International Technical Support Organization

Windows NT Systems Management

July 1997
Take Note!

Before using this information and the product it supports, be sure to read the general information in Appendix C, “Special Notices” on page 279.

First Edition (July 1997)

This edition applies to TME 10 Version 3.1 and NT Server Version 4.0 for use with the Windows NT Operating System.

Comments may be addressed to:
IBM Corporation, International Technical Support Organization
Dept. HZ8 Building 678
P.O. Box 12195
Research Triangle Park, NC 27709-2195

When you send information to IBM, you grant IBM a non-exclusive right to use or distribute the information in any way it believes appropriate without incurring any obligation to you.

© Copyright International Business Machines Corporation 1997. All rights reserved.
Note to U.S. Government Users — Documentation related to restricted rights — Use, duplication or disclosure is subject to restrictions set forth in GSA ADP Schedule Contract with IBM Corp.
# Contents

**Figures** .................................................................................................................. vii

**Preface** .................................................................................................................. xvii
The Team That Wrote This Redbook ............................................................................... xvii
Comments Welcome ..................................................................................................... xvii

**Chapter 1. Overview of NT Systems Management** .................................................. 1
1.1 Hardware and Operating System Environment ..................................................... 1
1.2 Software Environment ............................................................................................. 3

**Chapter 2. SNMP Management** ............................................................................. 5
2.1 NT MIB Values ......................................................................................................... 5
  2.1.1 LAN Manager MIB-II ....................................................................................... 6
  2.1.2 Microsoft DHCP Server MIB ........................................................................... 9
  2.1.3 Microsoft Internet Information Server MIB ................................................... 9
  2.1.4 Microsoft WINS Server MIB .......................................................................... 10
  2.1.5 Microsoft SQL Server MIB ............................................................................ 13
  2.1.6 Lotus Notes Server MIB ................................................................................ 14
2.2 SNMP Utilities in the NT Resource Kit .................................................................. 18
  2.2.1 SNMPUTIL.EXE SNMP Browser ................................................................... 19
  2.2.2 SNMP Monitor ................................................................................................ 20
  2.2.3 MIBCC.EXE .................................................................................................... 21
  2.2.4 PERF2MIB.EXE Performance Monitor MIB Builder Tool ............................... 21

**Chapter 3. Domain Management** .......................................................................... 23
3.1 NT Web Administration ......................................................................................... 23
3.2 NT Management ..................................................................................................... 27
  3.2.1 Adding Users .................................................................................................. 28
  3.2.2 Editing Users .................................................................................................. 31
  3.2.3 Removing User Accounts ............................................................................. 33
  3.2.4 Adding Local Groups .................................................................................... 34
  3.2.5 Editing Groups ............................................................................................... 36
  3.2.6 Removing Groups .......................................................................................... 38
  3.2.7 Adding Global Groups ................................................................................... 40
  3.2.8 Creating Shared Directories .......................................................................... 41
  3.2.9 Editing Share Permissions .............................................................................. 47
  3.2.10 Removing Shares ........................................................................................ 49
  3.2.11 File System Management (File/Folder Permissions) .................................... 50
  3.2.12 Broadcasting Messages .............................................................................. 53
  3.2.13 Remote Console .......................................................................................... 55
  3.2.14 Rebooting Servers ....................................................................................... 57
  3.2.15 Printer Management ..................................................................................... 59
  3.2.16 Device Management ..................................................................................... 62
  3.2.17 Services Management .................................................................................. 65
  3.2.18 Sessions Management .................................................................................. 67
  3.2.19 Performance Management .......................................................................... 69
  3.2.20 Server Configuration .................................................................................... 70
  3.2.21 Web Administration Preferences .................................................................. 72
3.3 User Synchronization between Lotus Notes and Windows NT ............................ 73
  3.3.1 Installation of the User Synchronization .......................................................... 74
  3.3.2 User Synchronization Settings ....................................................................... 75
### Chapter 4. Protocol Management
- **4.1 SNA - IBM Personal Communications for Windows NT**
  - **4.1.1 Installation of LLC2 Protocol**            96
  - **4.1.2 SNA - IBM Communications Server for Windows NT**  105
  - **4.1.3 SNA - Microsoft SNA Server for Windows NT**  119
  - **4.1.4 IPX/SPX - Gateway (and Client) Services for NetWare**  134
  - **4.1.5 IPX/SPX - NetWare Client for Windows NT**  141
  - **4.1.6 IBM Networks Coordinated Logon Client for NT**  148
- **4.2 Network Monitor**
  - **4.2.1 Capturing Data**                           155
  - **4.2.2 Capturing Data with Filters**              161
  - **4.2.3 View the Captured Data**                   162

### Chapter 5. Performance Management
- **5.1 Windows NT Built-In Tools**
  - **5.1.1 Event Viewer**                             165
  - **5.1.2 Performance Monitor**                      168
  - **5.1.3 Task Manager**                             178
- **5.2 NetFinity Monitoring**
  - **5.2.1 Alert Manager**                            183
  - **5.2.2 Process Manager**                          183
  - **5.2.3 System Monitor**                           184
- **5.3 Lotus Notes Performance**
  - **5.3.1 Installing the Lotus Notes Performance Monitor**  189
  - **5.3.2 Un-Installing the Lotus Notes Performance Monitor**  190
  - **5.3.3 Getting the Instances Up and Running**      190
  - **5.3.4 What Instances Should You Monitor**         192

### Chapter 6. SMS
- **6.1 Environment Setup**
  - **6.1.1 Site Planning and Design**                193
  - **6.1.2 Prerequisites Setup**                      195
  - **6.1.3 SMS Installation**                        199
  - **6.1.4 SMS Clients Installation**                210
- **6.2 Working with SMS**
  - **6.2.1 The SMS Administrator**                   217
  - **6.2.2 Packages and Jobs**                        226
  - **6.2.3 Queries and Reports**                      236
  - **6.2.4 SMS Groups**                              241
  - **6.2.5 Events and Alerts**                       245
  - **6.2.6 Performing Inventory**                     253
  - **6.2.7 Performing Software Distribution**         260
  - **6.2.8 Performing Remote Troubleshooting**        262
  - **6.2.9 Performing Network Monitoring**            267

### Appendix A. SMS Files
- **A.1 RUNSMS.BAT**                                271

### Appendix B. Windows NT Diagnostic Summary
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix C. Special Notices</td>
<td>279</td>
</tr>
<tr>
<td>Appendix D. Related Publications</td>
<td>281</td>
</tr>
<tr>
<td>D.1 International Technical Support Organization Publications</td>
<td>281</td>
</tr>
<tr>
<td>D.2 Redbooks on CD-ROMs</td>
<td>281</td>
</tr>
<tr>
<td>D.3 Other Publications</td>
<td>281</td>
</tr>
<tr>
<td>How to Get ITSO Redbooks</td>
<td>283</td>
</tr>
<tr>
<td>How IBM Employees Can Get ITSO Redbooks</td>
<td>283</td>
</tr>
<tr>
<td>How Customers Can Get ITSO Redbooks</td>
<td>284</td>
</tr>
<tr>
<td>IBM Redbook Order Form</td>
<td>285</td>
</tr>
<tr>
<td>Index</td>
<td>287</td>
</tr>
<tr>
<td>ITSO Redbook Evaluation</td>
<td>289</td>
</tr>
<tr>
<td>Figure</td>
<td>Title</td>
</tr>
<tr>
<td>--------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>1</td>
<td>LAN Manager MIB on TME 10 NetView</td>
</tr>
<tr>
<td>2</td>
<td>LAN Manager MIB</td>
</tr>
<tr>
<td>3</td>
<td>DHCP MIB</td>
</tr>
<tr>
<td>4</td>
<td>IIS MIB</td>
</tr>
<tr>
<td>5</td>
<td>WINS Server MIB</td>
</tr>
<tr>
<td>6</td>
<td>SQL Server MIB</td>
</tr>
<tr>
<td>7</td>
<td>Lotus Notes SNMP Installation</td>
</tr>
<tr>
<td>8</td>
<td>Lotus Notes SNMP Installation</td>
</tr>
<tr>
<td>9</td>
<td>Lotus Notes SNMP Service</td>
</tr>
<tr>
<td>10</td>
<td>Lotus Notes SNMP Configuration Database</td>
</tr>
<tr>
<td>11</td>
<td>Lotus Notes SNMP Configuration Database - Parameter View</td>
</tr>
<tr>
<td>12</td>
<td>Lotus Notes SNMP Configuration Database - SNMP Control Rights</td>
</tr>
<tr>
<td>13</td>
<td>Lotus Notes Server MIB</td>
</tr>
<tr>
<td>14</td>
<td>Output from SNMPUTIL Command</td>
</tr>
<tr>
<td>15</td>
<td>Monitoring Status</td>
</tr>
<tr>
<td>16</td>
<td>NT Web Administration: Main Screen</td>
</tr>
<tr>
<td>17</td>
<td>Web Administration: Installation Screen</td>
</tr>
<tr>
<td>18</td>
<td>WWW Service Properties (Default Settings)</td>
</tr>
<tr>
<td>19</td>
<td>Maintenance Selected with MSIE and Netscape Navigator</td>
</tr>
<tr>
<td>20</td>
<td>Web Administration: Logon Requester</td>
</tr>
<tr>
<td>21</td>
<td>Windows NT: User Manager</td>
</tr>
<tr>
<td>22</td>
<td>Windows NT: New User</td>
</tr>
<tr>
<td>23</td>
<td>Syntax of the NET USER Command</td>
</tr>
<tr>
<td>24</td>
<td>Syntax of the ADDUSERS.EXE Command</td>
</tr>
<tr>
<td>25</td>
<td>Format of ASCII-file for Use with ADDUSERS.EXE</td>
</tr>
<tr>
<td>26</td>
<td>Windows NT CMD: Adding a User with the ADDUSERS.EXE Command</td>
</tr>
<tr>
<td>27</td>
<td>Web Administration: User Accounts</td>
</tr>
<tr>
<td>28</td>
<td>Web Administration: Create New User Account</td>
</tr>
<tr>
<td>29</td>
<td>Windows NT: User Properties</td>
</tr>
<tr>
<td>30</td>
<td>Web Administration: User Properties</td>
</tr>
<tr>
<td>31</td>
<td>Windows NT: Delete User Requester</td>
</tr>
<tr>
<td>32</td>
<td>Windows NT CMD: Removing Users Using the ADDUSERS.EXE Command</td>
</tr>
<tr>
<td>33</td>
<td>Web Administration: Delete User Account</td>
</tr>
<tr>
<td>34</td>
<td>Windows NT: New Local Group</td>
</tr>
<tr>
<td>35</td>
<td>Syntax of the NET GROUP Command</td>
</tr>
<tr>
<td>36</td>
<td>Windows NT CMD: Creating a Group Using the ADDUSERS.EXE Command</td>
</tr>
<tr>
<td>37</td>
<td>Web Administration: New Group Information</td>
</tr>
<tr>
<td>38</td>
<td>Windows NT: Local Group Properties</td>
</tr>
<tr>
<td>39</td>
<td>Example of Adding a User to a Group Using the NET GROUP Command</td>
</tr>
<tr>
<td>40</td>
<td>Web Administration: Group Memberships</td>
</tr>
<tr>
<td>41</td>
<td>Windows NT: Delete Requester</td>
</tr>
<tr>
<td>42</td>
<td>Windows NT CMD: Removing Groups Using the ADDUSERS.EXE Command</td>
</tr>
<tr>
<td>43</td>
<td>Web Administration: Group Accounts</td>
</tr>
<tr>
<td>44</td>
<td>Web Administration: Delete Group</td>
</tr>
<tr>
<td>45</td>
<td>Windows NT: New Global Group</td>
</tr>
<tr>
<td>46</td>
<td>Windows NT CMD: ADDUSERS</td>
</tr>
<tr>
<td>47</td>
<td>Syntax of the RMTSHARE.EXE Command</td>
</tr>
<tr>
<td>48</td>
<td>Windows NT CMD: Creating a Remote Share with RMTSHARE.EXE</td>
</tr>
<tr>
<td>Page</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>49.</td>
<td>ShareUI: Shared Directories 1</td>
</tr>
<tr>
<td>50.</td>
<td>ShareUI: Menu File - New - Share</td>
</tr>
<tr>
<td>51.</td>
<td>ShareUI: New Share</td>
</tr>
<tr>
<td>52.</td>
<td>ShareUI: Shared Directories 2</td>
</tr>
<tr>
<td>53.</td>
<td>Windows NT: Share Properties</td>
</tr>
<tr>
<td>54.</td>
<td>Windows NT CMD: NET SHARE Command</td>
</tr>
<tr>
<td>55.</td>
<td>Syntax of the NET SHARE Command</td>
</tr>
<tr>
<td>56.</td>
<td>Web Administration: Shares</td>
</tr>
<tr>
<td>57.</td>
<td>Web Administration: New Share Information</td>
</tr>
<tr>
<td>58.</td>
<td>Windows NT: Access through Share Permissions</td>
</tr>
<tr>
<td>59.</td>
<td>Windows NT: Add Users and Groups</td>
</tr>
<tr>
<td>60.</td>
<td>Windows NT CMD: Editing Shares with the RMTSHARE Command</td>
</tr>
<tr>
<td>61.</td>
<td>Windows NT CMD: NET SHARE /DELETE Command</td>
</tr>
<tr>
<td>62.</td>
<td>Windows NT: Properties</td>
</tr>
<tr>
<td>63.</td>
<td>Windows NT: Permissions</td>
</tr>
<tr>
<td>64.</td>
<td>Syntax of the CACLS.EXE Command</td>
</tr>
<tr>
<td>65.</td>
<td>Web Administration: Select File/Folder</td>
</tr>
<tr>
<td>66.</td>
<td>Web Administration: Permissions for File/Folder</td>
</tr>
<tr>
<td>67.</td>
<td>Broadcast Message</td>
</tr>
<tr>
<td>68.</td>
<td>Windows NT: Server Manager</td>
</tr>
<tr>
<td>69.</td>
<td>Windows NT: Send Message</td>
</tr>
<tr>
<td>70.</td>
<td>Syntax of the NET SEND Command</td>
</tr>
<tr>
<td>71.</td>
<td>Windows NT CMD: NET SEND Command</td>
</tr>
<tr>
<td>72.</td>
<td>Web Administration: Server Manager</td>
</tr>
<tr>
<td>73.</td>
<td>Windows NT CMD: Remote Client Command</td>
</tr>
<tr>
<td>74.</td>
<td>Syntax for the RCLIENT.EXE Command</td>
</tr>
<tr>
<td>75.</td>
<td>Web Administration: Remote Console</td>
</tr>
<tr>
<td>76.</td>
<td>Windows NT: Shutdown Manager</td>
</tr>
<tr>
<td>77.</td>
<td>Syntax for the SHUTDOWN.EXE Command</td>
</tr>
<tr>
<td>78.</td>
<td>Windows NT CMD: System Shutdown/Reboot Command</td>
</tr>
<tr>
<td>79.</td>
<td>Web Administration: Reboot Server</td>
</tr>
<tr>
<td>80.</td>
<td>Windows NT: Printers</td>
</tr>
<tr>
<td>81.</td>
<td>Windows NT: Printer Status</td>
</tr>
<tr>
<td>82.</td>
<td>Windows NT: Printer Job Manager</td>
</tr>
<tr>
<td>83.</td>
<td>Syntax of the NET PRINT Command</td>
</tr>
<tr>
<td>84.</td>
<td>Windows NT CMD: Managing Printer Jobs Using the NET PRINT Command</td>
</tr>
<tr>
<td>85.</td>
<td>Web Administration: Printers</td>
</tr>
<tr>
<td>86.</td>
<td>Web Administration: Print Jobs</td>
</tr>
<tr>
<td>87.</td>
<td>Windows NT: Device Manager</td>
</tr>
<tr>
<td>88.</td>
<td>Windows NT: Device Manager - Hardware Profiles</td>
</tr>
<tr>
<td>89.</td>
<td>Windows NT: Device Manager - Startup Type</td>
</tr>
<tr>
<td>90.</td>
<td>Web Administration: Device Manager</td>
</tr>
<tr>
<td>91.</td>
<td>Web Administration: Device Manager - Startup Type</td>
</tr>
<tr>
<td>92.</td>
<td>Web Administration: Device Manager - Inconsistent Sorting</td>
</tr>
<tr>
<td>93.</td>
<td>Windows NT: Services</td>
</tr>
<tr>
<td>94.</td>
<td>Windows NT: Service Startup</td>
</tr>
<tr>
<td>95.</td>
<td>Web Administration: Service Manager</td>
</tr>
<tr>
<td>96.</td>
<td>Windows NT: User Sessions</td>
</tr>
<tr>
<td>97.</td>
<td>Windows NT CMD: Managing Sessions Using the NET SESSION Command</td>
</tr>
<tr>
<td>98.</td>
<td>Syntax of the NET SESSION Command</td>
</tr>
<tr>
<td>99.</td>
<td>Web Administration: Sessions</td>
</tr>
<tr>
<td>100.</td>
<td>Web Administration: Sessions - Information</td>
</tr>
<tr>
<td>101.</td>
<td>Web Administration: Performance Monitor Objects</td>
</tr>
<tr>
<td>Page</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>153.</td>
<td>Lotus Notes User Synchronization: Approve File Deletion</td>
</tr>
<tr>
<td>154.</td>
<td>Lotus Notes User Synchronization: Performed Administration Requests</td>
</tr>
<tr>
<td>155.</td>
<td>Lotus Notes User Synchronization: Network Account Name</td>
</tr>
<tr>
<td>156.</td>
<td>Lotus Notes User Synchronization: User Rename Menu</td>
</tr>
<tr>
<td>157.</td>
<td>Lotus Notes User Synchronization: Rename Requester</td>
</tr>
<tr>
<td>158.</td>
<td>Lotus Notes User Synchronization: Changed Network Account Name</td>
</tr>
<tr>
<td>159.</td>
<td>Personal Communication for NT Information Dialog</td>
</tr>
<tr>
<td>160.</td>
<td>IBM LLC2 Driver Installation Help</td>
</tr>
<tr>
<td>161.</td>
<td>Network Protocol in Control Panel</td>
</tr>
<tr>
<td>162.</td>
<td>Select Net Protocol</td>
</tr>
<tr>
<td>163.</td>
<td>Insert Disk</td>
</tr>
<tr>
<td>164.</td>
<td>Personal Communication for NT</td>
</tr>
<tr>
<td>165.</td>
<td>Personal Communication for NT</td>
</tr>
<tr>
<td>166.</td>
<td>Information for Requiring Configuration</td>
</tr>
<tr>
<td>167.</td>
<td>Customize Communication</td>
</tr>
<tr>
<td>168.</td>
<td>Customize Communication - 3270 Host</td>
</tr>
<tr>
<td>169.</td>
<td>Configure Local System</td>
</tr>
<tr>
<td>170.</td>
<td>Configure LAN Connection</td>
</tr>
<tr>
<td>171.</td>
<td>Configuration Complete</td>
</tr>
<tr>
<td>172.</td>
<td>Save the Configuration File</td>
</tr>
<tr>
<td>173.</td>
<td>Complete Customization</td>
</tr>
<tr>
<td>174.</td>
<td>Complete Customization</td>
</tr>
<tr>
<td>175.</td>
<td>Connect to IBM S/390 Host</td>
</tr>
<tr>
<td>176.</td>
<td>IBM Communications Server for Windows NT</td>
</tr>
<tr>
<td>177.</td>
<td>Administrator and Configuration User ID</td>
</tr>
<tr>
<td>178.</td>
<td>Start Copying Files</td>
</tr>
<tr>
<td>179.</td>
<td>Connect to IBM S/390 Host</td>
</tr>
<tr>
<td>180.</td>
<td>Connect to IBM S/390 Host</td>
</tr>
<tr>
<td>181.</td>
<td>SNA Node Configuration</td>
</tr>
<tr>
<td>182.</td>
<td>SNA Node Configuration - Help Window</td>
</tr>
<tr>
<td>183.</td>
<td>SNA Node Configuration - New Configuration</td>
</tr>
<tr>
<td>184.</td>
<td>SNA Node Configuration/TN3270E Server</td>
</tr>
<tr>
<td>185.</td>
<td>SNA Node Configuration/Define a Node</td>
</tr>
<tr>
<td>186.</td>
<td>SNA Node Configuration/Configure a Device</td>
</tr>
<tr>
<td>187.</td>
<td>SNA Node Configuration/Define a LAN Device</td>
</tr>
<tr>
<td>188.</td>
<td>SNA Node Configuration/Configure the Gateway</td>
</tr>
<tr>
<td>189.</td>
<td>SNA Node Configuration/Define a Gateway Configuration</td>
</tr>
<tr>
<td>190.</td>
<td>SNA Node Configuration/Host Link Type</td>
</tr>
<tr>
<td>191.</td>
<td>SNA Node Configuration/Define a LAN Connection</td>
</tr>
<tr>
<td>192.</td>
<td>SNA Node Configuration/Assign New LUs</td>
</tr>
<tr>
<td>193.</td>
<td>SNA Node Configuration/Host LU Definition</td>
</tr>
<tr>
<td>194.</td>
<td>SNA Node Configuration/Assign LUs</td>
</tr>
<tr>
<td>195.</td>
<td>SNA Node Configuration - TN3270E Parameter</td>
</tr>
<tr>
<td>196.</td>
<td>SNA Node Configuration/Save the Configuration</td>
</tr>
<tr>
<td>197.</td>
<td>Start a SNA Node</td>
</tr>
<tr>
<td>198.</td>
<td>A Started SNA Node</td>
</tr>
<tr>
<td>199.</td>
<td>Microsoft SNA Server/Welcome</td>
</tr>
<tr>
<td>200.</td>
<td>SNA Server/Manager</td>
</tr>
<tr>
<td>201.</td>
<td>SNA Server/Help Window</td>
</tr>
<tr>
<td>202.</td>
<td>SNA Server/Insert Link Service</td>
</tr>
<tr>
<td>203.</td>
<td>SNA Server/DLC 802.2 Link Service Properties</td>
</tr>
<tr>
<td>204.</td>
<td>SNA Server - Link Service Added</td>
</tr>
<tr>
<td>205.</td>
<td>SNA Server</td>
</tr>
<tr>
<td>206.</td>
<td>SNA Server - Link Service Added</td>
</tr>
<tr>
<td>207.</td>
<td>SNA Server/Connection Properties/General</td>
</tr>
</tbody>
</table>
263. Network Monitor/Capturing Data ........................................ 156
264. Network Monitor/Total Stats ............................................ 157
265. Network Monitor/Session Stats ......................................... 158
266. Network Monitor/Session Stats/Edit Address ....................... 158
267. Network Monitor/Session Stats ........................................... 159
268. Network Monitor/Station Stats ......................................... 159
269. Network Monitor/Graph .................................................... 160
270. Network Monitor/Graph .................................................... 161
271. Network Monitor/Capture Filter SAPs and ETYPES ................... 162
272. Network Monitor/Graph .................................................... 163
273. Event Viewer ................................................................. 165
274. Event Viewer/System, Security, Application .......................... 166
275. Event Viewer/Filter ........................................................ 166
276. Event Viewer/Filter Events ............................................... 167
277. Event Viewer/Detail Information ....................................... 167
278. Performance Monitor/Chart .............................................. 168
279. Performance Monitor/Alert ................................................ 169
280. Performance Monitor/Log .................................................. 169
281. Performance Monitor/Report ............................................. 170
282. Performance Monitor/Chart/Add 1 ...................................... 170
283. Performance Monitor/Chart/Add 2 ...................................... 171
284. Performance Monitor/Chart/Histogram ................................ 171
285. Performance Monitor/Chart/Options ................................... 172
286. Performance Monitor/Chart/Graph ..................................... 173
287. Performance Monitor/Alert/Add ......................................... 173
288. Performance Monitor/Alert ................................................. 174
289. Performance Monitor/Alert/Options ................................... 174
290. Performance Monitor/Log/Add ............................................ 175
291. Performance Monitor/Log .................................................. 176
292. Performance Monitor/Start, Stop and Save ............................ 176
293. Performance Monitor/Report .............................................. 177
294. Performance Monitor/Data From ....................................... 178
295. Task Manager/Applications ............................................... 179
296. Task Manager/Processes ................................................... 180
297. Task Manager/Performance ............................................... 181
298. NetFinity Service Manager .............................................. 182
299. NetFinity/Alert Manager ................................................... 183
300. NetFinity/Process Manager Icon ....................................... 183
301. NetFinity Process Manager ............................................... 184
302. NetFinity System Monitor Icon ......................................... 184
303. NetFinity/System Monitor/Select Visible Monitors .................. 185
304. NetFinity/System Monitor/CPU Utilization ............................ 186
305. NetFinity/System Monitor/Space Remaining .......................... 186
306. NetFinity/System Monitor/Property of Monitor ..................... 187
308. NetFinity/System Monitor/Notify Window ............................ 188
309. Lotus Notes Performance Monitoring: Installing Performance Monitor 189
310. Lotus Notes Performance Monitoring: Add to Chart Requester 191
311. Lotus Notes Performance Monitoring: Initializing Replica Statistics 191
312. Example of Domains within a Site ..................................... 193
313. Site Hierarchy Layout Example ......................................... 194
314. Event Log Setup Window .................................................. 196
315. SQL Manager Logins Window ............................................ 198
316. Server Configuration/Options Dialog .................................. 199
317. SMS Setup Initial Window ............................................... 200
373. SMS Jobs Window ........................................... 232
374. SMS Job Properties Window ................................. 233
375. SMS Job Details Window ..................................... 233
376. SMS Mandatory Job Execution Warning .................... 234
377. SMS Job Schedule Window .................................. 234
378. SMS Job Status Window .................................... 235
379. SMS Job Status Details Window ........................... 235
380. Event Details .................................................. 236
381. SMS Queries Window .......................................... 237
382. SMS Query Properties Window .............................. 237
383. SMS Query Expression Properties Window .................. 238
384. SMS Query Properties Window ............................. 238
385. Inactive Personal Computers Query ......................... 239
386. SMS Execute Query Window .................................. 239
387. SMS Query Results Window .................................. 239
388. SMS Define Query Result Formats Window ................. 240
389. SMS Define Query Result Format Properties Window ....... 241
390. SMS Program Group Properties Window .................... 242
391. SMS Program Group Packages Window ..................... 242
392. SMS Program Group Properties Window .................... 243
393. SMS Program Group User Groups Window ................. 243
394. SMS Program Group Warning ................................ 244
395. SMS Groups .................................................... 244
396. Query Properties to Generate Alert ......................... 245
397. SMS Alert Properties Window ............................... 246
398. SMS Alert Query Window .................................... 246
399. SMS Alert Actions Window .................................. 246
400. SMS Event Resulting from Alert ............................ 247
401. SMS Alert Message .......................................... 247
402. SMS SNMP Traps Properties Window ......................... 248
403. SMS SNMP Trap Filter Properties Window .................. 248
404. SMS SNMP Traps Window ..................................... 249
405. Traps Details .................................................. 249
406. Win NT Administrative Tools, Event to Trap Translator ...... 250
407. Loading Trap Configuration Window ......................... 250
408. Event to Trap Translator Window ........................... 251
409. Event Properties ............................................... 252
410. Event to Trap Translator Settings .......................... 253
411. SMS Personal Computer Properties Window ................ 254
412. NetFinity Software Inventory .................................. 255
413. Inventoried Package .......................................... 255
414. Software Auditing Job in Package Command Manager in Win NT 3.51 257
415. Software Auditing Running on Windows NT 3.51 .................. 258
416. Software Auditing Running on Windows 95 .................. 258
417. Audited Software Shown in Computer Inventory ............... 259
418. SMS MIF Form Generator ..................................... 259
419. Customized Inventory Data ................................... 260
420. Package Definition File for Lotus Notes Client ............... 261
421. Unattended Installation Script CLIENT32.BAT ............... 261
422. Unattended Installation Response File CLIENT32.RSP ........... 262
423. Network Properties Window, NetBIOS Interface Parameters on Windows NT V4 264
424. SMS Help Desk Options Window ............................. 265
425. SMS Personal Computer Properties - Help Desk ............. 265
426. SMS Help Desk Window (Quick Windows Viewer) ............. 266
427. Being Accessed Warning ........................................ 267
428. Personal Computer Properties Window, Network Monitoring .......... 268
429. Network Monitor Window ........................................ 269
Preface

This redbook describes how to do systems management on the NT Server 4.0 platform using tools from Microsoft and IBM. Setting up IPX and SNA connectivity is also shown in this book. We show different NetWare clients, as well as used Microsoft SNA Version 3.0 to show how to set up SNA connectivity. There are examples of how to use each of the functions, as well as descriptions of the supporting details needed to enable the function. Simple scenarios are provided to show you how to use each of the systems management functions, as well as some complex examples showing how to integrate Lotus Notes user administration with Windows NT. In most cases the examples were done on the Windows platforms, but in some cases clients were OS/2 and NetWare. In addition, we used an AIX system to show some SNMP interaction.

The examples help the reader understand how to use the NT system management tools to manage and administer their environments better.

The Team That Wrote This Redbook

This redbook was produced by a team of specialists from around the world working at the Systems Management and Networking ITSO Center, Raleigh.

Barry D. Nusbaum is a Senior International Technical Support representative at the Systems Management and Networking ITSO Center, Raleigh. He writes extensively and teaches IBM classes worldwide on all areas of TME systems management on the NT and AIX platform. Before joining the ITSO four years ago, he worked in Professional Services in the United States as a National Communications Specialist.

Leonardo Pires Frollini is a senior product and systems specialist at the IBM Software Division in Brazil. He has six years of experience in systems and network management. His areas of expertise include the Tivoli framework and correlated products in AIX, NT and OS/2.

Lucas Fang is an Availability I/T Specialist in Taiwan. He has several years of experience in the UNIX field. He holds a Masters of Computer Science and Information Engineering degree from National Chiao Tung University at Taiwan. He has worked at IBM for two years. His areas of expertise include MVS, OS/2 and LAN.

Anders Ahl is a systems specialist in Sweden. He has several years of experience in the Windows NT field. His areas of expertise include Lotus Notes and LAN/WAN design.

Comments Welcome

Your comments are important to us!

We want our redbooks to be as helpful as possible. Please send us your comments about this or other redbooks in one of the following ways:

- Fax the evaluation form found in “ITSO Redbook Evaluation” on page 289 to the fax number shown on the form.
• Use the electronic evaluation form found on the Redbooks Home Pages at
the following URLs:

For Internet users http://www.redbooks.ibm.com
For IBM Intranet users http://w3.itso.ibm.com

• Send us a note at the following address:

  redbook@vnet.ibm.com
Chapter 1. Overview of NT Systems Management

This chapter provides an overview of this redbook, as well as provides details on the hardware and software that was used throughout the book to perform the scenarios. Each example only used a subset of the environment.

In this book we cover systems management functions that are used on the NT platform. We used the built-in functions that came with Windows NT Server, as well as products (and supporting products) from Microsoft and IBM. Some of the add-ons follow:

- NT Resource Kit
- System Management Server (SMS)
- SQL as a supporting tool
- TME 10 NetView for AIX
- TME 10 NetView for NT
- NetFinity
- Communications Server for NT
- IBM Network Client
- Lotus Notes

In this book we address the following:

- SNMP management
- Web-based user and domain management
- Protocol management
- Performance management
- Using SMS to assist with management

1.1 Hardware and Operating System Environment

The following table shows the hardware that was used in this residency. We did not add or subtract any hardware in this residency to make a particular example work properly.
<table>
<thead>
<tr>
<th>Hostname</th>
<th>IP Address</th>
<th>Model</th>
<th>OS Type</th>
<th>OS Version</th>
<th>OS Patches</th>
</tr>
</thead>
<tbody>
<tr>
<td>netw114</td>
<td>9.24.104.114</td>
<td>PS/2 77, 500 MB, 32 MB</td>
<td>Novell NetWare</td>
<td>4.1</td>
<td>410PT7, DS410A, INS224, LIBUPC, NAM41B, NWAMN2, SMSUP6, SRVMN1, STRTL5</td>
</tr>
<tr>
<td>netviewnt</td>
<td>9.24.104.120</td>
<td>IBM PC Server 520, 2 GB, 32 MB</td>
<td>Windows NT Workstation</td>
<td>4.0</td>
<td>Service Pack 1 &amp; 2</td>
</tr>
<tr>
<td>ntdomc</td>
<td>9.24.104.103</td>
<td>IBM PS/2 9595</td>
<td>Windows NT Server</td>
<td>4.0</td>
<td>Service Pack 2</td>
</tr>
<tr>
<td>smsmon</td>
<td>9.24.105.111</td>
<td>IBM TP755CD, 500 MB, 24 MB</td>
<td>Windows NT Workstation</td>
<td>4.0</td>
<td>Service Pack 1 &amp; 2</td>
</tr>
<tr>
<td>warpsrvr</td>
<td>9.24.104.112</td>
<td>PS/2 77, 500 MB, 32 MB</td>
<td>OS/2 WarpServer</td>
<td>3.0</td>
<td></td>
</tr>
<tr>
<td>window95</td>
<td>9.24.104.113</td>
<td>PS/2 77, 500 MB, 24 MB</td>
<td>Windows 95</td>
<td></td>
<td></td>
</tr>
<tr>
<td>winnt38</td>
<td>9.24.104.38</td>
<td>IBM PC350-133, 1 GB, 80 MB</td>
<td>Windows NT Server</td>
<td>4.0</td>
<td>Service Pack 2</td>
</tr>
<tr>
<td>winnt54</td>
<td>9.24.104.54</td>
<td>IBM TP755CE, 1 GB</td>
<td>Windows NT Workstation</td>
<td>4.0</td>
<td>Service Pack 2</td>
</tr>
<tr>
<td>winnt68</td>
<td>9.24.104.68</td>
<td>IBM PC350-133, 1.2 GB, 80 MB</td>
<td>Windows NT Server</td>
<td>4.0</td>
<td>Service Pack 2</td>
</tr>
<tr>
<td>winnt69</td>
<td>9.24.104.69</td>
<td>IBM PS2/77, 500 MB, 24 MB</td>
<td>WinNT Server</td>
<td>3.51</td>
<td>Service Pack 4</td>
</tr>
<tr>
<td>winnt80</td>
<td>9.24.104.80</td>
<td>IBM PC350-133, 1.2 GB, 80 MB</td>
<td>Windows NT Server</td>
<td>4.0</td>
<td>Service Pack 2</td>
</tr>
<tr>
<td>winnt87</td>
<td>9.24.104.87</td>
<td>IBM TP760E, 1 GB, 48 MB</td>
<td>Windows NT Server</td>
<td>4.0</td>
<td>Service Pack 2</td>
</tr>
</tbody>
</table>
1.2 Software Environment

The following table shows the software that was used in this residency. We did not do any operating system performance tuning to make any example run better. We took all system defaults during the installation process and tailored the systems to our needs, as the examples in the following chapters show.
<table>
<thead>
<tr>
<th>Hostname</th>
<th>Role</th>
<th>Software</th>
<th>Software Patches</th>
</tr>
</thead>
<tbody>
<tr>
<td>netw114</td>
<td>Server</td>
<td>NetWare V4.1</td>
<td>410pt7,libupc</td>
</tr>
<tr>
<td>netviewnt</td>
<td>Workstation</td>
<td>Windows NT Resource Kit 4.0 Server, NetView 5.0 (pre-Release)</td>
<td>telnetd patch</td>
</tr>
<tr>
<td>ntdomc</td>
<td>PDC for Domain NTDOM</td>
<td>Windows NT Resource Kit 4.0 Server</td>
<td>telnetd patch</td>
</tr>
<tr>
<td>smsmon</td>
<td>Workstation</td>
<td>Windows NT Resource Kit 4.0 Server, SMS Client 1.2</td>
<td>telnetd patch</td>
</tr>
<tr>
<td>warpsrvr</td>
<td>Server</td>
<td>NetFinity Service 5.0</td>
<td></td>
</tr>
<tr>
<td>window95</td>
<td>Workstation</td>
<td>SMS Client 1.2, NetFinity Service 5.0</td>
<td></td>
</tr>
<tr>
<td>winnt38</td>
<td>Server</td>
<td>IBM Communications Server 5.0, IBM Personal Communications 4.1, IBM Network Client 4.1, NetFinity 5.0</td>
<td>Service Pack 2</td>
</tr>
<tr>
<td>winnt54</td>
<td>Workstation</td>
<td>IBM Personal Communications 4.1, NetFinity Service 5.0</td>
<td>Service Pack 2</td>
</tr>
<tr>
<td>winnt68</td>
<td>PDC for Domain Management</td>
<td>SMS 1.2, SQL Server 6.5</td>
<td>SMS 1.2 Service Pack 1, SQL Server 6.5 Service Pack 1</td>
</tr>
<tr>
<td>winnt69</td>
<td>Server</td>
<td>SMS Client 1.2</td>
<td>Service Pack 2</td>
</tr>
<tr>
<td>winnt80</td>
<td>Server</td>
<td>Windows NT Resource Kit 4.0 Server, Lotus Notes Domino 4.51</td>
<td>telnetd patch</td>
</tr>
<tr>
<td>winnt87</td>
<td>Server</td>
<td>Windows NT Resource Kit 4.0 Server, Lotus Notes Domino 4.51</td>
<td>telnetd patch</td>
</tr>
</tbody>
</table>
Chapter 2. SNMP Management

This chapter documents the built-in SNMP functions in Windows NT, as well as other SNMP functions that can be added to the base operating system.

Windows NT provides many management functions using SNMP. It is possible, for example, to access management data about components such as the server and the DHCP service. There are tools offered by the NT Resource Kit that allow monitoring and customization of SNMP to suit each environment. We describe these functions and their applicability in the following paragraphs.

The SNMP.EXE program is responsible for the SNMP services in Windows NT. SNMP.EXE runs as an NT service, and must be enabled either during Windows NT installation or through the Services tab in the Network dialog contained in the Control Panel.

The services provided by SNMP.EXE are complemented by DLLs that extend its scope to manage WINS, DHCP, Internet components and LAN Manager functions. These DLLs work as SNMP subagents and communicate with the SNMP service through an agent API. Any DLL or application can use this API to extend the functions of the SNMP service. The following table shows SNMP functions versus DLL names:

<table>
<thead>
<tr>
<th>MIB Description</th>
<th>DLL Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN Manager MIB</td>
<td>LMIMIB2.DLL</td>
</tr>
<tr>
<td>DHCP Server MIB</td>
<td>DHCPMIB.DLL</td>
</tr>
<tr>
<td>Internet Information Server MIB</td>
<td>IIS.DLL</td>
</tr>
<tr>
<td>MIB-II</td>
<td>INETMIB1.DLL</td>
</tr>
<tr>
<td>WINS Server MIB</td>
<td>WINSMIB.DLL</td>
</tr>
<tr>
<td>SQL Server MIB (available from SQL server)</td>
<td>SQLSNMP.DLL</td>
</tr>
<tr>
<td>Lotus Notes server MIB (available from <a href="http://www.lotus.com">www.lotus.com</a>)</td>
<td>NVMIBDLL.DLL</td>
</tr>
</tbody>
</table>

Table 3. SNMP MIBs and Respective DLLs

The following registry key assigns DLLs to the SNMP service:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SNMP\Parameters\ExtensionAgents

The DLLs are only available if the corresponding software is installed on the machine. (For example, WINS.DLL is only available if the WINS server is installed.)

2.1 NT MIB Values

All the information manipulated by SNMP is stored in the Management Information Base (MIB). The SNMP service provided by NT and the Resource Kit includes MIB-II (based on RFC1213), the LAN Manager MIB and three proprietary MIBs: DHCP, WINS and the Internet Information Server MIB. Additional products such as SQL Server provide an additional MIB tree and SNMP subagent to extend its management capabilities. We describe the following MIBs:

- LAN Manager MIB-II
- Microsoft DHCP Server MIB
- Microsoft Internet Information Server MIB
• Microsoft WINS Server MIB
• Microsoft SQL Server MIB
• Lotus Notes Server MIB

2.1.1 LAN Manager MIB-II

This MIB allows management of file serving parameters in computers running Windows NT’s predecessor LAN Manager. However, it is still supported in Windows NT with LMMIB2.DLL.

The LAN Manager MIB branch is under:
iso.org.dod.internet.private.enterprises.

A lot of useful management information and statistics may be obtained from the LAN Manager MIB-II. The MIB tree branches into four items: common, server, workstation and domain.

The common branch contains mainly software version information and network I/O information. The comType variable shows the machine role according to the following table:

<table>
<thead>
<tr>
<th>Role</th>
<th>Bit Set</th>
<th>Example (0xB octet)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workstation</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Server</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>SQL Server</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Primary DC</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>Backup DC</td>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>Time Source</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>AFP Server</td>
<td>6</td>
<td>0</td>
</tr>
<tr>
<td>NetWare Server</td>
<td>7</td>
<td>0</td>
</tr>
</tbody>
</table>

The comType variable is a four-octet string. The above information is stored in the first octet. Each bit of the octet will be set according to the computer role. Refer to the above table for the following example.

A computer with the first octet of comType set to 0xB would have its bits set to 0000 1011; therefore having the roles for workstation, server and primary domain controller (DC). Although there is an option for SQL Server, comType did not report SQL Server V6.5 in our examples.

Network I/O statistics in this branch show the number of submitted operations and failed operations.

The server branch contains most of the important data in the MIB. Tables in this branch list the services running (svSvcTable), client sessions established (svSessTable), defined users (svUserTable), shares (svShareTable) and print queues (svPrintQTable). There are also statistics on the number of opens, bytes sent and received and buffer requests.

Following is what the MIB looks like when using the MIB Browser application on TME 10 NetView:
The *workstation* branch documents requests that the managed machine makes as a client to other machines. For example, it can show you the LAN connections that you would see if you had issued the `net use` command (in `wkstaUseTable`). In addition, it shows you request statistics and connection failures.

The last branch of the LAN Manager MIB shows domain data. The variable `domPrimaryDomain` displays which domain the machine belongs to, and `domLogonDomain` shows which domain the machine is currently logged on to. Domain controllers provide information to the `domLogonTable`, documenting each processed logon.

The structure of the LAN Manager MIB is as follows:
Figure 2. LAN Manager MIB
2.1.2 Microsoft DHCP Server MIB

The DHCP server MIB allows monitoring of DHCP server parameters using SNMP. The MIB variables that you can get are related to the address ranges and the availability of addresses. Two basic branches make up the DHCP MIB: dhcpPar and dhcpScope.

The dhcpPar branch contains information regarding the DHCP server start time and counters for parameters such as discovery messages, requests, releases and declines.

The dhcpScope branch is a table with address range information. Each entry in the table shows the range of subnet address and utilization within each range (for example, number of addresses in use and the number of free addresses). For example, monitoring of the number of free addresses may trigger automatic notification or action when this value shows that there are no free addresses remaining.

The structure of the DHCP MIB is as follows:

```plaintext
1 iso
3 org
6 dod
1 internet
 1 directory
 2 mgmt
 3 experimental
4 private
 1 enterprises
311 microsoft
 1 software
3 dhcp
 1 dhcpPar
    1 parDhcpStartTime
    2 parDhcpTotalNoOfDiscovers
    3 parDhcpTotalNoOfRequests
    4 parDhcpTotalNoOfReleases
    5 parDhcpTotalNoOfOffers
    6 parDhcpTotalNoOfAcks
    7 parDhcpTotalNoOfNacks
    8 parDhcpTotalNoOfDeclines
2 dhcpScope
 1 scopeTable
    1 scopeTableEntry
      1 subnetAdd
      2 noAddInUse
      3 noAddFree
      4 noPendingOffers
```

Figure 3. DHCP MIB

2.1.3 Microsoft Internet Information Server MIB

The IIS MIB provides monitoring statistics for gopher, gateway, FTP and http services. This branch starts at .iso.org.dod.internet.private.enterprises.microsoft.software, with four key pieces of information: ftpStatistics, httpServer, gopherServer and GatewayServer.

FTP and gopher statistics under their respective branches cover bytes and files sent and received, connection counters for anonymous and non-anonymous users and attempts for connections and logons. Variables worth watching could be the current number of users and connections (currentAnonymousUsers, currentNonAnonymousUsers and currentConnections) instead of the maximum allowed number of users and connections (maxAnonymousUsers,
maxNonAnonymousUsers and maxConnections). This way access to the FTP/gopher servers can be guaranteed with some capacity planning. Also, for security purposes, logonAttempts should document hacking endeavors.

The httpServer branch reports same statistics at the FTP and gopher branch plus http requests and errors such as totalGets, totalPosts, totalHeads, totalCGIRequests and totalNotFoundErrors. Monitoring not found errors may help detect HTML mistakes, while the total statistics will allow for capacity planning.

Internet gateway statistics also present bytes and files sent and received, as well as user and connection information. Counters are available for FTP, gopher and http requests. Three counters are used to provide summaries for Internet requests, fetches and cache fetches.

A partial structure of the Internet Information Server MIB looks like:

```
1 iso
3 org
6 dod
1 internet
1 directory
2 mgmt
3 experimental
4 private
1 enterprises
311 microsoft
1 software
7 internetServer
1 inetSrvCommon
2 ftpServer
3 httpServer
4 gopherServer
5 GatewayServer
```

Figure 4. IIS MIB

### 2.1.4 Microsoft WINS Server MIB

This MIB allows WINS monitoring and management including parameter setup using SNMP. If you are not familiar with WINS, read the Microsoft Windows NT Server Networking Guide in the NT Resource Kit documentation for a detailed description of WINS and its concepts. This MIB is very specific to WINS and requires some understanding of the Windows Internet Naming Service.

The WINS MIB branches into the par, pull, push, datafiles and cmd subtrees.

The par subtree contains WINS server statistics on its address synchronization functions and parameters. There are statistics on when scavenging (database backup and maintenance) and replication takes place, counters for total number of requests and failures and also WINS parameters such as path names and backup options.

The pull and push branches hold tables listing WINS pull and push partners addresses.

The cmd branch allows WINS settings to be modified with SNMP set commands. The following table shows each of the available commands and their functions.

<table>
<thead>
<tr>
<th>cmdPullTrigger</th>
<th>Causes WINS to pull the specified IP address</th>
</tr>
</thead>
</table>
Table 4. WINS Server MIB Variables

The structure of the WINS Server MIB is as follows:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmdPushTrigger</td>
<td>Causes WINS to push a notification message to the specified IP address</td>
</tr>
<tr>
<td>cmdDeleteWins</td>
<td>Deletes local WINS information regarding the specified WINS address.</td>
</tr>
<tr>
<td>cmdDoScavenging</td>
<td>Starts WINS scavenging.</td>
</tr>
<tr>
<td>cmdDoStaticInit</td>
<td>Causes WINS to do static initialization.</td>
</tr>
<tr>
<td>cmdNoOfWrkThds</td>
<td>Sets the number of work thread in WINS.</td>
</tr>
<tr>
<td>cmdPriorityClass</td>
<td>Sets WINS priority class (normal or high).</td>
</tr>
<tr>
<td>cmdResetCounters</td>
<td>Resets WINS counters.</td>
</tr>
<tr>
<td>cmdDeleteDbRecs</td>
<td>Deletes all data records (only data records) pertaining to the specified WINS address in the local database.</td>
</tr>
<tr>
<td>cmdDRPopulateTable</td>
<td>Triggers collection of cmdDRDataRecordsTable for the specified WINS address.</td>
</tr>
<tr>
<td>cmdDRDataRecordsTable</td>
<td>This table is collected when cmdDRPopulateTable is set, and contains data records from the specified WINS address.</td>
</tr>
</tbody>
</table>
Figure 5. WINS Server MIB
2.1.5 Microsoft SQL Server MIB

The SQL Server MIB is a read-only MIB containing descriptions and statistics on SQL Server and its resources. It is based on RFC1697, the SNMP Relational Database MS-MIB, with enhancements added by Microsoft. This MIB is made up of eight tables:

- **mssqlSrvTable**
  This table contains SQL product information, such as product name and version number.

- **mssqlSrvInfoTable**
  This table documents server performance statistics, as well as general information such as server name and server startup time.

- **mssqlSrvConfigParamTable**
  This is a table containing SQL Server configuration parameters. Its format stores one table entry for each parameter. It contains the parameter name, maximum and minimum configuration value, current parameter value and current run parameter value.

- **mssqlSrvDeviceTable**
  All devices defined in SQL Server are listed and described in this table, including its logical and physical name, device type, size and media type.

- **mssqlDbTable**
  Lists all databases in SQL Server. Each entry is comprised of a DB ID, DB name and DB state.

- **mssqlDbInfoTable**
  This table details information for each accessible database in SQL Server, such as owner, size and allocated space.

- **mssqlDbOptionTable**
  Possible database options for each database are listed in this table. For each option, mssqlDbOptionSetName indicates whether it is set or not.

- **mssqlDbDeviceTable**
  This table lists device fragments used by each SQL Server database.

The structure of the SQL Server MIB is as follows:
2.1.6 Lotus Notes Server MIB

The Lotus Notes Server MIB is provided by the NotesView SNMP Agent. NotesView is a Lotus product used for managing Notes servers. It is based on SNMP managers such as NetView for AIX and OpenView for Windows. Its SNMP agent offers extensive management capabilities, including detailed statistics and a few remote operation functions.

2.1.6.1 Installing the Lotus Notes SNMP Agent

The Lotus Notes SNMP Agent is free of charge and can be downloaded from the Lotus Web site. Use http://www.lotus.com as the starting point for finding the current page. At the time of this project, we used Notes 4.5 and found the agent at: http://www.lotus.com/dir_mktg/SNMP45.htm. The archive (NTAGNT45.EXE) contains the following files:

<table>
<thead>
<tr>
<th>Filename</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LNSNMP.EXE</td>
<td>Lotus Notes SNMP Agent service.</td>
</tr>
<tr>
<td>LSNMPCFG.NSF</td>
<td>Lotus Notes SNMP Agent configuration database.</td>
</tr>
<tr>
<td>MSVCRT20.DLL</td>
<td>Microsoft Visual C++ Run Time library.</td>
</tr>
<tr>
<td>NINTRCPT.EXE</td>
<td>Lotus Notes Event Interceptor. A Notes executable module.</td>
</tr>
<tr>
<td>NOTES.MIB</td>
<td>Lotus Notes MIB file.</td>
</tr>
<tr>
<td>NOTES.TDF</td>
<td>Lotus Notes Trap Definition File</td>
</tr>
<tr>
<td>NQUERYSET.EXE</td>
<td>Lotus Notes Query/Set Handler. A Notes executable module.</td>
</tr>
<tr>
<td>NREFLECT.EXE</td>
<td>Lotus Notes Mail Probe Reflector Agent. A Notes executable module.</td>
</tr>
<tr>
<td>NVINST.EXE</td>
<td>The installation program.</td>
</tr>
<tr>
<td>NVMIBDLL.DLL</td>
<td>Lotus Notes SNMP Sub Agent</td>
</tr>
</tbody>
</table>

Prior to the installation, you are required to have the SNMP service started and configured. Please see the Windows NT manuals on how to do this.

After you download the agent you will need to take the following steps:

1. Unpack the agent to a temporary directory.
2. Make sure your Lotus Notes directory is in the search PATH.
3. If you have the Notes Server task running, shut it down.
4. Execute the installation program (NVINST.EXE).
5. If you only want the SNMP agent, select Installation Option 1.

6. If you don’t have the Reporter task configured in your NOTES.INI file, the installation program allows you to add it now.

7. The installation is now complete.

You need to reboot your server for the SNMP Agent to start correctly.

2.1.6.2 Configuring the Lotus Notes SNMP Agent

The SNMP Agent is installed as a service (LNSNMP) on your server allowing for easy starting and stopping.
There are three configuration parameters editable from Lotus Notes in the Lotus Notes SNMP Configuration (LSNMPCFG.NSF) database.

Add this database to your workspace and open it to reveal a single document containing the SNMP Control Rights.

Edit this document to control the way to start, stop and reboot the Notes server.
Figure 12. Lotus Notes SNMP Configuration Database - SNMP Control Rights

Five subtrees comprise the Notes MIB: LnInfo, lnControl, lnInterceptor, lnUnix and MPAInfo. LnInfo is the most comprehensive branch, including most of the statistics and performance data. It is divided into 17 branches.

A summary of the structure of the Notes MIB follows:
Figure 13. Lotus Notes Server MIB

2.2 SNMP Utilities in the NT Resource Kit

The Windows NT Resource Kit contains SNMP-related tools that help extend SNMP management:

- SNMPUTIL.EXE - SNMP Browser
- SNMP Monitor - SNMP Monitor
- MIBCC.EXE - MIB Compiler
- PERF2MIB.EXE - Performance Monitor MIB Builder Tool
2.2.1 **SNMPUTIL.EXE SNMP Browser**

This command line utility allows you to send SNMP requests and to listen to traps. SNMP requests under SNMPUTIL are get, getnext or walk.

Use the following syntax for SNMP requests:

```plaintext
snmputil command agent community oidlist
```

Where command is:
- `get` (to obtain the specified MIB variables)
- `getnext` (to obtain the next MIB variable in the MIB tree)
- `walk` (to obtain all variables in the specified MIB tree)

agent is the target workstation name or IP address; community is the SNMP community name; oidlist is a blank separated list of MIB variables. This list may use the numeric or textual variable name. Each variable must start with a period (.). The following example lists the system subtree of a workstation:

```plaintext
snmputil walk winnt69 public .iso.org.dod.internet.mgmt.mib-2.system
```

The following output is generated:

```
Variable = system.sysDescr.0
Value = OCTET STRING - Hardware: 80486-D0 PS2/PS2 COMPATIBLE - Software: Windows NT Version 3.51 (Build Number: 1057 Uniprocessor Free )
```

```
Variable = system.sysObjectID.0
Value = OBJECT IDENTIFIER - .1.3.6.1.4.1.311.1.1.3.1
```

```
Variable = system.sysUpTime.0
Value = TimeTicks - 2971480
```

```
Variable = system.sysContact.0
Value = OCTET STRING - Contact: Leonardo P Frollini - Registered Owner: Barry D. Nusbaum
```

```
Variable = system.sysName.0
Value = OCTET STRING - WINNT69
```

```
Variable = system.sysLocation.0
Value = OCTET STRING - ITSO Raleigh
```

```
Variable = system.sysServices.0
Value = INTEGER - 76
```

End of MIB subtree.

*Figure 14. Output from SNMPUTIL Command*

Use the following syntax to listen to SNMP traps:

```plaintext
snmputil trap
```

**Note**

We tried to get the snmputil trap function to work, but we were not successful. There is a Microsoft write up on it at

http://www.microsoft.com/articles/q130/5/64.htm.
2.2.2 SNMP Monitor

SNMPMON.EXE is a utility to monitor specific MIB variables. You use a configuration file to specify which MIB variables to monitor and what actions to take when specified conditions are met. SNMPMON will periodically query these MIB variables and execute the specified actions according to the configuration file.

The following file sets SNMPMON to monitor the number of sessions established with one Windows NT server. This parameter is found in the MIB variable (1.3.6.1.4.1.77.1.2.19.0):

.iso.org.dod.internet.private.enterprise.lanmanager.lanmgr-2.server.svSessionNumber

When the number of sessions exceeds ten, SNMPMON sends a message to the administrator's machine.

//Sample file monitoring the number of sessions in Windows NT
//
// If number of sessions is greater than 10, a warning message
// is sent to the administrator machine

NTDOMC 1.3.6.1.4.1.77.1.2.19.0 20 0
>10 0 0 10000 net send winnt80 The number of sessions to NTDOMC has exceeded 10.

Three types of statements make up a configuration file: comments, scope definitions and conditional statements.

Lines starting with // are comments.

A scope definition contains the machine name to be monitored, the MIB variable to be monitored, the polling interval (how often SNMPMON will query this variable, in seconds) and whether or not to log transactions (0: do not log, 1: log). The scope definition for the example above sets NTDOMC as the machine to be monitored, 1.3.6.1.4.1.77.1.2.19.0 the MIB variable to be queried every 20 seconds and to not log the transactions.

A conditional statement determines when to execute an action. It contains a condition (>10 in the above example), a log trigger (0: do not log), a command trigger (0: execute command if condition is met), a command timeout (10000 milliseconds) and finally the command line command to be executed.

Invoke SNMPMON.EXE with the following command, using the configuration file as a parameter, to start monitoring:

```
snmpmon cfg.txt
```

The following window will show the monitoring status:

```
SNMP Monitor

Monitored nodes:  1
Queries made:     9
Command lines executed: 2
Database records written:  0

Figure 15. Monitoring Status
```
SNMPMON may also direct its output to a database via the ODBC interface. Refer to the Windows NT Resource Kit for details on using a database with SNMPMON.

2.2.3 MIBCC.EXE

The MIBCC command comes with the NT Server 4.0 Resource Kit and is used to compile MIBs. As indicated earlier in this chapter there are several MIBs that are distributed with the NT Server 4.0 Resource Kit.

2.2.4 PERF2MIB.EXE Performance Monitor MIB Builder Tool

PERF2MIB is another tool that comes with the Resource Kit. It is typically used by developers and it helps create new MIBs using ASN.1 syntax. It is designed for things that use the Performance Monitor counters.
Chapter 3. Domain Management

This chapter documents the built-in administrator capabilities of Windows NT, the Windows NT Resource Kit and IBM add-on functions.

The administration tasks are done with various applications within Windows NT rather than one centralized administration program. File management is done with the File Manager (the Explorer in NT 4.0), printer management from the Print Manager, user management from the User Manager and so on.

3.1 NT Web Administration

The NT Web Administration is a part of the Resource Kit for Windows NT 4.0 Server. (It can also be found on Microsoft’s Web page www.microsoft.com at ntserver/webadmin/webadmindl.htm.) It allows you to administer your Windows NT servers remotely from virtually any HTML browser. It is not in any way intended to replace the standard administration tools that are available, but
merely an additional way of keeping your system up and running, even if you are remotely attached over the network.

Some of the tasks you can perform with NT Web Administration are:

- **Account Management**
  - Create/remove user accounts
  - View/change user information
  - Change user passwords
  - Disable user accounts
  - Create/remove groups
  - Add/remove users to and from groups
  - Add workstations to the domain

- **Share Management**
  - View/create shares for all installed file services (Microsoft, Macintosh and NetWare)
  - Change permissions on shares

- **Session Management**
  - View/delete sessions
  - Send messages to current users of the server

- **Server Management**
  - Shut down/reboot server
  - Change services/driver configuration
  - View system, application and security log events
  - Server configuration data dump

- **Printer Management**
  - List print queues and jobs in each queue
  - Pause/flush queue or specific print job

You are required to have the Internet Information Server 2.0+ (IIS) installed and configured before you attempt to install the NT Web Administration. Since it requires IIS 2.0, NT 3.51 users are unable to use this feature. Clients could still be using NT 3.51, as long as you are using a compatible browser. Even though Web Administration doesn’t get installed when you install the Resource Kit, installation procedures are very straightforward. Just run the setup.exe file from the /Apps/WebAdmin folder. After that, there is very little customization required. Web Administration needs to be installed on all servers you wish to manage. Installing it only on the primary domain controller (PDC) doesn’t help you if you have shares or other manageable resources on other servers.
Before you start your browser after the installation, please make sure that you enable a suitable type of password authentication on the IIS server before you try to connect to it. By default, the Basic (Clear Text) method is turned off, making it impossible to connect with any other browser than the Microsoft Internet Explorer (MSIE).
We noticed some inconsistencies between the MSIE and Netscape Navigator when selecting the right-hand side menu links. The HTML table is different in height when you compare the two, rendering the .gif arrows out of sync. Everything works as it should though; it’s just a visual flaw.

Figure 19. Maintenance Selected with MSIE and Netscape Navigator

Please see the following table about browser/password support for some common versions of MSIE and Netscape Navigator.

<table>
<thead>
<tr>
<th></th>
<th>Basic</th>
<th>Windows NT Challenge</th>
<th>Both</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Explorer 2.0 for Macintosh</td>
<td>Supported</td>
<td>Not supported, can not connect</td>
<td>Supported - Rolls back to Basic</td>
</tr>
<tr>
<td>Internet Explorer 2.0 for Microsoft Windows 95</td>
<td>Supported</td>
<td>Not supported, can not connect</td>
<td>Not supported, does not roll back to Basic, you can not connect</td>
</tr>
<tr>
<td>Internet Explorer 2.0 for Windows 95, plus NTLM patch</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported - Windows NT Challenge Response applied</td>
</tr>
<tr>
<td>Internet Explorer 2.0 for Windows NT 4.0</td>
<td>Supported, but browser will repeatedly ask you for authentication</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Internet Explorer 3.0 for Windows 95/NT 4.0</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported - Windows NT Challenge Response applied</td>
</tr>
<tr>
<td>Netscape Navigator 2.0</td>
<td>Supported</td>
<td>Not supported</td>
<td>Supported - Rolls back to Basic</td>
</tr>
<tr>
<td>Netscape Navigator 3.0</td>
<td>Supported</td>
<td>Not supported</td>
<td>Supported - Rolls back to Basic</td>
</tr>
<tr>
<td>Netscape Communicator 4.0 Beta 2</td>
<td>Supported</td>
<td>Not supported</td>
<td>Supported - Rolls back to Basic</td>
</tr>
</tbody>
</table>
If you have the Windows NT Challenge/Response turned off or if you are using a browser other than MSIE, you will get a window that requests you to log on as soon as you try to select any of the menu links, except for Help.

![Authentication](image)

**Figure 20. Web Administration: Logon Requester**

For MSIE users, the best choice is the Windows NT Challenge/Response. This method is the most sophisticated and doesn’t transmit the password over the connection at all, compared to the Basic authentication which sends the password in clear text. Either way, the user name provided is checked against the members of the administrators group on the machine you are connecting to and you need to be a member of this group to gain access to the server.

Some pros and cons of the NT Web Administration are:

- **Pros**
  - Access is operating system-independent (requires a compatible browser).
  - Easy installation.
  - Free of charge.

- **Cons**
  - Server needs to be accessible over the Internet (if managed from the LAN/WAN).
  - IIS and Web Administration need to be installed on all servers that you want to administer.
  - The server needs to be NT 4.0 to be manageable.

The following sections discuss the similarities and drawbacks when comparing NT Web Administration with the native management tools in Windows NT and those included in the Resource Kit.

### 3.2 NT Management

Windows NT comes with a variety of management tools for different management tasks. Most of them are GUI versions. With the NT Resource Kits you get a set of handy command line (CMD) tools as well as quite a few GUI tools. We only used the NT Resource Kit for NT Server 4.0, but there is also a Resource Kit for NT Workstation 4.0 which is a subset of the server version as well as a new resource kit called the Microsoft Windows NT Server Version 4.0 supplement 1.

Normally, one would prefer to use the GUI-based tools since they tend to be more intuitive and easily manageable. Sometimes though, you learn to appreciate the flexibility of a CMD program, its ability to run batch jobs and the
possibility to run it over a text-based connection such as a TELNET session or a remote console.

3.2.1 Adding Users

This section shows how to perform the user administration function of adding user IDs using the GUI, the command line and the Web Management interface.

3.2.1.1 Adding a User with the Windows NT GUI

1. Start the Windows NT User Manager (for Domains).

![User Manager - WINNT80](image1)

![Groups](image2)

*Figure 21. Windows NT: User Manager*

2. Choose the **User - New User** menu items.

![New User](image3)

*Figure 22. Windows NT: New User*

3. Fill in the appropriate information in the empty fields.

4. Click on the **Add** button.
3.2.1.2 Adding a User from the Windows NT Command Line

You could use the NET USER command to do this if you don’t have the Resource Kit installed or if you only want to add a few users. See Figure 23 for the complete syntax of the NET USER command. As you probably already know your way with the NET commands, we try to use them as little as possible leaving more room for alternative solutions.

```
NET USER [username [password | *] [options]] [/DOMAIN]
    username {password | *} /ADD [options] [/DOMAIN]
    username [/DELETE] [/DOMAIN]
```

The [options] are:

```
/active:{no | yes}
/comment:"Text"
/countrycode:nnn
/expires:{Date | Never}
/fullname:"Name"
/homedir:Path
/homedirreq:{Yes | No}
/passwordchg:{Yes | No}
/passwordreq:{Yes | No}
/profilepath:[Path]
/scriptpath:Path
/times:{Times | All}
/usercomment:"Text"
/workstations:{Computername[,...] | *}
```

Figure 23. Syntax of the NET USER Command

The ADDUSERS.EXE command that comes with the Resource Kit is a very useful command when you want to add many users and groups to an NT server at the same time. Since it reads its input from a text file, you could easily machine-generate this file by exporting an employee record or a list of users to an ASCII-file with the format described in Figure 25 on page 30. For the complete syntax of the ADDUSERS.EXE command, see Figure 24.

```
ADDUSERS [/?] [\computername [[/c | /d | /e] filename]] [/s:?]
```

/? Display this help screen.
/c Create accounts specified in the file.
/d Write current accounts to the specified file.
/e Erase user accounts specified in the file.
/s:? Sets the separator character for the input/output file. Replace the ? with the character to be used for separating fields. (eg /s:’)

Note: The separator character is a comma ‘,’ by default.

For detailed information please refer to the Resource Kit Help file.

Figure 24. Syntax of the ADDUSERS.EXE Command
Figure 25. Format of ASCII-file for Use with ADDUSERS.EXE

Note

The syntax mentioned in the Windows NT Resource Kit help file differs from the actual ADDUSERS.EXE syntax regarding the <Description> parameter.

Windows NT Resource Kit help file format:

[Users]
<User Name>,<Full Name>,<Password>,<Home Drive>,<Home Path>,<Profile>,<Script>

ADDUSERS.EXE format:

[Users]
<User Name>,<Full Name>,<Password>,<Description>,<Home Drive>,
<Home Path>,<Profile>,<Script>

The <Description> parameter is left out in the help file. Trying to add users from a file based on this syntax will not generate any error messages (except if the fields you specify contain illegal information) but will generate user accounts with invalid values in the fields after <Password>.

1. Create a text file (users.txt) containing the user(s) you want to add.
2. Issue the ADDUSERS \<Servername> /c users.txt command.

Figure 26. Windows NT CMD: Adding a User with the ADDUSERS.EXE Command
3.2.1.3 Adding a User with the Web Management Interface

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the Accounts link.
3. Click on the Users link.

This will bring you to the following window:

![User Accounts](image)

Figure 27. Web Administration: User Accounts

4. Click on the Create New button.

![Create New User Account](image)

Figure 28. Web Administration: Create New User Account

5. Fill in the appropriate information in the empty fields.
6. Click on the Create button.

3.2.2 Editing Users

This section shows how to perform the user administration function of editing user IDs using the GUI, the command line and the Web Management interface.

3.2.2.1 Editing User IDs with the Windows NT GUI

1. Start the Windows NT User Manager (for Domains).
2. Select the user you wish to edit.
3. Either double-click, press Enter or choose the User - Properties menu items.
4. Edit the desired fields.
5. Click on the OK button.

3.2.2.2 Editing User IDs from the Windows NT Command Line
Editing users from the Windows NT command line using the NET USER command is very tedious work, especially if you want to change more than one parameter at a time. See Figure 23 on page 29 for the complete syntax of the NET USER command. The Windows NT ADDUSERS.EXE command doesn't let you change users properties.

3.2.2.3 Editing User IDs with the Web Management Interface
1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the Accounts link.
3. Click on the Users link.
4. Select the user you wish to edit.
5. Click on the Properties button.

This will bring you to the following window:
6. Edit the desired fields.
7. Click on the **Update** button.

### 3.2.3 Removing User Accounts

This section shows how to perform the user administration function of removing user IDs using the GUI, the command line and the Web Management interface.

**Note**

If you remove a user account and create a new one with the same name, it will *not* restore access to resources that currently reference this user account in the access control list.

### 3.2.3.1 Removing a User with the Windows NT GUI

1. Start the Windows NT User Manager (for Domains).
2. Select the user you wish to delete.
3. Click on the **Delete** button or choose the **User - Delete** menu items.

### 3.2.3.2 Removing a User ID from the Windows NT Command Line

You could use the NET USER command to do this if you don’t have the Resource Kit installed or if you only want to remove a few users. See Figure 23 on page 29 for the complete syntax of the NET USER command. The fastest way to remove many users from a server using the Windows NT command line is to export the user data to a file, edit the file and then use the ADDUSERS.EXE command to remove them.

1. Dump the user data to a text file (users.txt) by issuing the `ADDUSERS \<servername> /d users.txt` command.
2. Edit the file in a text editor of your choice, removing all the group sections and the users you want to keep.

When you’re done, the file should only contain the users you want to remove.

3. Issue the ADDUSERS \<Servername> /e users.txt command.

![Image of Command Prompt showing ADDUSERS command output]

3.2.3.3 Removing a User ID with the Web Management Interface

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the Accounts link.
3. Click on the Users link.
4. Select the user you wish to delete.
5. Click on the Delete button.

You will get the following window:

![Image of Delete User NTUser dialog box]

3.2.4 Adding Local Groups

The concept of groups in Windows NT greatly simplifies the assignment of permissions and rights in your NT environment. There are two types of groups available in Windows NT, local and global, and they differ considerably from each other.
On a Windows NT Server, a local group can only be granted permissions and rights for the domain controllers of its own domain but it can contain user accounts and global groups both from its own domain and from trusted domains.

A global group on the other hand can be used in its own domain (on member servers and workstations) and on trusted domains. It can become a member of a local group but only contain user accounts from its own domain.

### 3.2.4.1 Adding a Local Group with the Windows NT GUI

1. Start the Windows NT User Manager (for Domains).
2. Choose the **User - New Local Group** menu items.

![New Local Group](image1.png)

Figure 34. Windows NT: New Local Group

3. Fill in the appropriate information in the empty fields.
4. Click on the **OK** button.

### 3.2.4.2 Adding a Local Group from the Windows NT Command Line

The NET GROUP command doesn’t support adding local groups to a server. It can only operate on global groups when in a domain. See Figure 35 for the complete syntax of the NET GROUP command.

```
NET GROUP [groupname [/COMMENT:"text"] ] [/DOMAIN]
    groupname [/ADD [/COMMENT:"text"] | /DELETE ] [/DOMAIN]
    groupname username [...] [/ADD | /DELETE ] [/DOMAIN]
```

Figure 35. Syntax of the NET GROUP Command

Instead, we used the ADDUSERS.EXE command from the Windows NT Resource Kit.

1. Create a text file (users.txt) containing the local group(s) you want to add. See Figure 25 on page 30 for the correct format.
2. Issue the ADDUSERS \\<servername> /c users.txt command.
3.2.4.3 Adding a Local Group with the Web Management Interface

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the Accounts link.
3. Click on the Groups link.
4. Click on the Create button.

You will get the following window:

![New Group Information](image)

5. Fill in the appropriate information in the empty fields.
6. Click on the Create button.

3.2.5 Editing Groups

- Web Management doesn’t let you populate a group with members. Instead you have to assign groups to users.
- Web Management doesn’t let you change the description of a group.

3.2.5.1 Editing Groups with the Windows NT GUI

1. Start the Windows NT User Manager (for Domains).
2. Select the group you wish to edit.
3. Either double-click, press Enter or choose the User - Properties menu items.
4. Add/Remove users and/or change the description.
5. Click on the OK button.

3.2.5.2 Editing Groups from the Windows NT Command Line

The Windows NT Resource Kit ADDUSERS.EXE command doesn’t let you edit groups. Instead you have to use the NET GROUP command. See Figure 35 on page 35 for the complete syntax of the NET GROUP command.

3.2.5.3 Editing Groups with the Web Management Interface

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the Accounts link.
3. Click on the Users link.
4. Select the user you wish to edit group memberships for.
5. Click on the Groups button and you will get the following window:
3.2.6 Removing Groups

When removing groups, be sure you are aware of all the resources that use the group for permission control. If you’re not the only one using the group, removing it could be fatal for access elsewhere in your system. Write descriptive comments for the groups to help avoid unnecessary work recreating the structure. If you delete a group and create a new one with the same name, it will not restore the access to your resources.

3.2.6.1 Removing Groups with the Windows NT GUI

1. Start the Windows NT User Manager (for Domains).
2. Select the group you wish to delete.
3. Click on the **Delete** button or choose the **User - Delete** menu items.

4. Select **OK**.

3.2.6.2 Removing Groups from the Windows NT Command Line

The fastest way to remove many groups from a server using the Windows NT command line is to export the group data to a file, edit the file and then use the ADDUSERS.EXE command to remove them.

1. Dump the group data to a text file (users.txt) by issuing the `ADDUSERS \\<servername> /d users.txt` command.
2. Edit the file in a text editor of your choice, removing the user section and all the group sections that you want to keep.

   When you’re done, the file should only contain the groups you want to remove.
3. Issue the `ADDUSERS \\<servername> /e users.txt` command.
3.2.6.3 Removing Groups with the Web Management Interface

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the Accounts link.
3. Click on the Groups link.

4. Select the group you wish to delete.
5. Click on the Delete button.

6. Click on the Delete button.
3.2.7 Adding Global Groups

For an explanation of global and local groups, see 3.2.4, “Adding Local Groups” on page 34.

3.2.7.1 Adding Global Groups with the Windows NT GUI

1. Start the Windows NT User Manager (for Domains).
2. Choose the User - New Global Group menu items.

![New Global Group window]

3. Fill in the appropriate information in the empty fields.
4. Click on the OK button.

3.2.7.2 Adding Global Groups from the Windows NT Command Line

You could use the NET GROUP command to do this if you don’t have the Resource Kit installed or if you only want to add a few global groups. See Figure 35 on page 35 for the complete syntax of the NET GROUP command.

1. Create a text file (users.txt) containing the group(s) you want to add.
2. Issue the ADDUSERS \<servername> /c users.txt command.
3.2.7.3 Adding Global Groups with the Web Management Interface
You can not add global groups using the Web Management interface.

3.2.8 Creating Shared Directories
The easiest way to access a resource from another computer is to share the resource. This way, the resource owner has full control over who can use the resource and for what.

The folder to be shared needs to be physically present in the machine on which the share is done. This means that you can’t share a folder that you have connected to from another machine. However, with the Resource Kit there are two useful tools to handle remote sharing of folders. The first is a command line tool called rmtshare.exe and the other is a DLL that lets you share a folder that doesn’t reside on the machine you are running on.
RMTSHARE  \\server\sharename  \\
\\server\sharename=drive:path [/[USERS:number | /UNLIMITED]  
[/REMARK:"text"]  
[/GRANT [user[:perm]] [ /GRANT user[:perm]]]  
[/REMOVE user]  
\\server\sharename=printername /PRINTER [/USERS:number | /UNLIMITED]  
[/REMARK:"text"]  
[/GRANT [user[:perm]] [ /GRANT user[:perm]]]  
[/REMOVE user]  
\\server\sharename [/USERS:number | /UNLIMITED]  
[/REMARK:"text"]  
[/GRANT [user[:perm]] [ /GRANT user[:perm]]]  
[/REMOVE user]  
\\server\sharename /DELETE

NOTE: if a sharename or path contains spaces, it should be enclosed in quotes:
\\server\"with space"="c:\with space"

Figure 47. Syntax of the RMTSHARE.EXE Command

![Command Prompt](c:\>net view \\winnt87  
Shared resources at \\winnt87  
Share name | Type | Used as | Comment  
---------------------- | -------- | -------- | ---------  
TEMP | Disk | Share of remote TEMP catalog  
The command completed successfully.

![Command Prompt](c:\>rmtshare \\winnt87\Notes=c:\Notes  
The command completed successfully.

![Command Prompt](c:\>net view \\winnt87  
Shared resources at \\winnt87  
Share name | Type | Used as | Comment  
---------------------- | -------- | -------- | ---------  
Notes | Disk | Shared by remote command.  
TEMP | Disk | Share of remote TEMP catalog  
The command completed successfully.

Figure 48. Windows NT CMD: Creating a Remote Share with RMTSHARE.EXE

To install the .DLL, right-click on the ShareUI.inf file in your /RESKIT folder and choose Install. To see what it can do, connect to a host of your choice in the Explorer.
As you can see, there's a new drawer on each host called Shared Directories that contains all available shares on each particular host.

Select New - Share from the File menu as shown in Figure 50.

Fill in the fields with the appropriate information. Unfortunately you need to know the exact path to where you want the share to be, so a Browse button might be a useful addition in future versions.
Figure 51. ShareUI: New Share

The share is created on the remote host (provided you have permission to do so) and you can now access the information using this share or map it to a drive on your machine.

Figure 52. ShareUI: Shared Directories 2

3.2.8.1 Creating Shared Directories with the Windows NT GUI

1. Using the Windows Explorer, select the folder you wish to share and click the right mouse button.
2. Select Sharing.
3. Change the radio button from Not Shared to Shared As.
4. Change or accept the default share name and optionally enter a comment.
5. Select **OK**.

### 3.2.8.2 Creating Shared Folders from the Windows NT Command Line

1. Make sure you know the path to the folder you wish to share.
2. Issue the `NET SHARE sharename=drive:path /REMARK:"Optional Remark"` command. See Figure 55 on page 46 for the complete syntax of the NET SHARE command.
3.2.8.3 Creating Shared Folders with the Web Management Interface

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the File System link.
3. Click on the Shared Directories link.

4. Click on the Create New button.
New Share Information
This is the folder you selected to share:
C:\TEMP

Type the name you want to give this share:
TEMP

Type a description for this share:
Share of the TEMP catalog

Who do you want to have access to this share:
☐ Microsoft Windows Users
☐ NetWare Users
☐ Macintosh Users

User limit:
☐ Maximum Allowed
Number Of Users: 0

Add Cancel

Figure 57. Web Administration: New Share Information

5. Fill in the appropriate information in the empty fields.
6. Click on the Add button.

3.2.9 Editing Share Permissions
This section shows how to perform the user administration function of editing share permissions using the GUI and the command line.

3.2.9.1 Edit Share Permissions with the Windows NT GUI
1. Using the Explorer, select the share you wish to edit and click the right mouse button.
2. Select Sharing.
3. Click on the Permissions button.

Figure 58. Windows NT: Access through Share Permissions
4. If the user/group already exists, use Type of Access to edit it. If not, select Remove or Add.

![Add Users and Groups](image)

**Figure 59. Windows NT: Add Users and Groups**

5. Select the users/groups you want to add and set the access permissions in the Type of Access field.

6. Click on the OK button.

### 3.2.9.2 Edit Share Permissions from the Windows NT Command Line

1. If you want to check the permissions before you edit them, issue the RMTSHARE `\<servername>\<sharename>` command.

2. Use the /GRANT switch to specify the rights. See Figure 47 on page 42 for the complete syntax of the RMTSHARE command.
3.2.9.3 Edit Share Permissions with the Web Management Interface

You can’t edit shares using Web Administration. Work around this by deleting the person/group you wish to edit from the Access Control List and then adding them again.

3.2.10 Removing Shares

This section shows how to perform the user administration function of removing shares using the GUI, the command line and the Web Management interface.

3.2.10.1 Removing a Share with the Windows NT GUI

1. Using the Explorer, select the shared folder you wish to remove the share attribute from and click the right mouse button.
2. Select Sharing.
3. Change the radio button from Shared As to Not Shared.
4. Select OK.

3.2.10.2 Removing a Share from the Windows NT Command Line

1. Find out the share name by issuing the NET SHARE command.
2. Issue the NET SHARE sharename /DELETE command. See Figure 55 on page 46 for the complete syntax of the NET SHARE command.
3.2.10.3 Removing a Share with the Web Management Interface
1. Connect to the server with your browser
   (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the File System link.
3. Click on the Shared Directories link (see Figure 56 on page 46).
4. Click on the Delete button.

3.2.11 File System Management (File/Folder Permissions)
This section shows how to perform the user administration function of managing
file systems using the GUI, the command line and the Web Management
interface.

3.2.11.1 Managing Permissions with the Windows NT GUI
1. Using the Explorer, select the file/folder you wish to alter permissions for
   and click the right mouse button.
2. Select Properties.
3. Select the **Security** tab.

4. If the user/group already exists, use Type of Access to edit it. If not, select **Remove** or **Add**.
5. Select the users/groups you want to add and set the access with Type of Access.
6. Click on the **OK** button.
3.2.11.2 Managing Permissions from the Windows NT Command Line

Permission management from the Windows NT command line is done with the cacls.exe command. See Figure 64 for the complete syntax of the cacls.exe command.

<table>
<thead>
<tr>
<th>Displays or modifies access control lists (ACLs) of files</th>
</tr>
</thead>
<tbody>
<tr>
<td>[/P user:perm [...] ] [/D user [...] ]</td>
</tr>
<tr>
<td>filename Displays ACLs.</td>
</tr>
<tr>
<td>/T Changes ACLs of specified files in the current directory and all subdirectories.</td>
</tr>
<tr>
<td>/E Edit ACL instead of replacing it.</td>
</tr>
<tr>
<td>/C Continue on access denied errors.</td>
</tr>
<tr>
<td>/G user:perm Grant specified user access rights.</td>
</tr>
<tr>
<td>Perm can be: R Read</td>
</tr>
<tr>
<td>C Change (write)</td>
</tr>
<tr>
<td>F Full control</td>
</tr>
<tr>
<td>/R user Revoke specified user's access rights (only valid with /E).</td>
</tr>
<tr>
<td>/P user:perm Replace specified user's access rights.</td>
</tr>
<tr>
<td>Perm can be: N None</td>
</tr>
<tr>
<td>R Read</td>
</tr>
<tr>
<td>C Change (write)</td>
</tr>
<tr>
<td>F Full control</td>
</tr>
<tr>
<td>/D user Deny specified user access.</td>
</tr>
</tbody>
</table>

Wildcards can be used to specify more than one file in a command. You can specify more than one user in a command.

Figure 64. Syntax of the CACLS.EXE Command

3.2.11.3 Managing Permissions with the Web Management Interface

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the File System link.
3. Click on the File and Folder Access for NTFS partitions link.

4. Select the folder and file you wish to edit.
5. Click on the Permissions button.

Figure 65. Web Administration: Select File/Folder

52 Windows NT Systems Management
3.2.12 Broadcasting Messages

Broadcasting a message will pop up a box on the connected users screens (provided they have the Messenger service started). Any user logged on can send a message to or from any workstation or server on the network that they can connect to.

3.2.12.1 Broadcasting a Message with the Windows NT GUI

1. Start the Windows NT Server Manager.

2. Select the desired computer to broadcast message to.

3. Choose the **Computer - Send Message** menu items.
4. Type the message you wish to broadcast.
5. Click on the **OK** button.

### 3.2.12.2 Broadcasting a Message from the Windows NT Command Line

Broadcasting a message from the Windows NT command line is done with the NET SEND command. See Figure 70 for the complete syntax of the NET SEND command.

```
NET SEND {name | * | /DOMAIN[:name] | /USERS} message
```

*Figure 70. Syntax of the NET SEND Command*

---

```cmd
C:\>net send /USERS "Warning! The server will be shut down in 2 minutes!"
The message was successfully sent to all users of this server.
C:\>
```

*Figure 71. Windows NT CMD: NET SEND Command*
3.2.12.3 Broadcasting a Message with the Web Management Interface

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the Maintenance link.
3. Click on the Broadcast Message link.

4. Type the message you wish to broadcast.
5. Click on the Send Message button.

3.2.13 Remote Console

The Remote Console Server is a part of the Windows NT Resource Kit and needs to be installed on the machines you wish to be able to connect to in order to use the remote client (rclient). The Remote Console Client is provided both with the Windows NT Resource Kit and with the Windows NT Web Administration. We have found this connection method to be a better alternative for remote sessions than the telnetd service. Both services are still in beta and you may experience some problems. At times we lost the connection between the systems without any apparent reason. Since the rclient requires you to connect from an NT workstation, the telnetd service is still a good way to connect from other operating systems.

3.2.13.1 Using Remote Console with the Windows NT GUI

You can not use the remote console with the Windows NT GUI.

3.2.13.2 Using Remote Console from the Windows NT Command Line

1. Make sure the Remote Console Server is running on the machine you’re connecting to.
2. Issue the RCLIENT \\COMPUTERNAME command. See Figure 74 on page 56 for the complete syntax of the rclient.exe command.
3. When you are finished working on the remote machine, type `exit`.

### 3.2.13.3 Using the Remote Console with the Web Management Interface

The Remote Console isn’t really a Web Administration function. The browser merely provides you with the executable if you should end up on a workstation that doesn’t have it installed; be aware that it needs to be a Windows NT workstation though.
3.2.14 Rebooting Servers

This section shows how to perform the user administrator function of rebooting servers. The server can be local or remote.

3.2.14.1 Rebooting Server with the Windows NT GUI

1. Start the Windows NT Shutdown Manager.

To download a Remote Console client, click the Remote Console link that corresponds to the platform you are currently using. This utility only works Microsoft Windows NT clients.

Remote Console Utility (rcclient.exe) for:

- Intel
- PPC
- MIPS
- Alpha
2. Select the desired computer to shut down.
3. Edit the message text or accept the default.
4. Click on the OK button.

3.2.14.2 Rebooting Server from the Windows NT Command Line
Shutting down or rebooting a machine from the Windows NT command line requires the SHUTDOWN.EXE command from the Windows NT Resource Kit.

Release 2.0 written by A. Blatzheim 1993 at Microsoft GmbH


/? Shows this screen.
\Computer Specifies a remote computer to shutdown.
/L Specifies a local shutdown.
/A Aborts a system shutdown. This is only possible during the timeout period. If this switch is used, all other are ignored.
/R Specifies that the machine should reboot after shutdown.
/T:xx Sets the timer for system shutdown in seconds.[20 sec. default]
"Msg" Specifies an additional message
/Y Answer all following questions with yes
/C Forces running applications to close.

ATTENTION: If you use the /C parameter NT ignores the applications option to save data which may have changed. You will see no File-Save dialog box, because NT will force the application to close. This will result in a loss of all data. not previously saved !!!

Figure 77. Syntax for the SHUTDOWN.EXE Command

Issue the shutdown /L /T:200 /Y /R "This machine is being rebooted for maintenance!" command.
3.2.14.3 Rebooting Server with the Web Management Interface

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the **Maintenance** link.
3. Click on the **Reboot Server** link.
4. Edit the message text or accept the default.
5. Click on the **Reboot** button.

3.2.15 Printer Management

This section shows how to perform the user administrator function of managing printers. We show how to do that from the GUI, the command line and from the Web Management interface.

3.2.15.1 Managing Printers with the Windows NT GUI

1. Start the Printer Manager.
2. Double-click on the printer you want to manage.

3. Double-click on the job you want to manage.
3.2.15.2 Managing Printers from the Windows NT Command Line

```plaintext
NET PRINT \computername\sharename
[\computername] job# [/HOLD | /RELEASE | /DELETE]
```

Figure 83. Syntax of the NET PRINT Command

Figure 84. Windows NT CMD: Managing Printer Jobs Using the NET PRINT Command

3.2.15.3 Managing Printers with the Web Management Interface

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the Printers link.

![Printers](image)

Figure 85. Web Administration: Printers

3. Select the printer you want to manage.
4. Click on the Jobs button.
5. Select the job you want to manage.
3.2.16 Device Management

In Windows NT 4.0 a new feature was added that helped with the management of hardware profiles. It lets you start different components depending on your current configuration. If you are using a laptop for instance, you might not want to start your SCSI drivers when you aren’t docked since your SCSI interface is located in your docking station.

3.2.16.1 Managing Devices with the Windows NT GUI

Devices are managed with the Device Manager (Devices) located in the Control Panel.

Here you can start and stop devices installed on your system, change hardware profile settings and change the startup type.
3.2.16.2 Managing Devices from the Windows NT Command Line

You cannot manage devices using the command line interface.

3.2.16.3 Managing Devices with the Web Management Interface

Management of the hardware profiles through the Web Management interface is done as follows:

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the Devices link.
Here you can start and stop devices installed on your system and change the startup type.

One odd thing we discovered while testing the Device Manager with Web Administration was that the list of devices isn’t consistently sorted.
We have no explanation for this phenomenon but the error is consistent across all servers that we worked on.

### 3.2.17 Services Management

This section shows how to manage the startup of NT Services using the GUI, command line, and Web Management interface.

#### 3.2.17.1 Managing Services with the Windows NT GUI

1. Start the Service Manager (Services) from the Control Panel.

![Figure 93. Windows NT: Services](image)

Here you can start, stop, pause and change the startup type and hardware profile settings (see 3.2.16, “Device Management” on page 62) for services installed on your system.

2. Click on the **Startup** button.
3.2.17.2 Managing Services from the Windows NT Command Line

Managing services from the Windows NT command line is an inefficient task using the NET [START | STOP | PAUSE | CONTINUE] command. Installed but stopped services are not visible at all and paused services show up in the started list.

To list started services, issue the NET START without any switches.

3.2.17.3 Managing Services with the Web Management Interface

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the Services link.

![Service Manager](image)

**Figure 94. Windows NT: Service Startup**

Here you can start, stop, pause and change the startup type for services installed on your system.

3. Click on the Startup button and edit the settings.

**Figure 95. Web Administration: Service Manager**
4. Click on the **Update** button.

The same problem with inconsistent sorting as in the Device Management with the Web Management Interface (please see 3.2.16.3, "Managing Devices with the Web Management Interface" on page 63) occurs in the Services list.

### 3.2.18 Sessions Management

This section shows how to manage sessions using the GUI, command line, and Web Management interface.

#### 3.2.18.1 Managing Sessions with the Windows NT GUI

1. Start the Windows NT Server Manager (Figure 68 on page 53).
2. Select the desired computer to manage sessions on.
3. Double-click on the selected server and click on the **Users** button.

![User Sessions on WINNT88](image)

*Figure 96. Windows NT: User Sessions*

4. Disconnect the connection(s).
5. Click on the **Close** button.

#### 3.2.18.2 Managing Sessions from the Windows NT Command Line

Use the NET SESSION command to list all sessions on your machine. See Figure 98 on page 68 for complete syntax of the NET SESSION command.
Figure 97. Windows NT CMD: Managing Sessions Using the NET SESSION Command

The syntax of this command is:

```
NET SESSION \\computername [ /DELETE]
```

Figure 98. Syntax of the NET SESSION Command

3.2.18.3 Managing Sessions with the Web Management Interface

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the Sessions link.

```
Sessions

<table>
<thead>
<tr>
<th>User</th>
<th>Computer</th>
<th>Opens</th>
<th>Time</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>administrator</td>
<td>WINNT38</td>
<td>46</td>
<td>00:00 hrs</td>
<td></td>
</tr>
<tr>
<td></td>
<td>WINNT38</td>
<td>0</td>
<td>00:00 hrs</td>
<td></td>
</tr>
</tbody>
</table>
```

Figure 99. Web Administration: Sessions

3. Select the session you would like to get information on.
3.2.19 Performance Management

This section provides a brief overview of how to use the Web Management interface to get performance data.

3.2.19.1 Managing Performance with the Windows NT GUI

3.2.19.2 Managing Performance from the Windows NT Command Line
It’s not possible to do any performance management from the command prompt.

3.2.19.3 Managing Performance with the Web Management Interface
1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the Status link.
3. Click on the Performance Statistics link.
4. Select the object of interest and click on the Counters button.
3.2.20 Server Configuration

Configuring the server is done using different tools for different parts of the server. This section shows how to display the various settings using the three different approaches: GUI, command line and Web.

3.2.20.1 Managing Server Configuration with the Windows NT GUI

1. Start the Windows NT Diagnostics Program from the Administrative Tools Group.

   You can also start it from the command line. The executable is located at `\winnt\winmsd.exe`.

2. Navigate your way through the application using the available tabs.
3.2.20.2 Managing Server Configuration from the Windows NT Command Line

There isn’t much hardware information available from the command line. Using the NET CONFIG [SERVER | WORKSTATION] will give you some information about OS level and NICs.

If you use the command line interface for winsmd /? you will find there are a few things that you can do. You can get the following reports:

- A complete system report
- A summary system report

For a sample of the summary report, see Appendix B, “Windows NT Diagnostic Summary” on page 275.

3.2.20.3 Managing Server Configuration with the Web Management Interface

1. Connect to the server with your browser (http://<Servername>/NTAdmin/NTAdmin.htm).
2. Click on the Status link.
3. Click on the Server Configuration link.

Figure 104. Web Administration: Configuration Category

4. Select a category of interest and click on the Get Configuration button.

Figure 105. Web Administration: Server Configuration
When displaying the operating system version, we discovered an inability for the Web Administration Interface to correctly display the Service Pack level of the queried machine. When using the GUI application the correct information was displayed. This error was consistent on all machines we tested the Web administration on.

3.2.21 Web Administration Preferences

Under the Web administration menu maintenance is a selection called Web Administration Preferences.

<table>
<thead>
<tr>
<th>Web NT Admin Preferences</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td><strong>High Boundary</strong></td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td>CPU Utilization:</td>
</tr>
<tr>
<td>Disk Space Utilization:</td>
</tr>
<tr>
<td>Memory Utilization:</td>
</tr>
<tr>
<td>Network Utilization:</td>
</tr>
<tr>
<td>Number Of Sessions:</td>
</tr>
</tbody>
</table>

Ensure use of SSL secured channel

Note:

- Low Boundary - the text "Low" and a sunny sky bitmap will be displayed.
- High Boundary - the text "High" and a stormy sky bitmap will be displayed.
- Between Low and High - the text "Medium" and a cloudy sky bitmap will be displayed.

*Figure 106. Web Administration: Preferences*

This applies to the General Windows NT Server status information reachable from the Welcome screen of Web administration (see Figure 16 on page 23).
Depending on the workload of your server, you should change these to fit your server.

### 3.3 User Synchronization between Lotus Notes and Windows NT

Lotus Notes Domino provides a way to tightly integrate user administration and authentication between Lotus Notes and Windows NT. With just a few exceptions, the administrator can now synchronize Person documents in the Notes Name & Address Book (NAB) and user accounts on the Windows NT server. This synchronization works both ways, allowing the administrator to either have Lotus Notes generating or deleting Windows NT users or vice versa.

After installing User synchronization, a new menu item, Notes, is added to the Windows NT User Manager for Domains. This menu contains several options that effect how synchronization is performed.

All of the settings are on a per session basis and don’t get saved for future use. If the User Manager is closed and re-opened, the settings are lost.
User synchronization lets you keep both the NAB and User Manager current, without having to update both when either changes. Also, you can manage user information in the NAB and User Manager through the interface of your choice, either Lotus Notes or Windows NT. Not all fields are synchronized though. For example, changes to the users full names on one system do not cause an update on the other.

You are required to have a Notes user ID with appropriate access to make any changes to a Lotus Notes server’s public address book, even when using Windows NT to do this. To add users you also need access to the certifier with which you wish to certify the users. On the NT side, you must be a member of the administrator group or account operator group to add user accounts to User Manager.

### 3.3.1 Installation of the User Synchronization

The easiest way to install the Lotus Notes User synchronization is to do it while installing the Lotus Notes server. By default, this option is not checked when you choose the customized install and you have to make sure you select it manually.

If you already have installed the Lotus Notes server but didn’t install the Lotus Notes User synchronization, run the installation program again and select only the Lotus Notes User synchronization using the customized installation.

![Figure 109. Lotus Notes User Synchronization: Installation](image)

You will get a warning message as you try to check the User synchronization box, informing you of the requirement to have administrator rights to install the product. Make sure you are an administrator or equivalent before you proceed.
When the installation is done, start the User Manager to see the new options.

### 3.3.2 User Synchronization Settings

The first thing you need to do is to enable the User synchronization from the Notes menu in the User Manager.

#### 3.3.2.1 Registration Setup

When choosing this menu item, the User Manager looks in your notes.ini file for a valid Notes user ID. If Lotus Notes Single Logon isn’t enabled or if you haven’t already authenticated it in this session, a Notes Password requester will pop up asking you for the appropriate password.

After authentication you will get prompted for the certifier ID to use.
The following screen resembles the Register Person screen (Figure 132 on page 82) that you have to fill in when registering users in Notes. Fill in the appropriate information regarding server and license information. If you plan on using the Lotus Notes Single Logon service, make sure Use common Notes/NT password is checked. At registration time you have the option to change this for individual users providing you don’t use the quick registration.

![Notes Registration Setup](image1)

**Figure 114. Lotus Notes User Synchronization: Notes Registration Setup**

**Note.**

Selecting the **Use common Notes/NT password** option will cause the existing NT password for the NT user to be replaced with the common NT/Notes password. Make sure you inform the user about this if the account is active when synchronizing with Notes.

### 3.3.2.2 Mail/ID Registration Options

Selecting the mail server to be used when registering the users is done in the same manner as registering the users from Lotus Notes (see Figure 134 on page 83).

![Notes Mail/ID Registration Options](image2)

**Figure 115. Lotus Notes User Synchronization: Notes Mail/ID Registration Options**
3.3.2.3 Deletion/Rename Options

When deleting a user, Lotus Notes uses the Administration Process (Service Task ADMINP) on the server to remove the necessary files and references. If you choose to delete a user’s mail file when deleting a user, an Approve File Deletion request is generated in the Administration Requests database. See 3.3.5.2, “Deleting Users from Lotus Notes” on page 89 for how this is done.

![Figure 116. Lotus Notes User Synchronization: Notes User Deletion and Rename Options](image)

3.3.3 Adding Users

The administrator has the ability to add users to the system either from Lotus Notes or from Windows NT. Even though the accounts get synchronized there’s still information that has to be edited manually after the registration is done. Both approaches will be demonstrated in this chapter but there’s always additional refinements that can be done, such as using user templates or flat file registering of users.

3.3.3.1 Adding One User to Lotus Notes from Windows NT

1. Start the User Manager for Domains.
2. Select the user you wish to add as a Lotus Notes user.
3. From the Notes menu, select Add selected NT users to Notes.

![Figure 117. Lotus Notes User Synchronization: User Registry Confirmation](image)

4. Select OK.
5. Assuming you want to use a common NT/Notes password, enter a password that will be used for the user to verify both Windows NT logins and Lotus Notes ID file access.

Make sure that the password meets the security requirements of both systems in terms of its naming convention.
6. Click on the **OK** button.

![Figure 118. Lotus Notes User Synchronization: Enter Notes User Information](image)

7. Click on **OK**.

![Figure 119. Lotus Notes User Synchronization: Begin Registration](image)

8. To start the registration process, select the **Begin Registration** button.

   The system will create an ID file for the user, certify it with the certification ID specified and create the user’s mail file.

![Figure 120. Lotus Notes User Synchronization:](image)

9. Click on the **OK** button.

   To look at the user, open the Notes Address Book on the server and select the **People** view.
3.3.3.2 Adding Multiple Users from Windows NT to Lotus Notes
To add multiple user IDs at the same time:
1. Start the User Manager for Domains.
2. Select the users you wish to add as Lotus Notes users.

3. From the Notes menu, select Add selected NT users to Notes.

4. To start the registration process, select the Begin Registration button.
The system will create all of the ID files for the users, certify them with the certification ID specified and finally create all of the user’s mail files.

You can choose to register the users without specifying any passwords (quick installation).

The system will generate random numbers for passwords and store them on the Lotus Notes server in a database called NTSYNC45.NSF. If this database isn’t present on the server, one will be created for you.

This newly created database contains only one view listing the user names and the creation date.
3.3.4 Creating Users

In addition to adding users that are already registered in Windows NT, the administrator can choose to register new users and create them in both environments at the same time.

3.3.4.1 Creating Users from Lotus Notes

1. Start the Lotus Notes Client.
2. Select the File - Tools - Server Administration menu items.
3. Click on the People button and choose Register Person from the menu that appears.
4. Lotus Notes will prompt you with a license question. Make sure you have enough licenses and click on the Yes button.

5. Edit all the fields to reflect your server policies. Don’t forget to check the Add NT User Account(s) and select an initial Windows NT group for the user.

6. In the Basic section of the Register Person request form there is a new field for specifying the NT User Name. Change this to fit your Windows NT naming conventions if you have any.
7. The Mail section should also be edited to match your server policies.

8. Click on the **Register** button to start the registration process.

9. The user has now been registered both in Lotus Notes (Figure 135 on page 84) and in Windows NT (Figure 136 on page 84).
3.3.4.2 Creating Users from Windows NT

1. Start the User Manager (for Domains).
2. In order to synchronize the new user with Lotus Notes, check **Enable Notes User Registration** in the Notes menu (Figure 111 on page 75).
3. Select **User - New User** and fill in the fields as you normally would. There’s no need to give the user a password though, as you will have to reenter it anyway in the next screen.
4. When that is completed select the Add button and a Notes User request form will pop up asking you for confirmation of the user name and to enter a password common to Windows NT and Lotus Notes.

5. Select the Close button if you don’t want to add more users.

6. To start the registration process, click on the Begin Registration button (see Figure 119 on page 78).

7. Click on the OK button to finish the registration process.

8. The newly added user shows up in Windows NT and in Lotus Notes. Figure 139 on page 86 shows the fields from the Person document on the Lotus Notes server.
3.3.5 Deleting Users

Deleting users from either system requires consideration as re-creation of users doesn’t restore the previous access levels or database assignments. However, if a user document is deleted from the NAB using the Delete key instead of the Delete User Action, all user entry’s will still be left in the server(s) Access Control Lists (ACLs). Creating a new user with the exact same name and organization will grant that user the current rights in the databases as Lotus Notes verifies the user’s access to a database by comparing the user name with the entry in the ACL.

3.3.5.1 Deleting Users from Windows NT

When deleting users from Windows NT, nothing will be synchronized with Lotus Notes unless you have the Enable Notes User Deletion box checked in the Notes User Deletion and Rename options (see Figure 116 on page 77).

1. Start the User Manager (for Domains).
2. Mark the selected user that you wish to remove from both Windows NT and Lotus Notes.
3. Select User - Delete to remove the user. Don’t use the Delete key on the keyboard.
4. Click on the OK button.

In Lotus Notes, a series of administration requests will get generated and put in the Administration Requests database on your Lotus Notes server.

![Lotus Notes User Synchronization: Administration Requests](image1)

Figure 141. Lotus Notes User Synchronization: Administration Requests

If you choose to delete a user’s mail file, the administration process generates an Approve File Deletion request that shows up in the Pending Administrators Approval View of the Administration Requests database.

![Approve File Deletion](image2)
To confirm that the mail file should be deleted, you have to open the request in edit mode and click on Approve File Deletion for ADMINP to process the request.

```
**Administration Process Request**

- **Action:** Approve File Deletion
- **Server(s) to perform the action:** ITSLab1/ITSO
- **Replica ID:** 05256492.0070C636
- **Name(s) to perform the action on:** Felix Koop/ITSO
- **Action requested by:** ITSLab1/ITSO
- **Name of process to perform action:** Adminp
- **Database name:** mailKoop.nsf
- **Database title:** Felix Koop
- **Database ACL:** The following have Manager access to this database: ITSLab1/ITSO
- **Database design template name:** StdR45Mail
```

Figure 143. Lotus Notes User Synchronization: Manual Approving of File Deletion

---

**Verification**

You are about to approve the deletion of mailKoop.nsf on server ITSLab1/ITSO. Do you wish to continue?  

[Yes]  [No]

Figure 144. Lotus Notes User Synchronization: Verification of File Deletion
3.3.5.2 Deleting Users from Lotus Notes

When working locally from the Notes Desktop, make sure you have all the databases of interest opened from the server rather than having them opened locally. Locally opened databases don’t trigger the synchronization process and nothing will get propagated to Windows NT.

1. Open the NAB from the server.
2. Choose the Person view.
3. Select the user you wish to delete from both Lotus Notes and Windows NT.
4. Select the action button Delete Person. Don’t use the Delete button on the keyboard.
5. Lotus Notes will prompt you for verification for deleting the selected person. Click on Yes.
6. You then have to specify how you want the mail file to be deleted and if this should remove the users Windows NT account. In this example we want this to happen.
7. Click on the OK button.
8. We want to remove the user immediately so we click on the Yes button.

9. A series of administration requests have been generated and put in the Administration Requests database.

10. Since deleting a user in this case involves removing a mail file, one of the administration tasks is pending your approval.
11. Open the document in edit mode and click on the Approve File Deletion button.

12. The user is now completely wiped off your systems. The ADMINP may take a while to perform its chores depending on the ADMINP interval you have specified in the server document.
When the requests are done, they will be prefixed with a check mark in the Administration Requests database.

Figure 154. Lotus Notes User Synchronization: Performed Administration Requests

3.3.6 Renaming Users from Windows NT

The renaming of users doesn’t really rename the person in Lotus Notes; what gets renamed is the user’s Network account name. To rename a Lotus Notes person you still have to use the renaming steps described in the Lotus Notes Administrator’s Guide and then update the full name in Windows NT accordingly. We still show how the renaming procedure is done using the Lotus Notes User Synchronization as this affects the user’s ability to utilize the Lotus Notes Single Logon Service.

When examining a person document in Lotus Notes the only important field in this example is the Network account name.

Figure 155. Lotus Notes User Synchronization: Network Account Name

1. Start the User Manager (for Domains).
2. Select User - Rename.
3. Enter the person's new Network account name.

4. Examine the user's person document in the NAB and notice how the Network account name has changed but the user’s full name remains unchanged.
Chapter 4. Protocol Management

This chapter documents how to set up transport protocols for connectivity between Windows and other environments. Some of the other environments to be addressed are:

- NetWare
- OS/2
- MVS
- AIX

The transport protocols that we used were:

- TCP/IP
- NetBEUI (NetBIOS)
- NWLink (IPX/SPX)
- SNA

The components used for this are:

- Windows NT and Windows 95
- OS/2 Warp Server V4.0
- NetWare V4.1
- AIX Connections on AIX V4.2
- MVS OpenEdition R3

Some of the products used for this are:

- Communications Server for NT
- Microsoft SNA 3.0
- PCOMM for NT and OS/2
- NetWare Client for Microsoft
- Microsoft NetWare Client

4.1 SNA - IBM Personal Communications for Windows NT

To connect to an IBM mainframe you can install IBM Personal Communications for NT on your Windows NT system. There are several ways to connect to IBM mainframes using IBM Personal Communications for NT. We only show how to connect to an IBM host using IBM Personal Communications IEEE 802.2 LAN interfaces since the TCP/IP customization just requires an IP address and a few other minor parameters. PCOMM can also be installed on the same system as Communications Server for NT from IBM if Communications Server is installed first.

To connect to an IBM host using the IBM Personal Communications IEEE 802.2 LAN Interfaces, we had to install the LLC2 driver. When you install IBM Personal Communications for NT, you will be asked whether you want to install the IBM Personal Communications IEEE 802.2 LAN Interface.
4.1.1 Installation of LLC2 Protocol

To install the IBM LLC2 Protocol, you should add the network protocol onto NT Server:

1. Click on Start, point to Settings, and then click on the Control Panel.
2. Double-click on the Network icon.
3. Click on the Protocols tab.
4. Click on **Add**.

5. Click on **Have Disk**. The Insert Disk Window is displayed next.
6. Type `C:\Personal Communications` if that is the location where you installed PCOMM.

7. Select **IBM LLC2 Protocol** and click on **OK**.

   You should see the network protocol show up in the Network window.
8. Click on Close. The Network Settings window is displayed.
9. Click on Yes to restart the NT system.

4.1.1.1 Configuring IBM PCOMM for NT with IEEE 802.2 Protocol

To use IBM Personal Communications for NT with IEEE 802.2 protocol, we had to configure it with the following steps:

1. Click on Start, Programs, and IBM Personal Communications. Then click on Start or Configure Session to start IBM Personal Communications.

You will get the following information dialog box that will have to be configured before using it:
Welcome to the IBM Personal Communications WorkStation (host session) Window.

Before you can connect to the host system, you must configure some options. In the next panel, choose the host system, the interface and the type of connection you will use, then choose Configure...

If you are in doubt or encounter a problem during the steps that follow, push the Help button to get assistance.

Thank you for choosing IBM Personal Communications.

Figure 166. Information for Requiring Configuration

2. Click on OK to continue.

Figure 167. Customize Communication

3. Select:
   - Interface - LAN
   - Attachment - LAN via IEEE802.2
   - Host - S/390

Click on Configure... to customize.
4. Even though it is not needed for connectivity, if you will need to use graphics on your 3270 session, you should click on Yes in the Graphics Parameters section.

5. Click on Configure Link... to configure link parameters.

6. Fill in the Net ID and CP Name of the local PC for PC Location Name.
The value depend on your SNA network configuration, ask your host administrator for these information. It is possible that some of these values are dynamically created at run time.

7. Click on **Next** to continue.

![Configure LAN Connection](image)

8. Fill in the Destination address: for the network address of the NCP (3745).

   Ask your host administrator for that information.

9. Click on **Next** to continue.
10. Click on **Finish** to complete configuration.

---

**Note**

The PCG file is an SNA node configuration file. It can only be read by the SNA node control utility.

11. Specify a file name for this configuration and then click on **Save** to save it.
12. Click on **OK** to continue.

13. Click on **OK** to continue and it will connect you to the host automatically.
Figure 175. Connect to IBM S/390 Host

Note

If you have problems connecting to your host system:

- Check your physical connection between your NT system and your communication controller (3174, 3745) using one of the following: Network Monitor or Net Watch in the NT Resource Kit.
- Check the system definitions in VTAM on your host system.

4.1.2 SNA - IBM Communications Server for Windows NT

In this section we show how to share the SNA LU on the workstation without IBM’s LLC2 protocol, and connect to MVS using the TCP/IP protocol.

4.1.2.1 Installation of IBM Communications Server for Windows NT

When installing IBM Communications Server for Windows NT, you will automatically get the following window after you put the CD into the drive.
1. Double-click on the **Communications Server for Windows NT** icon to run the Installation Program.

After copying the temporary files to Windows NT Server system, you will get the welcome window and then you will be able to configure it.
2. Fill in the administrator ID for Communications Server. This ID must be in the administrator group.

3. Click on Next to continue the installation.

![Start Copying Files](image1)

Figure 178. Start Copying Files

4. Click on Next to copy the files.

![IBM Communications Server](image2)

Figure 179. Connect to IBM S/390 Host

5. If you want to use the IBM Communications Server IEEE 802.2 LAN interface, click on Yes to install it; otherwise, click on No.

We recommend that you install this interface if you think there is a chance that you will use it at all. The installation method is the same as the one to install the IEEE 802.2 interface in IBM Personal Communications. See 4.1, “SNA - IBM Personal Communications for Windows NT” on page 95 for details on that.
After the installation is complete, you will see a new program group named IBM Communications Server. You will find it in the Windows NT Start task bar.

### 4.1.2.2 Configure IBM Communications Server for Windows NT

To connect to an IBM host (MVS or OS/390) as a TN3270 Server, a Windows NT Server running Communications Server needs some information about the SNA configuration.

- Fully qualified CP Name
- CP Alias
- Network Destination Address of Communication Controller (3745, 3174)

To configure IBM Communications Server for Windows NT:

1. Click on **Start, Programs, IBM Communications Server** and then click on **SNA Node Configuration** to configure the SNA node.

   You will get the blank SNA Node Configuration window shown in the following window:
2. Use the pull-down menu under **File** and click on **New**.

   It will automatically switch to the following window, which lists all possible scenarios.
3. In this case, select **TN3270E Server**.
4. Select **Configure Node** and click on **New** to create a new node configuration.

![Define the Node](image)

**Figure 185. SNA Node Configuration/Define a Node**

5. Fill in the following information:
   - Fully qualified CP name
   - CP alias (not required)

   Ask your MVS SNA coordinator to get this information for you. Click on **OK** to complete this configuration.
6. Select **Configure Devices** for Configuration options and select **LAN** for DLCs (data link control).

7. Click on **New...** to create a new configuration.
As a TN3270E server, you don’t have to change any of the parameters here.

8. Click on **OK** to complete the definition.

![Diagram of SNA Node Configuration/Configure the Gateway](image)

**Figure 188. SNA Node Configuration/Configure the Gateway**

9. Select **Configure the Gateway** for Configuration options and click on **View/Change/Add** to create a new configuration.
10. Click on **Create...** to create a host link.

11. Select **LAN** for the DLC type for your host connection. Click on **OK** to continue.
12. Fill in the network address of the NCP (3745) or 3174 in the Destination address field and click on OK to continue.

13. Click on Yes to continue.
14. Fill in the Base LU name, Start NAU address and the Number of LUs fields.

**Note**

The LU name is used in the local system. You can use any name you want. The number of LUs is dependent on how many LUs belong to this PU, which is defined in VTAM at the host.

15. Click on **OK** and you will get an LU list.
16. Click on OK to continue and it will take you back to the following window:

Figure 195. SNA Node Configuration - TN3270E Parameter

17. Select the TN3270E tab.

18. Select PUBLIC as the Default pool and click on OK to complete.

19. Save this configuration and give it a name that you want it to be known as.
The SNA Node Configuration is now complete.

### 4.1.2.3 Start the TN3270E Server

To start the TN3270E Server:

1. Click on Start, Programs, IBM Communications Server and then SNA Node Operations.
   
   You will get the SNA Node Operations window.

2. Select Operations and click on Start Node....

Figure 196. SNA Node Configuration/Save the Configuration

Figure 197. Start a SNA Node
3. Select a configuration and click on Open.

After a short period of time you will see the following:

![Communications Server Node Operations - TRIAL...](image)

Figure 198. A Started SNA Node

Now that you have defined a gateway you can use the TN3270 emulation program, running on the same system or another system, to TELNET to this gateway server and connect to MVS.

### 4.1.3 SNA - Microsoft SNA Server for Windows NT

In this section we show how to share the SNA LU on a workstation without the DLC protocol, and connect to MVS using the TCP/IP protocol using Microsoft SNA Server.

#### 4.1.3.1 Installation and Configuration of SNA Server

In this session, we assume that your NT system will use the DLC protocol to connect to the MVS host. Therefore, you will have to install the DLC protocol first.

The installation of Microsoft SNA Server for Windows NT is similar to other software, so we do not document the installation procedure in this section.

To run the SNA Server program, simply:

1. Click on Start, Programs, Microsoft SNA Server (Common) and then Manager to open the SNA Server Manager program. You will get the following window:
After the initial window you will get the following:

Figure 199. Microsoft SNA Server/Welcome

If this is the first time that you are using SNA Server, you can click on Begin Here (Figure 199) to get to the Help window.
2. From the Windows NT Control Panel window, select **Network**.

3. Click on the DLC protocol.

   Now you have to insert a link service.

4. In the Insert menu, click on the **Link Service** to add a new link service.

5. Select **DLC 802.2 Link Service** and click on **Add**.
6. Change the Title if you want.

7. Select an adapter.

8. Set up the Local Service Access Point (SAP) and then click on **OK**.

Clicking on **OK** will bring you back to the following window:
9. Click on Finish to complete. Then you should see that there is one adapter in the SNA Server called SNADLC1.

10. In the Insert pull-down menu, click on Connection to add a new connection.
11. Give it a connection name.
12. Select one link service.
13. Click on the Address tab.

14. Fill in the Remote Network Address with the network address of the 3745 or 3174 (see your SNA network administrator).
15. Click on the System Identification tab.
16. Fill in the net ID in the Network Name field.
17. Fill in the CP name for the Control Point Name.
18. Click on the 802.2 DLC tab.

The default values in Figure 210 worked for us.
19. Click on OK.

Then you will have to configure 3270 access. First, you have to add some LUs for the connection.
20. In the Insert menu, point to 3270 and then click on Display LU.
21. Fill in the LU Name.

In addition, click on the Display Model and Associated Printer tabs to change their parameters. Then click on OK.

After adding three LUs called SNALU002, SNALU003 and SNALU004, you will get the following window.

22. In the Insert pull-down menu, point to 3270 and then click on the Range of LUs.
23. Specify the Domain, Server, Connection and LU Type and click on Next.

24. Enter the Base LU Name.

25. Enter the First LU Number.

26. Enter the Number of LUs.

27. Enter the First Extension.

28. Click on Finish to create the LUs.

After the link service, connection and LUs have been created, you have to assign a user, group or workstation to SNA Server.

29. In the Insert menu, click on User.
Select the users or groups you want to add and click on Add.

Click on OK to finish.

You then have to assign the LUs to these users, groups or workstations.

Select the LUs and drag them on top of the desired user or workstation.

From the File pull-down menu, click on Save to save these settings.
After you have installed and configured SNA Server you can use the 3270 applet provided by SNA Server (or Client) to connect to SNA Server over TCP/IP and then connect to the host.

4.1.3.2 Installation and Configuration of SNA Server Client

For other workstations to access the host system, you don’t have to install the SNA Server, you only install the SNA Servers client code. You use the client code to connect to SNA Server to get to the host system. In order to install the SNA Server client code, you will need to do the following:

1. Run the program `\CLIENT\WINNT\I386\SETUP.EXE` from the installation CD or code drive.

2. Step through the initial windows until you get to:

![Windows NT Client for SNA Server Setup](image)

3. Click on Select Components.
Figure 218. SNA Server Client/Select Components

4. Select the options you want to use.

5. Click on Continue.

Figure 219. SNA Server Client/Select Client Server Protocol

6. Choose the protocol you want to use and click on Continue.
7. Select the method your client will use to search for the SNA Server. There are two ways to look for the SNA Server:
   a. Client locates servers in an SNA Server subdomain.
   b. Client locates servers by name.

   We chose **Client locates servers by name**.

8. Click on **Continue**.

9. Fill in the primary SNA server name and the backup SNA server name if you have set one up.

10. Click on **Continue**.
You will get a window showing you that it is copying the files.

After the files have been copied the installation is done and you have to reboot your system. Before you use the Client for SNA Server you will still have to configure it.

1. Click on Start, Programs, Microsoft SNA Server Client and then Config Client.
   You will get the following window:
2. Select the protocol you want to use.
3. Click on the **Client Mode** tab.

4. Select the method that the client should use to locate the server.

   If you use the Client locates server by name, you have to fill in the server name.

5. Click on **OK** to complete.

6. Click on **Start, Programs, Microsoft SNA Server Client** and then **3270 Applet**.
It will automatically connect you to SNA Server and get the logical unit you need to connect to the host with.

4.1.4 IPX/SPX - Gateway (and Client) Services for NetWare

To access files or printers on a NetWare server, a service must be used, such as the Client Service for NetWare (CSNW) on Windows NT Workstation or the Gateway Service for NetWare (GSNW) on Windows NT Server.

4.1.4.1 Client Service for NetWare

To access files or printers on a NetWare server you only have to install the Client Service for NetWare.

4.1.4.2 Installation

To install the Gateway Service for NetWare, you need to add a network service to the NT Server.

1. Log on to the system as a user with administrator rights.
2. Click on Start, point to Settings and click on Control Panel.
3. Double-click on Network.
4. Click on the Services tab.
5. Click on **Add**...

   The Select Network Service dialog box appears.

   ![Select Network Service](image)

   **Figure 226. Network Services in Control Panel**

6. Click on **Gateway (and Client) Services for NetWare** and click on **OK**.

   ![Select Gateway Service](image)

   **Figure 227. Add Gateway Service for NetWare**
Since it needs some additional files for Windows NT Server, point to either your NT Server CD-ROM or your LAN drive that has an image of the CD-ROM on it.

**Figure 228. Windows NT Setup**

7. Click on **Continue** to copy the required files.

**Figure 229. Copy Required Files**

You should notice that there is now a Network Service - Gateway (and Client) Service for NetWare installed.
8. Click on **Close** to complete the network change.

9. Click on **Yes** to restart system.

   After the system has been rebooted, you will find a new icon GSNW in the Control Panel.
10. Double-click on **GSNW** and you will get the Gateway Service for NetWare setup dialog box.

Select a preferred server and then you can access that NetWare server.
To map a NetWare resource as a Network drive:

- Right-click on the **Network Neighborhood**.
- Click on **Map Network Drive**.

You should get a window similar to the one that follows:

![Gateway Service for NetWare](image)
4.1.4.3 Gateway Service for NetWare

To use the disk or printer from a NetWare server and share them with other clients, you have to install the Gateway Service for NetWare on the Windows NT Server.

The Gateway Service for NetWare (GSNW) provides Windows NT Server connections to NetWare servers, and shares the network connections, for example, a gateway, from a NetWare server. This service allows the Windows NT Server to access the NetWare server as just another client and allows the network clients to access files on the NetWare server without having to have a NetWare client re-director (service) over an IPX/SPX protocol.

The Gateway Service for NetWare depends on two protocols being installed on Windows NT Server. You need to have the NWLink protocol and the NWLink NetBIOS installed. NWLink is an implementation of the internetworking packet exchange (IPX) and sequenced packet exchange (SPX) transport protocols used by the NetWare network. NWLink NetBIOS is a Microsoft-enhanced implementation of Novell NetBIOS, and transmits Novell NetBIOS packets between a NetWare server running Novell NetBIOS and a Windows NT computer, or between two Windows NT computers.

NWLink and NWLink NetBIOS can coexist with other protocols on the same network adapter card. The Windows NT Server establishes a network connection to the NetWare server similar to any network client connection.
Note: Before you install the Gateway Service for NetWare, you have to remove any existing NetWare redirector, such as NetWare Services for Windows NT from Novell, and then restart your computer.

4.1.4.4 Enable a Gateway
Before enabling the gateway server for NetWare on Windows NT Server, you have to check that:

- A user account has been created on the NetWare server with necessary rights for the resources you want to access.
- The NetWare server must have a group named NTGATEWAY with necessary rights for the resources you want to access.
- The NetWare user account you use must be a member of the NTGATEWAY group.

4.1.5 IPX/SPX - NetWare Client for Windows NT
The other way to access NetWare Server Resources from Windows NT Server is to install the Novell NetWare Client for Windows NT.

4.1.5.1 Installation
To install the NetWare Client for Windows NT you need to add a network service to the NT Server. Unlike the installation of the Gateway Service for NetWare, we used the standard type or installation process to install the NetWare Client for Windows NT.

1. Log on to the system as a user with administrator privileges.
2. Click on Start and Run.

![Figure 235. Run the NetWare Client for Windows NT - Installation Program](image)

3. Enter the location of the NetWare Client for Windows NT, and click on OK. The Novell NetWare Client 4.0 Installation dialog will be displayed.
4. Click on **Continue**.

   If your Windows NT Server already has the Gateway Service for NetWare installed (Microsoft Client Service for NetWare), the NetWare Client for Windows NT Installation Program will remove it.

5. Click on **Yes** to continue.

   The installation program will copy the files to your hard drive.

After the installation is complete, the Windows NT system will need to be rebooted.
6. Click on **Reboot** to reboot your Windows NT system.

After Windows NT is rebooted you will find a new item in the task bar. Under Programs a group named NetWare (Common) will be created. In addition, a new icon will appear in the Control Panel in place of the GSNW icon.
You will also find the new Network Service - Novell NetWare Client for Windows NT.

![Network Service - Novell NetWare Client for Windows NT](image)

*Figure 241. Network Service - Novell NetWare Client for Windows NT*

### 4.1.5.2 Using the NetWare Client for Windows NT

The NetWare Client for Windows NT provides a graphical user interface. You can click on **Start** and point to **Programs**. Then click on **NetWare (Common)** and click on **NetWare GUI Login** to use this GUI application.

![Novell NetWare Client for Windows NT GUI/Login](image)

*Figure 242. Novell NetWare Client for Windows NT GUI/Login*
1. Using this GUI application you can log in to the NetWare server.

![Novell NetWare Login](image1)

Figure 243. Novell NetWare Client for Windows NT GUI/Connection

2. Specify which tree or server you want to connect to.

![Novell NetWare Login](image2)

Figure 244. Novell NetWare Client for Windows NT GUI/Script

3. Specify the login and profile script.
4. Specify the variables for the login script. You will find there are four new items when you click on Network Neighborhood:
   
   • Change NetWare Password - Changes the password on the NetWare server.

Figure 246. Change Password
Figure 247. Current NetWare Resources

- NetWare Connections - Gets the current NetWare resources for this connection.

<table>
<thead>
<tr>
<th>Resource</th>
<th>User Name</th>
<th>Conn No</th>
<th>Type</th>
<th>NDS Tree</th>
</tr>
</thead>
<tbody>
<tr>
<td>NETW114</td>
<td>SUPERVISOR</td>
<td>3</td>
<td>Bindery</td>
<td>NETW114</td>
</tr>
</tbody>
</table>

Figure 248. Capture NetWare Printer Port

- Capture Printer Port - Adds a network printer or to assign this connection to a network print server defined in NetWare Server.
4.1.6 IBM Networks Coordinated Logon Client for NT

To log on to OS/2 Warp Server or LAN Server, you will need to install the IBM Networks Coordinated Logon Client for NT. It provides your Windows NT system with all of the IBM OS/2 Warp Server functions, such as:

- Connecting to home directories
- Setting up and connecting to logon assignments
- Running shared applications
- Connecting to aliases
- Checking DASD limits

4.1.6.1 Prerequisites

The following prerequisite components need to be installed on your NT system before you can install the IBM Networks Client:

- Microsoft Workstation Service
- An appropriate network adapter device driver
- NetBEUI or TCP/IP
4.1.6.2 Installation
To install the IBM Networks Client, you must add a network service into your NT server.

1. Log on to the system as a user with administrator rights.
2. Click on Start, point to Settings, and click on the Control Panel.
3. Double-click on Network.
4. Click on the Services tab.

5. Click on Add....

The Select Network Service dialog box appears.
6. Click on Have Disk... The Insert Disk Window is displayed.

7. Insert the IBM Networks Coordinated Logon Client for Windows NT diskette into the A: drive, and then click on OK. Of course, you can also install the code from a CD or a LAN drive.
8. Select **IBM Networks Coordinated Logon Client for Windows NT**, and then click on **OK** to copy the files.

![IBM Networks Coordinated Logon Client](image)

Figure 254. Copy IBM Networks Client for Windows NT Files

The IBM Networks Client Properties notebook is displayed after the files are copied.

9. Click on the **General** tab.

![IBM Networks Client Properties/General](image)

Figure 255. IBM Networks Client Properties General

10. In the Domain name box, type the name of the default logon IBM OS/2 Warp Server domain.

11. In the Alternate domain name box, if you want to use an alternative domain, type the name of the alternative domain.

12. Click on the **Advanced** tab.
13. If you select the button to specify the name of your logon server, you must enter the name of the logon server.

14. Click on OK to complete.

At this time you will get the following message:

See 4.1.6.3, “Coordinating the User Accounts” on page 154 for more information.

15. Click on OK. The Network notebook will be displayed.
16. Click on **Close**. The network bindings for the various protocols you have selected will get configured.

**Figure 258. Network Services in Control Panel**

17. Click on **Yes** to restart the NT system.

**Figure 259. Network Services Binding**

The Network Settings Change window is displayed.

**Figure 260. Network Settings Change**

17. Click on **Yes** to restart the NT system.
4.1.6.3 Coordinating the User Accounts
The Windows NT user account and IBM OS/2 Warp Server domain user account must be synchronized. You have to have a Windows NT user account whose user name and password also exists in an IBM OS/2 Warp Server domain. To coordinate the user accounts do one of the following:

- If you have a Windows NT user account with a user name that is the same as our IBM OS/2 Warp Server domain account user name, then you must change the password on your Windows NT account to be the same as our password on the IBM OS/2 Warp Server domain user account.
- If you do not have a Windows NT user account with a user name that is the same as our IBM OS/2 Warp Server domain account user name, then you must create one. Use the Windows NT User Manager utility to create a Windows NT account.

4.1.6.4 Using IBM Networks Client
Click on Start, Programs, IBM Networks Client (Common) and then click on IBM Networks Client to start the IBM Networks Client. The following window will be displayed:

![IBM Networks Client](image)

From the IBM Networks Client, you can do the following functions:

- List logged on users
- List shared applications
- Send messages
- Connect a network disk
- Connect a network printer
- Change the logon assignments

4.2 Network Monitor
Windows NT Server provides a built-in tool for monitoring the network activity. It is called the Network Monitor. With the Network Monitor, you can capture the activity of systems connected to your Windows NT Server system. It provides four status views:

- Total Stats
- Session Stats
- Station Stats
You can also restrict the data that is to be captured with a filter. It appears that this monitoring function came from the SMS component of BackOffice. View these traces frame by frame.

### 4.2.1 Capturing Data

To start the capture of network data, click on **Start, Programs, Administrative Tools (Common)** and **Network Monitor**. The following window will be displayed.

![Network Monitor](image)

*Figure 262. Network Monitor*

Click on **Capture** and **Start** to start capturing data.
There are four windows that provide statistics in Network Monitor:

- Total Stats
- Session Stats
- Station Stats
- Graph

### 4.2.1.1 Total Stats
There is a lot of information available in this window, including:

- Network Statistics
- Captured Statistics
- Per Second Statistics
- Network Card (MAC) Statistics
- Network Card (MAC) Error Statistics
4.2.1.2 Session Stats

In this window, you can determine how many sessions have been established between your Windows NT Server and other machines. It includes the network address of the sender and receiver. You can change the network address to a name, a computer name or a user name. You can select any network address of session you want to change, click the right button and select Edit Address.

Fill in the name of the machine and click on OK. You will then get a new session list.
Figure 267. Network Monitor/Session Stats

Now it is easier to identify the resource you want to analyze.

4.2.1.3 Station Stats

Figure 268. Network Monitor/Station Stats
In this window, you can see detailed data about the station communicating with your Windows NT Server system. You have the following information provided to you here:

- Network Address
- Frames Sent
- Frames Received
- Bytes Sent
- Bytes Received
- Directed Frames Sent
- Multicasts Sent
- Broadcasts Sent

You can also change the network address to be a name just like you did with Session Stats.

4.2.1.4 Graph

![Graph Image](image)

*Figure 269. Network Monitor/Graph*

This window graphically presents the network statistics. It includes the following information:

- % Network Utilization
- Frames Per Second
- Bytes Per Second
- Broadcasts Per Second
- Multicasts Per Second
4.2.2 Capturing Data with Filters

In general, when the network is stable, you don’t need to capture all of the network data on your NT system. In some cases, you just want to capture specific data for a specific session. In that case you would set up a filter.

4.2.2.1 Capture Filter

To create a filter in the Network Monitor, you can press F8 or click on Capture in the menu bar of the main window of Network Monitor. Then click on Filter.

You can change the protocol you want to monitor or change the address pair you want to capture. In addition, you can change the pattern you want to analyze.

For example, you can specify the network protocol you want to capture. You can select: \textbf{SAP/ETYPE = Any SAP or Any ETYPE} and click on \textbf{Line...} in the Edit field. You will get the Capture Filter SAPs and ETYPEs window.
Figure 271. Network Monitor/Capture Filter SAPs and ETYPES

You can also disable all protocols first, then select just the network protocol you want to capture and enable it.

4.2.3 View the Captured Data

After you stop capturing data, you can click on **Stop and View** to stop and view the data you just captured or you can save it as a capture file *.cap then select **Open** to view it.

After you open a capture file, you will see:
In this window, you can trace the network data frame by frame, or look at it field by field. You can also see the data in hex. This is helpful in the problem determination process on your network.
Chapter 5. Performance Management

This chapter documents how to gather performance information and report on it in a Windows NT environment.

5.1 Windows NT Built-In Tools

Windows NT provides some built-in tools for performance management:

- Event Viewer
- Performance Monitor
- Task Manager
- Network Monitor

5.1.1 Event Viewer

Windows NT Server provides a built-in management function called the Event Viewer. The Event Viewer can view each event logged by the system. You cannot access the data using the file manager, or the explorer function as all event data is accessed using an API. You can also view the event of other NT systems if you have the right administrator privileges.

To access the Event Viewer application you can click on Start, Programs, Administrative Tools (Common) and the Event Viewer option. You can also issue the eventvwr command which is typically found in the \winnt\system32 directory.

If you have the Windows NT Resources Kit installed on your system it provides a utility called DUMPEL.EXE to dump the event log. The dumpel /? command will give you all of the options that you can use. In addition to just dumping out into a flat file the system, security or application event log, you can also provide some filtering as to what gets written to the file. See 6.1.2.1, “Event Viewer Setup” on page 196 for more information.

![Event Viewer](image)

There are three kind of events logged by NT system:

There are three kind of events logged by NT system:
• System
• Security
• Application

You may select each of them to get the detail information.

If you feel too many events are displayed in the window, you may filter them; just select View from the main menu bar, then select Filter Events.

Select your filters and click on OK. You will only see the events that pass your filter.
### Event Viewer - System Log on \WINNT38 (Filtered)

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Source</th>
<th>Category</th>
<th>Event</th>
<th>User</th>
<th>Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>4/10/97</td>
<td>6:50:02 PM</td>
<td>Remote</td>
<td>None</td>
<td>4012</td>
<td>N/A</td>
<td>WINNT38</td>
</tr>
<tr>
<td>4/10/97</td>
<td>6:24:43 PM</td>
<td>Snv</td>
<td>None</td>
<td>2011</td>
<td>N/A</td>
<td>WINNT38</td>
</tr>
<tr>
<td>4/10/97</td>
<td>6:24:43 PM</td>
<td>Snv</td>
<td>None</td>
<td>2011</td>
<td>N/A</td>
<td>WINNT38</td>
</tr>
<tr>
<td>4/10/97</td>
<td>6:24:43 PM</td>
<td>Snv</td>
<td>None</td>
<td>2011</td>
<td>N/A</td>
<td>WINNT38</td>
</tr>
<tr>
<td>4/10/97</td>
<td>6:24:43 PM</td>
<td>Snv</td>
<td>None</td>
<td>2011</td>
<td>N/A</td>
<td>WINNT38</td>
</tr>
<tr>
<td>4/10/97</td>
<td>6:24:43 PM</td>
<td>Snv</td>
<td>None</td>
<td>2011</td>
<td>N/A</td>
<td>WINNT38</td>
</tr>
<tr>
<td>4/10/97</td>
<td>6:24:43 PM</td>
<td>Snv</td>
<td>None</td>
<td>2011</td>
<td>N/A</td>
<td>WINNT38</td>
</tr>
<tr>
<td>4/10/97</td>
<td>6:24:39 PM</td>
<td>Snv</td>
<td>None</td>
<td>2011</td>
<td>N/A</td>
<td>WINNT38</td>
</tr>
<tr>
<td>4/10/97</td>
<td>6:24:39 PM</td>
<td>Snv</td>
<td>None</td>
<td>2011</td>
<td>N/A</td>
<td>WINNT38</td>
</tr>
<tr>
<td>4/10/97</td>
<td>6:24:39 PM</td>
<td>Snv</td>
<td>None</td>
<td>2011</td>
<td>N/A</td>
<td>WINNT38</td>
</tr>
<tr>
<td>4/10/97</td>
<td>6:24:39 PM</td>
<td>Snv</td>
<td>None</td>
<td>2011</td>
<td>N/A</td>
<td>WINNT38</td>
</tr>
</tbody>
</table>

*Figure 276. Event Viewer/Filter Events*

Double-click on each event to get detail information for each event.

### Event Detail

- **Date:** 4/11/97
- **Time:** 4:30:34 PM
- **Source:** NwFids
- **User:** N/A
- **Computer:** WINNT38
- **Event ID:** 8007
- **Type:** Warning
- **Category:** None

**Description:**
The Microsoft Client Service for NetWare redirector has timed out one or more requests to NetWare.

*Figure 277. Event Viewer/Detail Information*

Each event contains the following information:

- Date
- Time
- User
- Computer
With this information, you will know more about what is going on in your NT system. In addition, you should be aware that the Tivoli Event Console (TEC) has an adapter that can be installed on Windows NT so that all of the events can be forwarded to the Tivoli Management Platform for further processing, correlation and action.

5.1.2 Performance Monitor

Windows NT provides other useful built-in functions. An example of this is the Performance Monitor.

Click on **Start, Programs, Administrative Tools (Common)** and **Performance Monitor** to show the Performance Monitor.

There are four views in Performance Monitor: Chart, Alert, Log and Report.

![Performance Monitor/Chart](image)

*Figure 278. Performance Monitor/Chart*
Chapter 5. Performance Management

Figure 279. Performance Monitor/Alert

Figure 280. Performance Monitor/Log
In the following sections, we discuss how to use the Performance Monitor.

5.1.2.1 Add a Monitored Object to a Chart View

In the Chart View, you can use the graphic mode to monitor Windows NT systems. You can monitor the current activity of Windows NT systems. You can monitor not only local Windows NT Servers but also other remote Windows NT V4.0 Servers. If you want to monitor another NT system, you must have a user ID and password in the administrator group of that system. You can then get the system information from that system.

1. In the View menu, click on Chart to switch to the Chart View.

2. From the Edit menu, click on Add To Chart and the Add To Chart window will be displayed.

3. You can select a server you want to monitor and then you have to select which objects and counters you want to monitor.
You can change the display values of the monitored objects. Examples of things you can change are: color, scale, width and style.

If you don’t understand what the counters mean, you can click on the **Explain** button to get more detailed information.

![Add to Chart](image1)

4. Click on **Add** to add this object to the Chart View.

Repeat the process for additional objects or computers that you want to monitor.

5. Click on **Done** to complete your selections.

After you add the monitored objects, you will see:

![Performance Monitor/Chart/Histogram](image2)
You can change the chart properties if you want a different chart.

6. In the Options menu click on **Chart** to open the Chart Options dialog box.

![Chart Options](image)

**Figure 285. Performance Monitor/Chart/Options**

You can change some of the properties of Chart View for example, legend, value bar, grid, label, vertical maximum, gallery type and update time.

- In Vertical Maximum you just type the maximum value to which the vertical axis should extend.
- In Update Time you select either manual update or periodic update and then type a number in the interval box to determine the time (in seconds) between chart updates.
- In Gallery click on Graph or Histogram as its format.

**Note**

The graph time value displayed in the value bar shows the time (in seconds) that it takes to create a complete chart across the window.

For example, if you change its gallery to be graph, you will get the following view:
5.1.2.2 Add a Monitored Object to an Alert View

In the Alert View you can create an alert to monitor your system and then forward these alerts to another system by doing the following:

1. Click on View and then Chart to switch to the Chart View.

2. Click on Edit and Add To Alert. The Add To Alert window will displayed.

3. In the Object field select an available object to monitor.

4. In the Counter field select one or more counters.

5. For the Instance select one or more instances.
6. For the field labeled Alert If, click on Over or Under and add a value.

7. In Run Program On Alert, click on First Time or Every Time and enter the complete path name for the program or macro that you want to run whenever the specified alert occurs.

8. Click on Add.

9. Repeat the process for additional objects or NT systems that you want to monitor and then click on Done.

Then you can start the monitor. If any alert occurs, you will see the following:

![Performance Monitor/Alert](image1)

Figure 288. Performance Monitor/Alert

Also, the program you specified in the Alert Entry will be run.

5.1.2.3 Forward the Alert to Other NT Systems

The Performance Monitor can forward alerts to other NT systems; just perform the following steps:

1. From the Options menu, click on Alert.

![Alert Options](image2)

Figure 289. Performance Monitor/Alert/Options
2. In the Alert Options dialog box select any combination of the following:
   - Switch To Alert View
   - Log Event In Application Log
   - Send Network Message

3. For a network alert, type the name of the alert recipient’s computer in Net Name, but without typing the back slashes (\).

4. In Update Time, select either Manual Update or Periodic Update and then type a number in the Interval box to determine the time (in seconds) between updates if you click Periodic Update.

5.1.2.4 Log Activity of NT Systems
The Performance Monitor can log the activities on NT systems; just perform the following steps:

1. From the View menu click on Log to switch to the Log View.

2. From the Edit menu click on Add To Log and the Add To Log window will displayed.

![Add To Log](image)

You can collect data from multiple systems into a single log file. Log files contain detailed data about system bottlenecks and can help with detailed analysis. For capacity planning you have to view trends over a longer period of time. That requires the ability to create a log file and to produce reports from that file.

3. In Objects, select an available object or set of objects to monitor and then click on Add.

   Repeat the process for any additional systems that you want to monitor.

4. Finally, you can click on Done.

   After you are done you will get a list of log objects.
To save the log selections in a settings file:

1. From the File pull-down menu click on **Save Log Settings As**.
2. In the Performance Monitor - Save As dialog box enter a path name for the file that will contain the selections that you want to reuse. Then click on **OK**.

To start or stop logging or to save the log file:

1. In the Options menu, click on **Log**.
2. In the Log Options dialog box click on **Start Log**. If Start Log is not enabled, you must enter a log file name and add objects to the log.
3. To stop logging, click on **Stop Log**.
4. To save the log file, click on **Save** after you start and stop logging.

### 5.1.2.5 Add a Monitored Object to a Report View

1. From the View menu click on **Report** to switch to the Report View.

2. From the Edit menu, click on **Add To Report**, and the Add To Report window will displayed. This window is the same as shown in Figure 283 on page 171.

3. You can select a server you want to monitor and then select which object and counter you want to monitor.

   If you don’t understand what the counter means, you can click on the **Explain** button to get more detailed information.

   You can change the property of this monitored object in the chart. Examples of that would be: color, scale, width and style.

4. Click on **Add** to add this object into the Report View.

   Repeat the process for additional objects or systems that you want to monitor.

5. Click on **Done** to complete the process.

   After you add the monitored objects, you will see:

   ![Performance Monitor/Report](image)

   **Figure 293. Performance Monitor/Report**

   There is only one option in the Report View. It relates to the Update Time. You can select either Manual Update or Periodic Update and then type a number in the Interval box to determine the time (in seconds) between chart updates.

### 5.1.2.6 Working with Current Activity

To work on any view with information about current activity from the File menu click on **New** to open a new settings file or click on **Open** to open an existing settings file. You can add objects to monitor. From the File menu click on **Save Settings As** to save selections in a new settings file.
If you have updated information in all four views, then from the File pull-down menu click on **Save Workspace** to save the current settings for all four views.

You can only open a single chart (.pmc), alert (.pma), log (.pml), or report (.pmr) settings file or you can open a workspace (.pmw) file with all the options.

### 5.1.2.7 Working with Logs Files

To work on any of the views with information from the log files:

1. In the Options menu click on **Data From**. and enter an existing log file in **Log File**.

![Data From](Figure 294. Performance Monitor/Data From)

2. Click on **Open** from the File menu to open an existing settings file or workspace file.

3. From the Edit menu click on the **Time Window** to change the starting and stopping times.

4. In the View menu, select each view you want to see.

### 5.1.3 Task Manager

The Task Manager is another useful built-in tool in Windows NT. With the Task Manager you can monitor and control your NT system and you can see what programs and processes are running on it and your computer’s performance.

To access the Task Manager you need to use the right mouse button on the task bar and then click on **Task Manager**.

#### 5.1.3.1 Task Manager - Applications

Click on the **Applications** tab and you will get an application list.
From this window you can:

• End Task - Terminates a running application.
• Switch to - Brings this application to the foreground.
• New Task - Opens an application to run.

5.1.3.2 Task Manager - Processes
Click on the Processes tab to get a list of processes that are running on this NT system.
You can show the following types of information for tasks in the process list:

- Image Name
- PID (Process Identifier)
- CPU Usage
- CPU Time
- Mem Usage
- Mem Usage Delta
- Page Faults
- Page Faults Delta
- Virtual Memory Size
- Paged Pool
- Non-Paged Pool
- Base Priority
- Handle Count
- Thread Count

You can click on **Select Columns** from the **View** pull-down menu to select the information that you want to display on the Process page of the Task Manager.
In this window you can also click on **End Process** to terminate a running process. Right-click on each process to terminate this process or set its priority. Each process has four kinds of priorities:

- Real time
- High
- Normal
- Low

### 5.1.3.3 Task Manager - Performance

If you click on the **Performance** tab you will get some charts and tables similar to the following:

![Windows NT Task Manager](image)

This window shows system performance information such as CPU Usage, MEM Usage and breaks it out into finer detail.
• You can click on **Show Kernel Times** on the **View** pull-down menu to enable or disable the CPU Usage of Kernel in the CPU Usage chart.

You can click on **Update Speed** in the View pull-down menu to change the update speed to one of the following:

- High
- Normal
- Low
- Paused

## 5.2 NetFinity Monitoring

NetFinity is a powerful management tool on the Intel platform. There are several tools in NetFinity that are related to Performance Management.

![NetFinity Service Manager](image)

*Figure 298. NetFinity Service Manager*

Examples of the NetFinity services that can assist in performance management are Alert Manager, Process Manager and System Monitor.

For more details on NetFinity monitors you can look in *Systems Management from an NT Server Point of View*, SG24-4723 or *NetFinity V5.0 Command Line and LMU Support*, SG24-4925.

To start NetFinity you can click on **Start**, **Programs**, **NetFinity** and **NetFinity Service Manager** to start the NetFinity Service Manager.
5.2.1 Alert Manager

![Alert Manager Icon]

**Alert Manager**

*Figure 299. NetFinity/Alert Manager*

The Alert Manager is an extendable facility that allows the receiving and processing of application-generated alerts. Several features of Alert Manager include:

- Simplifying application use and processing of alerts.
- Providing standard response actions to alert:
  - Log alert to file
  - Display alert in pop-up window
  - Forward alert to another workstation
  - Execute a program
  - Dial out to a digital pager
  - Generate an SNMP version of the alert
  - Play a waveform (WAV) file
- Providing extensive configurable alert management and action generation.

A variety of actions can be taken in response to alerts, including alert logging, pop-up user notification, forwarding the alert to another system, program execution, or an application-defined action.

Alerts can be generated as a result of thresholds being reached by a system performance monitor.

5.2.2 Process Manager

![Process Manager Icon]

**Process Manager**

*Figure 300. NetFinity/Process Manager Icon*

You can use the NetFinity Process Manager to view detail information on all processes running on your NT system. With the Process Manager, you can:

- Run Command - Runs a single command on the system.
- Process Alert - Sets up some condition for generating a NetFinity alert.
• Close Applications - Closes an application running on a Windows system.

When you double-click the Process Manager icon in the NetFinity window the NetFinity Process Manager window will be displayed.

![NetFinity Process Manager](image)

5.2.3 System Monitor

![System Monitor](image)

The System Monitor provides some charts and reports to monitor the activity of many of components in your NT system. It can continuously monitor:

• Locked memory usage
• Virtual memory usage
• CPU usage
• DASD space available and space remaining
• DASD utilization
• TCP/IP protocol functions
• Processes running
• Threads running
• Pentium processor computations
• RAID Device attributes
• Read/Write errors (NetFinity Manager only)

The System Monitor has the following features:
• Continuous monitoring
• Export System Monitor data to an ODBC database
• Detachable, sizeable, scalable and user-configurable monitors
• User definable thresholds that will generate NetFinity alerts when exceeded
• Line graph, text, and real-time graphic representation

If you double-click on the System Monitor icon in NetFinity window you will get the System Monitor Service window. Click on Show Monitors... to get a list of monitors.

Select the monitors you want to use and click on Accept. For example, we selected CPU Utilization and Drive C: Space Remaining. As a result of that the following two monitors showed up on our desktop:
5.2.3.1 Change the Monitors Properties

From any of the NetFinity monitors you can use the right mouse button to change its settings:
You can change the view type and the detail settings for each view.

**5.2.3.2 Define a Threshold for a Monitor**

If you double-click anywhere within the Monitor window, the Threshold Configuration window will be displayed.
1. Type in a Threshold Name and press Enter.
2. Set a Duration value for the monitor.
3. Set a Resend value for the monitor.
4. Select a State which, if reported by the monitored attribute, will generate a NetFinity alert.
5. Select a Severity for the alert that will be generated if the specified state is reported.
6. Select an Application Alert Type to be used for the generated alert.
7. Select a Type of Alert to be used for the generated alert.
8. Select Notify (optional).
   If you want an alert to be sent to the NetFinity Alert Manager select the Notify check box for this threshold.
9. Select Create to save these threshold values. If you have been editing a previously configured threshold, select Change to save the new threshold values.

We defined a threshold CPUHigh in Figure 307 on page 187. When the CPU usage is higher than 95% you will get the notify window.

![Alert Received](image)

**Figure 308. NetFinity/System Monitor/Notify Window**

### 5.3 Lotus Notes Performance

**Note**

Whenever the term Lotus Notes Server is mentioned in this section, it refers to the Lotus Notes server process rather than the physical Lotus Notes server computer itself.
Lotus Notes Domino comes with a set of server statistics that you can tie in to the Windows NT Performance Monitor for logging and/or alerting. All add-in programs that report statistics to the Notes server (for example, the SMTP/MIME MTA) can be monitored using the Performance Monitor.

5.3.1 Installing the Lotus Notes Performance Monitor

The easiest way to install the Lotus Notes Performance Monitor is to do it while installing the Lotus Notes server. By default, this option is not checked when you choose the customized install process so you have to make sure you check it manually.

If you have already installed the Lotus Notes Server but didn’t install the Notes Performance Monitor, run the installation program again and select only the Notes Performance Monitor using the customized installation.

When the installation is done, execute notesreg.bat with a parameter pointing to the path for your Notes directory. Assuming your Notes directory is C:\Notes, you would type:

Notesreg.bat C:\Notes

The following modifications are done to your registry, still assuming the path to your Notes directory is C:\Notes:


Finally, the batch file (notesreg.bat) updates the Performance Monitor counters in the registry from the file notestat.ini by issuing the `lodctr notestat.ini` command.

These two registry keys get modified as a result of that:

- HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\notestat
- HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Perflib

### 5.3.2 Un-Installing the Lotus Notes Performance Monitor

To remove the Notes statistic counter from the Performance Monitor, issue the `unlodctr notestat` command. This only disables the registry reference from the Performance Monitor. The notestat information in the registry for Lotus Notes will still have to be manually removed. There’s no need for it to be removed but those of you who want a clean registry, see 5.3.1, “Installing the Lotus Notes Performance Monitor” on page 189 for information on what registry items to edit.

### 5.3.3 Getting the Instances Up and Running

The Windows NT Performance Monitor polls given counters in real time for statistics. This means that you can’t monitor something that isn’t running or started. If you start the Performance Monitor without having the Lotus Notes Server running, the Lotus Notes object will not show up in the Add to Chart requester.

Even when the Lotus Notes server has been started and the Lotus Notes object shows up in the Add to Chart requester, very few instances may be visible. This is due to the fact that Lotus Notes doesn’t report statistics on modules that haven’t been initialized yet. The best way to activate the basic modules is to issue the `show stat` command on the Lotus Notes console or leave the server on for a period of time.
If you want to monitor a specific instance that hasn’t showed up yet in the Performance Monitor, you need to initialize that particular module explicitly. For example, to initialize the replicator statistics, issue the `rep <servername>` command on the Lotus Notes console.
5.3.4 What Instances Should You Monitor

The instances to monitor depend on what you will use the information for. There are four different types of instances, which are shown in the following table:

<table>
<thead>
<tr>
<th>Type</th>
<th>Example Instance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cumulative</td>
<td>Server.Trans.Total</td>
</tr>
<tr>
<td>Cumulative/Timeunit</td>
<td>Server.Trans.PerMinute</td>
</tr>
<tr>
<td>Instantaneous</td>
<td>Server.Users</td>
</tr>
<tr>
<td>Static</td>
<td>Server.CPU.Count</td>
</tr>
</tbody>
</table>

Some rules of thumb on Lotus Notes Performance Monitoring:

- Don’t mix the various types of instances in the same performance chart or you will have difficulties in reading the graphs.
- When displaying Cumulative/Timeunit instances, adjust the update time to reflect the units of time. For example, don’t update the chart every five minutes if you have instances that reset every minute or you will lose information.
- Consider having two or more Performance Monitors running at the same time instead of trying to fit all instances into one chart.
Chapter 6. SMS

This chapter documents how to install and use Microsoft SMS 1.2 and SQL 6.5 on NT Server 4.0.

6.1 Environment Setup

SMS allows a hierarchical implementation of management servers, which permits a scalable solution. This management hierarchy is implemented through SMS sites and domains, and must be planned prior to installation.

After organizing and setting up the initial site plan you will be ready for the installation of SMS server and clients. Part of that planning will require you to take care of some system setup items that are a prerequisite to installing SMS.

6.1.1 Site Planning and Design

SMS structures the manager and managed machines in groups called sites and SMS domains. Sites are groups of SMS domains. SMS domains are groups of managed machines, either servers or clients, managed as a single entity. A typical implementation uses sites to group machines geographically, and SMS domains to group machines with similar characteristics within each site as shown in Figure 312.

Figure 312. Example of Domains within a Site

Sites have specific names according to their position and capability in the SMS hierarchy:
• A **primary site** is a site that has its own SQL database. It may have other sites beneath it in the hierarchy.

• A **secondary site** is a site without an SQL database and it is always dependant upon the primary site. Sites without an SQL database may not have sites below them in the hierarchy.

• A **central site** is the top site in the site hierarchy and it is always a primary site. There may be only one central site.

• **Parent site**, **child sites**, and **subsites** are also used sometimes to refer to sites according to their position in the hierarchy.

---

**Figure 313. Site Hierarchy Layout Example**

Figure 313 shows an implementation of five sites. The Headquarters Site is in this case, the central site, the top of the site hierarchy. The Mexico City Plant Site, NY Office Site and LA Office Site are all secondary sites (no SQL database), and the Manufacturing Site is a primary site with one subsite. Note that this is just a sample environment. Depending on implementation considerations, all sites could be set as primary sites, provided that each had its own SQL Server database.

Each site has its SMS site server, responsible for executing management functions and allowing controlled use of the network for inter-site communications.
Communication between sites is handled by SMS services called senders, using connectivity provided by Windows NT services such as RAS and SNA Server. Senders provide function much like transmission queue managers. There are different senders for each type of connection between sites: RAS sender, ISDN sender, and SNA sender. This example used a stand-alone site, so senders will not be necessary. The following senders exist in SMS Version 1.2:

- LAN sender
- Batch SNA sender
- Inter SNA sender
- Async RAS sender
- ISDN RAS sender
- X.25 RAS sender

Our environment consisted of one domain containing the following systems:

- WINNT68 (Windows NT Server 4.0 Domain Controller)
- WINNT69 (Windows NT Server V3.51)
- WINDOW95 (Windows 95)
- SMSMON (Windows NT Workstation)

SMS also supports 16-bit versions of Windows as well as OS/2, NetWare and Macintosh machines.

Site planning and design was not at all complicated in this case, but should be considered in large environments. When designing your site layout, keep in mind that:

- SMS assumes that network communications within a site are fast, and that network communications between sites are slow. Therefore, take into consideration your physical topology when defining sites.
- Primary sites should be used in locations where you have a full-time systems administrator. Sites to be administered remotely may be secondary sites, since local queries will be rare.

### 6.1.2 Prerequisites Setup

You need to check hardware and software prerequisites in the SMS documentation prior to your installation. Our SMS site server machine was WINNT68, described in 1.1, “Hardware and Operating System Environment” on page 1.

Before installing SMS you must:

- Have an NTFS partition to install it on
- Make sure the Event Viewer is set to hold enough events from applications
- Install and customize SQL Server
- Create an account to be used by SMS services

If you plan to work with SNMP functions in SMS, remember to install the SNMP service before installing SMS. We recommend you install SNMP during Windows NT installation as we had some problems with some of our systems installing SNMP after the initial installation.
6.1.2.1 Event Viewer Setup

SMS logs its messages in the System and Application event logs. Select the Log Settings option under the Log pull-down menu in the Event Viewer to customize the logs. The following window will appear:

![Event Log Settings Window](image)

Change the Maximum Log Size value to a size proportional to the number of events you expect to have in the log. We chose 10048 KB, because we will have SQL Server, SNA Server and SMS Server using the event log together with the operating system. Select the Overwrite Events as Needed button so applications will not cause errors writing to the log when the log is full, then click on OK.

Figure 314 shows the settings for the system log. Make sure you change the settings for the application log and for the error log. Use the list box Change Settings for to switch between the three logs. The parameters are the same for all three logs.

The Windows NT Server Resource Kit provides a utility to dump event log contents into a text file. This utility is called DUMPEL.EXE and it list logs for local and remote machines. The output of DUMPEL.EXE is a text file with all of the events. The following command would dump all entries in the application log generated by the SMS source into the output.txt file:

```bash
dumpel -l application -m SMS -f output.txt
```

Output from dumpel is as follows:
In addition there is an SMS Resource Kit, but we did not use it in this residency. Information on it can be found at http://www.microsoft.com/smsmgmt/reskit.htm. It is available from Microsoft Press by order number 1-55615-932-3.

6.1.2.2 SQL Server Setup

SQL Server may be installed using integrated security or standard security. Integrated security allows SQL Server to use NT’s user authentication system, while the standard security uses SQL Server’s own login validation process. Both security methods may be used with SMS.

We installed SQL Server using default settings, thereby choosing standard security and a blank password for the sa (system administrator) user.

Customize SQL Server in the following ways before installing SMS:

1. Create SQL Server login IDs for SMS:

   We installed our SQL Server with standard security. Therefore, SMS required SQL login IDs for the installation process and for SMS administrators to use SMS. These login IDs were used by SQL Server’s own validation process, and they are not related to Windows NT user IDs.

   The SQL login ID used by the installation process requires dbo (database owner), permission so that all customization in SQL could be performed. The dbo has full privileges over the database. Figure 315 on page 198 shows the properties for the sa user in the SQL Enterprise Manager.
Customization done by the install program includes creating and/or increasing the size of devices and databases for SMS. We used the default SQL system administrator user ID sa in our installation process.

2. Make sure the database is large enough:

Use the following table to determine what the database device minimum size should be. The SMS data and log devices will get automatically created by the install process.

Additional information for large implementations may be found in the Microsoft Systems Management Server Help files and in the Microsoft Systems Management Server books online.

Use the SQL Enterprise Manager program to increase the size of devices and databases.

<table>
<thead>
<tr>
<th>Device</th>
<th>Minimum Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>data</td>
<td>10MB</td>
</tr>
<tr>
<td>log</td>
<td>10MB</td>
</tr>
<tr>
<td>SMS data</td>
<td>35KB per managed computer</td>
</tr>
<tr>
<td>SMS log</td>
<td>10 percent of SMS data device size</td>
</tr>
<tr>
<td>tempdb data</td>
<td>20 percent of SMS data device size</td>
</tr>
<tr>
<td>tempdb log</td>
<td>20 percent of tempdb device size</td>
</tr>
</tbody>
</table>

Table 7. Minimum Size Recommendations for SQL Server Devices

3. Set SQL Server parameters for connections and open objects:

Use the SQL Enterprise Manager to set connections and open object parameters. Click on the Configure SQL Server button to bring up the Server Configuration/Options dialog and select the Configuration tab.
4. Tune the system memory configuration for SQL Server.

### 6.1.2.3 Create Account for SMS Services

The account for SMS should have the following properties:

- Part of the administrators local group
- Part of the domain admins group
- Log on as a service advanced right

We called our account SMSServiceAccount.

### 6.1.3 SMS Installation

To install SMS, run the _smsetup program from the directory where the SMS files are located. If you are installing from CD and your environment is set to auto-run, the installation program will start automatically after the CD is inserted. The window in Figure 317 on page 200 will be displayed.
Select **Set up SMS 1.2**.

**Figure 318. SMS Setup Welcome Window**

Select **Continue**, then enter your registration information to get to the Installation Options window (Figure 320 on page 201).
SMS Setup will search your system for previously installed versions of SMS. If it finds any version installed, it will just display registration information and go on to the next screen.

If no previous installation of SMS was found, the first and second options will be available; otherwise, the last three options will be available. We did not have any previous installation of SMS in our machine, so we selected **Install a SMS primary site**.
Check the I agree check box if you comply with the licensing instructions to continue installation. The prerequisites window will be displayed.

These prerequisites were taken care of in 6.1.2, “Prerequisites Setup” on page 195. You can select the Help button to get additional information on this. Click on Continue.
Type in the location of the directory that you would like SMS 1.2 installed in. You can either accept the default name or choose a new one. After deciding on that, click on Continue.

Figure 324. SMS Components Selection Window

The default components shown in Figure 324 are enough for a primary server in the Intel environment we worked with. If you need to install additional modules select the Custom button and the window in Figure 325 will be displayed.

Figure 325. SMS List of Installable Additional Components

Add the items suitable to your environment to the Software to Install window and click on OK.

SMS Setup will then prompt you for some SQL parameters.
The default information for this dialog is obtained from your SQL server installation and customization.

If you chose to let SMS Setup customize SQL automatically, you will need to enter your SQL Server name, the SQL login ID to be used by SMS Setup (as explained in 6.1.2.2, “SQL Server Setup” on page 197) and its corresponding password. Select the Device creation button if you wish to change any of the default values for SMS SQL devices.

If you don’t want SQL to automatically customize and create the SMS databases, you can do it manually. You can change the database information in the dialog in Figure 326 to meet your needs.

Select Continue in the window in Figure 326 to continue the installation process. The Primary Site Configuration Information window will be displayed. Update the Site Code field with the three letter code you will use to identify this site. This three letter code will prefix SMS identifiers for every computer managed by SMS.
Many SMS functions are performed using logon scripts. That makes logon servers (domain controllers or backup domain controllers) very important to SMS domains. The servers that SMS clients use for logon authentication are called SMS logon servers. SMS automatically detects these logon servers if you check the Automatically detect all logon servers check box shown in Figure 328.

Enter in the Service Account fields the information about the account created in 6.1.2.3, “Create Account for SMS Services” on page 199 that is to be used by SMS services.

After you select Continue, the Setup Progress window is shown.

We chose in Figure 324 on page 203 to install the Network Monitor Agent. SMS deletes old Network Monitor template information (Figure 330 on page 206) and instructs us to reinstall it through the Control Panel’s Network setting dialog shown in Figure 331 on page 206.
The SMS Setup process automatically starts the Control Panel’s Network setting dialog for Network Monitor Agent installation. The Network Monitor Agent is a collector of network statistics available in Windows NT. The Network Monitor Agent collects information to be displayed by Network Monitor Tools (another network service in Windows NT Server). Select the Services tab and click on Add.
Select the **Network Monitor Agent** and click **OK** to install the Network Monitor Agent. Select **OK** again to exit the Control Panel’s Network setting dialog but do **not** reboot your machine if your SMS Setup is not finished.

Figure 333. Network Service Selection Window

After you exit the Network settings dialog, you should see Figure 334 on page 208 showing successful completion of SMS Setup.
The following program group is created by the installation process:

Click on the **Services** icon in the Control Panel to verify the creation and the status of SMS services, as shown in Figure 336.

Note that all services are automatically set to use the account created in 6.1.2.3, "Create Account for SMS Services" on page 199. Click on **Startup** after selecting...
one of the SMS services and Figure 337 on page 209 will show the account under which the service will run.

![Figure 337. SMS Service Startup Properties](image)

SMS Setup creates three shares in the primary server as shown in the following figure:

![Figure 338. SMS Shares Created by the Setup Program](image)

There were no changes in user accounts or user rights after installation.

After the above steps, install the most recent service pack available from Microsoft. At the time of this writing, SMS service packs could be obtained from the Internet at the address http://www.microsoft.com/kb/softlib/. We installed SMS Server 1.2 Service Pack 1. During the final editing phases of this book, service pack 2 became available, but we did not update the book for any new functions or fixes from that service pack.

At this point, that completes the SMS primary server installation. To be able to manage other machines you must install client code on each machine you want to manage.
6.1.4 SMS Clients Installation

SMS 1.2 supports Windows (NT, 95 and 3.x), OS/2 and NetWare machines as managed resources. Our environment, however, was limited to Windows 95 and Windows NT.

Before installing clients, synchronize the client clock with the server clock with the command:

```
net time \servername /set
```

Change servername to the server you want the client clock synchronized with. This assures you that jobs will be carried out at the correct time.

SMS clients may be installed manually or automatically.

6.1.4.1 Manual SMS Client Installation

To install clients manually, simply go to the target machine, map the SMS shared directory SMS_SHR as a local drive and from it run the RUNSMS.BAT script.

RUNSMS.BAT issues simple shell commands to verify what operating system it is running on and starts the correct SMS client install program. The script ran fine in our installation, and did not require any modification. The sample SMS scripts are listed in Appendix A, “SMS Files” on page 271.

No special requirements other than the ones listed in the Appendix B of the Microsoft SMS Getting Started manual were necessary. It is interesting to note, however, that only Windows machines have all of the SMS functions. Any other non-Microsoft platform (DOS, OS/2 and Macintosh) can only use the inventory and software distribution.

We installed our SMS client on Windows NT Server V3.51 manually. Figure 339 shows the installation output.

```
F:\>runsms
Microsoft Systems Management Server (SMS)

Installing Microsoft Systems Management Server on this client.................
..................................................

Microsoft Systems Management Server has been successfully installed. Re-start your machine for all newly installed components to run and function properly.

{MS108n}
F:\>
```

*Figure 339. Output from SMS Client Manual Installation*
6.1.4.2 Automatic SMS Client Installation

The process regarded by Microsoft as automatic installation is actually the execution of the install procedure from a logon script. Logon scripts are programs or batch files executed automatically when a user logs on to a server. That means, for example, that if nobody ever logs on to a remote Windows NT Server, automatic installation is impossible. This is still a handy alternative when SMS clients must be deployed in large environments.

Therefore we had to enable logon scripts and their related services in our environment to allow automatic SMS client installation to occur.

You need to follow three steps to enable automatic client installation:

1. Configure the Windows NT directory replicator service.

   The replicator service will allow SMS files and scripts to be shared (replicated) between domain controllers in your environment, thus making these files and scripts available to all clients at login time.

   Enable NT’s directory replicator service with the following steps:

   a. Create an account to be used by the directory replicator service with the following characteristics: administrator privileges, user cannot change password, password never expires and log on as a service advanced right.

      Set the directory replicator service to use that account through the Services icon in the Control Panel.

   b. Give read access to the domain user group to the NETLOGON share in each logon server.

   c. Enable replication using the Windows NT Server Manager program, with the following steps:

      1) Select the server you want to enable replication in.

      2) Select Properties under the Computer pull-down menu. You will see the following window:

         ![Figure 340. NT Server Properties Window](image)

         Click on the Replication button, and the Directory Replication window will appear:
Select **Export Directories** and **Import Directories**. Make sure that To List and From List are empty, and close all open windows by clicking on the **OK** button.

You may test your directory replication by copying a small sample file to the `\winnt\system32\repl\export\scripts` directory (where `winnt` is your windows system directory). If everything is working fine, the directory replicator service will copy this file automatically to the `\winnt\system32\repl\import\scripts` directory.

**Note**

The copying is not instantaneous.

2. Set domains to use the **All detected servers** option.

Click on the **Domains** button in the Site Properties window of the SMS Administrator program (refer to 6.2.1, “The SMS Administrator” on page 217 for information on how to start the SMS Administrator program) to set the **Use All Detected Servers** option.
Choose **Proposed Properties** and then **Properties**... Figure 343 on page 213 will be displayed.

![Domain Properties Window](image1)

**Figure 343. SMS Domain Properties Window**

Note that your primary site server will be automatically added to the Use These Logon Servers window.

Select **Use All Detected Servers** and select **OK**. Click on **OK** again and the proposed properties will be saved and applied by the SMS services according to their schedule.

This makes SMS discover other logon servers to replicate its logon scripts, assuring that all user logins will execute the SMS client install program.

3. Enable Automatically Configure Workstation Logon Scripts.

Click on the **Clients** button in the Site Properties window of the SMS Administrator program (please refer to 6.2.1, "The SMS Administrator" on page 217 for information on how to start the SMS Administrator program) to enable the Automatically Configure Workstation Logon Scripts option.

![Clients Properties Window](image2)

**Figure 344. SMS Clients Properties Window**
Select **Proposed Properties** and check the **Automatically Configure Workstation Logon Scripts** option. This will cause SMS to update existing logon scripts to include the SMSLS.BAT script. If any of the users don’t have a logon script SMS will make SMSLS.BAT the users logon script. If a user’s logon script is a binary file instead of a .BAT file, SMS will not update it. In that case, before enabling automatic client installation, create a logon script that calls the binary file. When you enable SMS automatic client installation, it will successfully add SMSLS.BAT to the logon script. SMSLS.BAT is listed in Appendix A, “SMS Files” on page 271.

Select **OK** to submit changes to SMS services.

These are the steps needed to make SMS automatic client installation available. From now on, when a user logs on, SMS will check for installed client code. If the client code has not been installed, the installation process runs automatically on the machine.

---

**Note on Timing**

SMS and NT’s Directory Replicator service both take some time to perform synchronization among its services. Be aware that your automatic installation environment might even take a few hours to be 100% complete. Check the Events window in SMS Administrator (described in 6.2.5, “Events and Alerts” on page 245) for any errors that might occur during this process.

We created our SMS service account belonging to the administrator group only, as described in SMS documentation. The fact that the SMS service account was not part of the domain admin group did not allow the login scripts for automatic installation to be copied to the shared directories, causing a long delay.

We only found out about the problem when we checked the SMS Events window. The entry in Figure 345 documented the error. We then added the SMS service account to the domain admins group and the automatic client install process worked fine.

---

![Figure 345. SMS Event Describing Insufficient Privileges](image-url)
6.1.4.3 SMS Client Modules

The client installation process starts the Package Command Manager (Figure 346), the MIF Entry program (Figure 347 on page 216) and creates an SMS client program group (Figure 348 on page 216 and Figure 349 on page 217).

![Welcome to Package Command Manager](image)

*Figure 346. SMS Package Command Manager*

The Package Command Manager (PCM) is part of the SMS software distribution function. It is the client portion that is in charge of executing jobs sent by SMS. PCM is loaded in the client machine, and it waits for the arrival of a job. When a job arrives, it pops up a window. If the job is not mandatory, it will sit in PCM until it expires or until the user executes it. If it is mandatory, PCM will show a message (Figure 376 on page 234) and execute it after five minutes.
The MIF Entry program complements the inventory service provided by SMS by allowing the creation of forms with new inventory fields. These forms use the DMTF MIF standard format. We discuss inventory extensions in more detail in 6.2.6, “Performing Inventory” on page 253.
In addition to the Package Command Manager and the MIF Entry program, two other modules are installed in the client machine and included in the SMS client program group: Program Group Control and Help Desk Options.

The Program Group Control is the client module responsible for making shared network applications available.

Help Desk Options allows the user in the managed machine to customize how SMS remote troubleshooting will work. This customization applies to allowing or denying the SMS administrator from executing each remote troubleshooting function. The remote troubleshooting option is discussed in 6.2.8, “Performing Remote Troubleshooting” on page 262.

Windows 3.x and Windows 95 machines have an additional icon in the SMS client program group for the remote control client (WUSER.EXE and WUSER32.EXE). This module is started as a service in Windows NT, therefore, it only appears within the services program in the control panel.

The above steps complete the basic SMS client installation. As clients are installed, the inventory function is run. Check in the SMS Administrator window (see 6.2.1, “The SMS Administrator”) if the client was registered and if its inventory information was actually collected. If yes, communication between SMS and the client is fine. Note that remote control (Help Desk icon) is disabled by default. (See 6.2.8, “Performing Remote Troubleshooting” on page 262 for how to enable it.)

6.2 Working with SMS

SMS functions are available through the SMS Administrator GUI. This program is installed in primary sites by default, but may also be installed in any Windows NT machine that communicates with the primary site.

6.2.1 The SMS Administrator

After installation, the SMS program group in your administrator machine should look like this:

---

Figure 349. SMS Client Program Group in Windows 95

---
Select the **SMS Administrator** item to start the SMS GUI. You will be prompted for your SMS SQL password. This password will be the same one you used to install SMS.

![Figure 350. SMS Administrator Program Group](image)

The open SMS window will appear allowing you to choose which window type to start SMS with. At this time, select **Sites** as your window type and then click on **OK**.

![Figure 351. SMS Administrator Login Window](image)
Figure 352. Open SMS Window

The administrator window is displayed. The tool bar under the pull-down menus contains buttons for each type of window you can open:

- Sites
- Jobs
- Packages
- Queries
- Alerts
- Machine Groups
- Site Groups
- Program Groups
- Events
- SNMP Traps

If you position the mouse pointer over the buttons for a moment, a help box will indicate what the button is used for. We provide a description of each of these buttons as we explain each function of SMS. For now, you will have the sites window displayed. This window shows how your site hierarchy is laid out. We double-clicked on the site icon named Raleigh ITSO, and then on the domain icon Management. You will see in the right side of the sites window the list of clients belonging to this domain.
Select the Raleigh ITSO site and click on the **Properties** button (or choose Properties from the file pull-down menu). The window in Figure 354 appears.

This window shows the site properties and allows you to change settings for each specific service for this site. You may customize how often inventory is carried out, which SMS services are available in client machines, where SMS Server services will run, position in hierarchy, as well as other functions. We list all of the parameters, but we focus on the ones that are most meaningful to our scenarios. Refer to the bibliography for details on parameters not documented here.

Each property window will have two property views: Current Properties and Proposed Properties. When you enter a property window the Current Properties option is always the default.

Current Properties shows the options SMS is using at that moment. Proposed Properties allows you to modify Current Properties and then submit your changes to SMS.
The SMS Hierarchy Manager will detect modifications in the database and execute these changes using a system job.

![Inventory Properties Window](image)

**Figure 355. SMS Inventory Properties Window**

The Inventory Properties window is shown after you select the **Inventory** button in the Site Properties window. This window allows customization of how frequent hardware and software inventory will run on client machines, as well as how to handle inventory when the network is slow.

The shortest time interval to perform inventory is the time between consecutive logons to the network by the client. For example, if the client logs on at 12:00 then logs right off and logs back on at 12:01, the time interval will be one minute. This is an inefficient way to perform the inventory process, but it is the way SMS is implemented. If logons are too frequent, this interval may be increased by the number of days you find adequate.

Click on the **Clients** button in Figure 350 on page 218 and the following window is displayed:

![Client Properties Window](image)

**Figure 356. SMS Client Properties Window**

Use the Client Properties window to set:
• Which SMS component will be available at the client machines in this site.
You may select under Client Software which modules will be available in the
client machine, and if each one of them will be automatically started or not.
• Remote Troubleshooting options
Also under Client Software are options for Remote Troubleshooting on
Windows NT managed machines, available by clicking on the **Options** button.

![Remote Troubleshooting Options](image)

**Figure 357. SMS Client Remote Troubleshooting Properties Window**

Use the first section of the above window to restrict access to the remote
troubleshooting option to specific groups or users. All administrator groups
have access to this function by default.

SMS provides improved remote troubleshooting performance for the default list
of video drivers in Windows NT. Use the Install Accelerated Screen Transfer
section to disable this function or to disable acceleration with one specific video
driver.

In the last section of Figure 357, select which protocol you would like to use for
remote control of your Windows NT managed machines.

• Automatic configuration of logon scripts
This option in Figure 356 on page 221 will determine whether or not to
enable automatic installation of SMS clients, as shown in 6.1.4.2, “Automatic
SMS Client Installation” on page 211.

• Polling interval for the Package Command Manager
Specify in this field how many minutes the Package Command Manager
(6.2.7, “Performing Software Distribution” on page 260) should wait between
each round of polls from the server to search for new available packages.
SMS allows you to distribute each server function among different NT servers, called SMS Helper servers. Click the Services button in Figure 354 on page 220 to customize which server will execute which function, as shown below.

![Services Window](image)

**Figure 358. SMS Services Properties Window**

Type the server name for each service in the appropriate field, and the corresponding drive where the SMS code is located in that server. Note that it must be an NTFS drive.

The Sender service is not listed in this window, but may also be started on a different machine. Click on the Senders button in Figure 354 on page 220 to customize senders.

Use the Services Properties window to set how much system load SMS services should use. In the Response section select the kind of response time you expect from SMS. An example of the system load being proportional to the requested response time is shown in the right-hand column.

Click on the Account button in Figure 354 on page 220 if you need to change some of the SMS service account parameters. Examples of that would be the account name or the password. This refers to the account created in 6.1.2.3, “Create Account for SMS Services” on page 199.

![Account Window](image)

**Figure 359. SMS Account Properties Window**

Use the Parent Site window to set the role of this server in the SMS hierarchy. In our case, the server is a stand-alone server. However, if you are a child site of any other site, select Attach to Parent Site and input the Site Code in the proper field in Figure 360 on page 224.
The site code of the parent site was chosen during the installation process as shown in Figure 328 on page 205.

Figure 360. SMS Parent Site Properties Window

The Domains window allows you to configure which domains are located under the selected site. Click on the Domains button in the Site Properties window (Figure 354 on page 220) to open the Domains window.

Figure 361. SMS Domains Window for a Site

Figure 361 lists the domains currently under this site. You may add other domains or change domain properties by clicking on the Add and Properties buttons respectively.

In both cases you will be prompted with the window in Figure 362 on page 225. For each domain you may manually specify which machines are logon servers or leave it up to SMS to discover them. Select Use All Detected Servers to let SMS discover logon servers, or Use Specified Servers to manually input logon servers for your domain.

Note that Use All Detected Servers must be set to enable automatic client installation for SMS (see 6.1.4.2, “Automatic SMS Client Installation” on page 211).
The following window allows you to register additional package servers to your site. Package servers are sources or intermediate repositories for packages distributed by SMS.

The Addresses, Outboxes and Senders buttons in Figure 354 on page 220 refer to parameters used generally in multi-site implementations:

- **Addresses parameters** allow configuration of addresses to be used by senders for communication between sites.
- **Outboxes parameters** determine which outboxes are available in this site. Outboxes are directories used by each sender as an intermediary repository of transmission requests.
- **Senders parameters** register all senders within a site.

Click on the **SNMP Traps** button in Figure 354 on page 220 to customize the SMS SNMP-related settings.
6.2.2 Packages and Jobs

All software that is to be managed by SMS must be defined in packages. Packages contain parameters for SMS to perform software distribution, application sharing and software inventory. A package is much like a CID install, where you have installation parameters gathered for automation.

A job in SMS is a task that carries out actions contained in packages. Jobs may distribute or remove software and share applications.

A job always takes actions based upon what is specified in a package, and a package is always handled by a job. Therefore, the two are very closely related.

6.2.2.1 Packages

Use the Packages window in the SMS Administrator GUI to define new packages.

Packages may be used in three ways:

1. Defining files and commands to be distributed to client machines.
2. Defining applications to be distributed to servers and shared with client machines.
3. Defining parameters for SMS to recognize a package during software inventory.

To create a new package, click on the New Package button in the tool bar or choose File then New from the pull-down menus.

![Image of SMS Packages Window]

Enter the name and a comment and click on Workstations to enter distribution properties for this package.
The Source Directory field must contain the directory where the files you want to distribute are. It must also be a shared directory in order to be accessed by SMS services (local or remote). Click on New to specify the installation command.

The installation command will be executed on the target machine when the package distribution job is carried out. The executable file for the installation command must be in the source directory together with the files to be transferred.

Select OK to exit the screens and the following warning will be displayed to remind you of sharing the source directory.

The Sharing button in the Package Properties window will allow you to enter information on software sharing.
In the Source Directory field, enter the directory where the shared application files are. These files will be packaged and distributed to the servers that will be sharing this application with client machines. This application will be shared under the share name specified in the Share Name field.

You can specify several program items for each shared application. Each program item will be one icon in the client’s program group. Click on New to specify new program items.

Specify the following characteristics for each icon:

- Description: Icon label
- Command Line: Program to be executed when the icon is clicked on
- Registry Name: Registry name of the application, if the application is to be called by its registry name instead of its program name
• Configuration Command Line: Any configuration program to be run by the program group manager to set up the shared application in the client machine
• Whether or not to display the icon in the program group
• Whether or not to run the application minimized
• Run Local Copy if Present: Will make SMS look for copies of the application on local drives and execute local copies if they exist
• Drive Mode: Determines if the application will run directly from its share name (UNC name) without being mounted to a drive, or if it will need to be mounted to any drive or a specific drive
• Supported platforms for this application

Click on **OK** to close the sharing screens to finish sharing parameters setup.

Click on the **Inventory** button in the Package Properties window to define how SMS will discover this software during inventory. This is done by specifying a set of characteristics that imply that the software is installed in a machine.

Characteristics must always be file-related. For example, the simple fact that one file exists in a workstation may show that an application is installed. On the other hand, it might be necessary to distinguish different versions of the same software. In this case, you may specify file names and file sizes to find out what version is installed.

![Setup Package for Inventory](image-url)

**Figure 371. SMS Setup Package for Inventory Window**

Use the Add AND and Add OR buttons to define these parameters. You may specify date or checksum. There are other attributes to compare on as well. If you do not know the value for one attribute, the Retrieve function will obtain the correct value for you.

After selecting **OK**, SMS will warn you the changes are underway.
This package will now be part of the inventory criteria for software, and will show up with remaining inventory data (see 6.2.6, “Performing Inventory” on page 253).

Packages may also be created with package definition files (PDFs). PDFs are text files that contain package parameters to be input automatically when creating a package. SMS provides many PDFs for Microsoft products in the \SMS\PRIMSITE.SRV\IMPORT.SRC\ENU directory. PDF files have a .PDF extension. A sample PDF file for Microsoft Office 95 follows:
Figure 372. Sample PDF File for Microsoft Office 95

Each section in the PDF corresponds to the windows for manual creation of the package. The Package Definition section corresponds to input in the Package Properties window (Figure 365 on page 226). The Manual Setup and Automated Setup sections correspond to the workstation command lines contained in the Setup Package for Workstations window (Figure 366 on page 227). Setup
Package for Inventory section and the File 1 section correspond to parameters in the Setup Package for Inventory window (Figure 371 on page 229).

To create a package from a PDF, click on the Import button in the Package Properties window (Figure 365 on page 226). The only parameter required to be input manually will be the source directory (Figure 366 on page 227).

After defining your packages, you are ready to use jobs to distribute and execute them in client workstations.

6.2.2.2 Jobs

Use the Jobs window in the SMS Administrator GUI to work with jobs.

<table>
<thead>
<tr>
<th>ID</th>
<th>Type</th>
<th>Status</th>
<th>Time</th>
<th>Comment</th>
<th>Priority</th>
<th>Repeat</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAL0000C</td>
<td>Run Command Job</td>
<td>Complete</td>
<td>4/9/97 11:20:00 AM</td>
<td>Audit Software</td>
<td>Low</td>
<td>Never</td>
</tr>
<tr>
<td>RAL00010</td>
<td>Run Command Job</td>
<td>Complete</td>
<td>4/9/97 4:25:00 PM</td>
<td>Once again audit run</td>
<td>Low</td>
<td>Never</td>
</tr>
<tr>
<td>RAL00013</td>
<td>System Job</td>
<td>Complete</td>
<td>4/10/97 5:30:00 PM</td>
<td>System job to resync client.</td>
<td>Medium</td>
<td>Never</td>
</tr>
<tr>
<td>RAL00017</td>
<td>Remove Package</td>
<td>Pending</td>
<td>12/14/97 6:31:00 PM</td>
<td>test</td>
<td>Low</td>
<td>Never</td>
</tr>
<tr>
<td>RAL00018</td>
<td>Share Package</td>
<td>Pending</td>
<td>12/14/97 6:32:00 PM</td>
<td>System job to resync client.</td>
<td>Low</td>
<td>Never</td>
</tr>
<tr>
<td>RAL00019</td>
<td>System Job</td>
<td>Complete</td>
<td>4/17/97 7:48:00 PM</td>
<td>System job to resync client.</td>
<td>Medium</td>
<td>Never</td>
</tr>
<tr>
<td>RAL0001A</td>
<td>System Job</td>
<td>Complete</td>
<td>4/17/97 7:48:00 PM</td>
<td>System job to resync client.</td>
<td>Medium</td>
<td>Never</td>
</tr>
</tbody>
</table>

Figure 373. SMS Jobs Window

Note that in Figure 373 there are different types of jobs: System jobs, Run Command jobs, Remove Package jobs, and Share Package jobs. SMS itself uses jobs to carry out its tasks. SMS jobs are called System Jobs. Jobs created by the administrator may be Run Command jobs, Share Package jobs or Remove Package jobs.

A Run Command on Workstation job distributes a package with a command to be executed on a workstation. The package must contain a command and may also contain software or data files.

A Share Package job distributes a package to servers for application sharing.

A Remove Package job removes packages from distribution servers. This type of job deletes package source directory files in the specified distribution servers.

Regular job processing includes the Send, Distribute and Run phases. The Send phase transmits the package to all target sites. The Distribute phase places the package in the distribution servers. The Run phase executes the packages in the target client workstations. Run Command on Workstation jobs have all three phases. A Share Package job has only the Send and the Distribute phases, since it does not involve client workstations directly. Remove Package jobs do not have any phases.

A job is automatically created if you drag a package onto a target such as a machine (in the Sites window), a domain or a group. You will be prompted to enter job parameters as if you were creating the job manually.

Click on New to manually create a new job under the Jobs window.
For a Run Command on Workstation job, type a job description in the Comment field and choose the appropriate job type. Then click on Details to input the job details.

Specify in the first field of the job details window what package will be handled by this job. The Package field will contain all packages defined with workstation attributes (the only ones that apply to the Run on Workstation job type).

Job Target, listed below the Package field, allows you to set target workstations where the job will be executed. You may use the results of a query as targets, as well as machine groups, machine paths, and site/subsite boundaries.

Send Phase options will determine if SMS actually sends a new copy of the package to the distribution servers and clients or if it uses the current copy already available in each machine. Select Even if Previously Sent to force
package distribution. The Only if Not Previously sent option will use the package currently available at the target sites.

Use the parameters in the Distribution Phase section to limit the scope of target distribution servers that will receive this package. Refresh Existing Distribution Servers will cause SMS to send the package to all servers that already have a copy of the package, while the other option allows you to specify machines or groups of machines (distribution servers) to receive the package.

Packages may contain different commands for different actions on package files (for example, standard installation or minimum installation). Select which command you want to be executed in the Run Phase section of the Job Details window. Also specify when this job should be offered to the client workstation. After that specific period of time, the job will show up in the Package Command Manager in the client workstation. Note that this is different than scheduling the job for a specified time. Scheduling is available by clicking on the Schedule button in the Job Properties window.

It is possible to make jobs mandatory, to force the Package Command Manager to run them after the specified date and time. Check the Mandatory After box to select that option, and clients will be prompted with the following window when the job is received by Package Command Manager.

![Mandatory Execution](image)

*Figure 376. SMS Mandatory Job Execution Warning*

Jobs may have an expiration date that will prevent them from being executed after a specified date and time (by deleting them from Package Command Manager in the client workstation). The expiration date is enabled by checking the Expires After check box.

Scheduling parameters, as mentioned above, may be set by clicking the Schedule button in the Job Properties window.

![Job Schedule](image)

*Figure 377. SMS Job Schedule Window*

A job may be scheduled for a specified date and time, with priority and frequency (repeat) options. Selecting OK to close the windows will finish job creation and trigger an update in the database.
SMS will distribute and execute the jobs accordingly and show their status in the Job Status window.

![Job Status Window](image)

**Figure 378. SMS Job Status Window**

Figure 378 shows a summary of the status for this job on a per site basis. You may select one specific site and click Details for detailed status information.

![Job Status Details Window](image)

**Figure 379. SMS Job Status Details Window**

Details on job status cover date, time and outcome of job arrival to the site. In addition, you can get status details on server processing for the job (distribution), and the status of execution on each target workstation.

If a job fails, it will generate an event documenting the error. Check the Event window for job events. Double-click on an event to see event details.
6.2.3 Queries and Reports

A lot of the functional advantages in SMS are obtained not from new code or solutions, but from the fact that it uses an SQL database to store its data. It is difficult to visualize a good inventory management solution that does not build its data on a flexible and open database. SMS does a good job in storing its information in SQL Server, allowing other applications to make use of it, and providing internal querying and customized output capabilities.

Queries allow the administrator to select entries in the SMS database according to pre-specified criteria. To better understand queries in SMS, we must understand part of the structure of the SMS database.

Objects in the SMS database are stored according to their architecture. An architecture specifies a set of characteristics (attributes) defining object types. The Personal Computer architecture, for example, structures characteristics of computers supported by SMS. Architectures in the SMS database are:

- Personal Computer
- UserGroups
- JobDetails
- SMS Event
- SNMP Traps
- PackageLocation

Smaller sets of attributes form groups. Error and information could be examples of groups in the SMS event architecture.

The Queries icon in the SMS Administrator window opens the Queries window.
Select from the pull-down menus File, then New, to create a new query.

The Query Properties window is basically a way to graphically create queries. That is, you create a text expression specifying your criteria without typing, just by pointing and clicking.

Queries may be run on one architecture at a time. Use the proper fields to name and describe your query, and select the architecture you want to run it on. Our example selects all error events from the database, so we selected the SMS Error architecture.

The column of buttons to the right side of the window allows you to enter your criteria. Click on the Add AND button and the Query Expression Properties window will show you a table with groups, classes and attributes that may be used in your query. You may combine any of these attributes in any way with
SQL operators to specify your selection criteria. For our example, we will select the EventTypeName attribute, the is operator, and the \Microsoft\SMS\Error value.

![Query Expression Properties Window](image1)

**Figure 383. SMS Query Expression Properties Window**

After selecting **OK**, your selections will be converted to text and inserted into the **Find all 'SMSEvent' items where: section of the Query Properties window.**

![Query Properties Window](image2)

**Figure 384. SMS Query Properties Window**

Our sample query is ready to be run. It is possible to add other selection criteria, using the Add AND and Add OR buttons, and to group them in parenthesis to override the default resolution order.

SMS has a number of preset queries available. A subset of the preset queries is listed in Figure 381 on page 237. One example of a query with more than one selection criteria is the Inactive Personal Computers query.
To execute a query, select the desired item from the Query window and click on the **Execute Query** button.

Under the Execute Query window you may change the query to be executed, choose its output format, and the database scope for this query (site wise). We used the default query result format for this example. Click on **OK** to run the query.
Figure 387 is displayed with the results of the query.

SMS internal reporting capabilities are limited to customizing query output format and printing query output. Because of that, an additional reporting tool called Crystal Reports from Crystal Computer Services, Inc. is packaged together with SMS.

Select **Define Query Result Formats** from the File menu to customize query output.

![Define Query Result Formats](image)

*Figure 388. SMS Define Query Result Formats Window*

Each query output format must be associated with an architecture. It is possible to have more than one output format based on each architecture. SMS provides one default format, the Identification format, for each architecture.

The Identification format formats query output to show basic information such as machine name, SMSID, site, domain, system role and type, and last user logged on. All queries you execute before specifying an output format will have results shown in the Identification format.

In our example, we created output for the selected error events that included all of the text data in the message. To duplicate this choose the SMSEvent architecture and click on **New** to create the new output format.
Move the desired attributes from the Available Columns list to the Format list of the window to compose your new output format. Click on OK to close the windows and the new output format will be available when you run queries on the specified architecture.

Remember that all output may be printed or copied to a file by clicking on the Print option in the File pull-down menu.

6.2.4 SMS Groups

Two different categories of groups are listed here as examples: program groups and site/machine groups.

6.2.4.1 Program Groups

A program group is basically a collection of program items. After applications are shared (see 6.2.2, “Packages and Jobs” on page 226), application program items are made available to the users. These program items can only be accessed with the program groups.

Program groups may be customized to show only specific icons and access to them may be restricted by user groups. Create one program group by clicking on the New button in the Program Groups window.
Type a name with some comments and select the **Packages** button to specify which sharing packages will be used in this program group.

All available packages with sharing properties will be listed in the right portion of the window. Select the ones you will use in the program group by moving them to the left portion of the window.

Each member package selected will have its program items listed in the Shared Program section of the Program Group Packages window. The default setting is to select all program items, but you may select/deselect according to your needs. After you click on **OK**, you will see in the Program Group Properties window the icons for each program item selected to be part of this program group.
Click on **User Groups** to define which user groups will have access to this program group.

Click on **OK** to finish the program group creation process. Program groups apply only to program items and user access. Packages associated with program groups are not distributed automatically when program groups are distributed. SMS issues the warning below to remind you that any related packages must be distributed by you.
6.2.4.2 Site Groups and Machine Groups

Site groups and machine groups are yet another way for the administrator to group machines. Queries group machines with similar criteria. Groups provide the administrator with the freedom to set up any kind of arrangement they need, based upon their own criteria.

Open the Site Groups window and create a new group. After selecting this group simply drag and drop into it any sites you want from the Sites window.

Perform the same procedure for machine groups, selecting managed machines instead of sites. The figure below illustrates the Sites window together with the Site Groups window and the Machine Groups window.

Machine groups and site groups may be used as targets in drag-and-drop operations or, as for example, in Figure 375 on page 233 in the Job Target fields.
6.2.5 Events and Alerts

Relevant occurrences within SMS are logged to the database as events. All events may be viewed through the Event window in the SMS Administrator GUI. Events are logged also in the Windows NT Event Viewer, under the SMS source.

Alerts also document relevant occurrences, but differ from events because they are the result of a query in the SMS database. Events are a result of SMS actions, while alerts flow as a result of conditions that were pre-determined by how the administrator customized the system.

The administrator may query any condition in the SMS database, and if that condition is met, an alert will be generated. For each alert, you may specify an action to be automatically executed.

Note that the way alerts are structured does not allow real-time responses to conditions. Any condition must first be detected by SMS, then written to the database, then be detected by the alert query to trigger an action. The more dynamic the information you want to monitor, the more difficult it is to respond to it promptly with SMS.

Since an alert is always the result of a query you must obviously perform the query before any alert will flow. We created a query to select all machines with less than 400 MB of free disk space on drive C:

![Figure 396. Query Properties to Generate Alert](image)

Use the Alerts window to create new alerts. After selecting **New**, **Name** and **Comment**, the alert will be created.
The Query button allows you to specify which query will be associated with this alert. Select the one we just created.

The query will be executed by SMS based upon the time interval you specify in Figure 398. Every time the query is executed, an alert will be generated if the number of hits match the condition and value in the Generate Alert fields. However, if the number of hits is the same as the previous query executed by the alerter service, an alert will not be generated.
Use the Actions button in the Alert Properties window to specify actions to be performed when an alert is generated. You may log an event, run a command line program or notify a computer or user.

The specified command will run in the same machine where the SMS alerter service is running, under the SMS service account. This command may not be a windows application, but you may redirect command output to a specified file as we did in the above example. The diruse command in the above syntax lists all directories with more than 20 MB and redirects its output to the file analysys.txt.

The following event was generated from our alert:

![Event Detail](image)

**Figure 400. SMS Event Resulting from Alert**

Users selected to be notified receive a messenger service window.

![Messenger Service](image)

**Figure 401. SMS Alert Message**

### 6.2.5.1 SNMP Functions in SMS

SMS is able to interact with SNMP in two ways, by listening to SNMP traps or generating SNMP traps from Windows NT events.

**Listening to SNMP Traps:** To set up SMS to listen to SNMP traps, go to the Sites window in the SMS Administrator and after selecting the desired site, click on the Properties button. The Site Properties window will be displayed (Figure 354 on page 220). Click on the **SNMP Traps** button for the SNMP Traps Properties window.
This window allows the administration to set up how traps will be handled by SMS. Traps may be either filtered (ignored) or logged to the database. You may create handling options for each trap or group of traps, using the SNMP Trap Filter Properties window. Click on the Create button to create a trap filter.

We created a filter to log all traps to the database. The window in Figure 403 allows you to restrict actions on traps based on:

- IP address
- Trap enterprise ID
- NT event source (for traps that correspond to NT events)
- Trap type

Select the desired options and click on the OK button to close the windows, clicking on Yes when SMS prompts you for confirmation on site update. You will now see traps in the SMS SNMP Traps window.
Double-click on a trap to see trap details.

Figure 405. Traps Details

Traps listed in the SMS SNMP Traps window are part of the SMS database. Therefore, you may base new queries on trap parameters, and also create new alerts or automated actions for SMS to perform when a specific trap or group of traps occur. Queries are described in 6.2.3, "Queries and Reports" on page 236. Refer to 6.2.5, "Events and Alerts" on page 245 for information on alerts and automated actions.

Keep in mind, however, that because SMS has query-based alerts you will not be able to respond to traps in real time. Responding to traps in real time is better performed by dedicated SNMP managers such as TME 10 NetView or OpenView.
**Generating SNMP Traps from Windows NT Events:** All events logged to the Windows NT Event Viewer may be translated to SNMP traps. This allows events to be integrated into SNMP management platforms such as TME 10 NetView, TME Event Console or OpenView.

Use the Event to Trap Translator function in SMS to generate traps from NT events. Find the computer you want to work on in the Sites window and double-click on it. This will bring you to the Personal Computer Properties window. Select the **Windows NT Diagnostics** icon in the left column, and you will see the Event to Trap Translator icon available in the same window.

![Figure 406. Win NT Administrative Tools, Event to Trap Translator](image)

Click on the **Event to Trap Translator** button and a progress indicator window is shown. Since you are getting remote parameters over the network, it may take a few seconds to load.

![Figure 407. Loading Trap Configuration Window](image)

The Event to Trap Translator window is displayed. Click on the **Edit** button to expand the window and add events to be translated into traps.
The lower part of the window lists the available event sources from the Event Viewer grouped by the event log type. We chose a couple of events from the SNMP source under the system log. Double-click on the selected event and the event properties window is displayed.
Figure 409. Event Properties

The Properties window allows you to create a trap throttle (threshold) to generate traps only when events reach a pre-specified count within a specific time interval. For example, you may want to only generate a trap for unsuccessful logon events if you detect more than three unsuccessful logon attempts in 60 seconds. This way the If Event Count Reaches field must be set to 3 and the Within Time Interval check box must be checked with its corresponding seconds field set to 60.

Clicking on OK will add this event to the list in the top half of the window. Every time this type of event is generated, SMS will check it against the event properties (see Figure 409) and issue a corresponding SNMP trap if appropriate.

The Settings button in the Event to Trap Translator window allows you to change trap translation parameters.
The field Trap Length Limit allows you to restrict how large translated traps will be. Trap size may be limited by your networking software, so adjust this parameter accordingly. If the trap is bigger than the length you specify, you may choose to trim insertion strings or the message text first.

Using the field Trap Throttle gives you control of the number of generated traps in a period of time. You may instruct SMS to stop translation if you have too many traps in a specific period of time.

Selecting OK saves all settings and traps will now be generated when the events you specified occur.

6.2.6 Performing Inventory

SMS aids in LAN administration by detecting hardware and software that is installed in managed machines. Both hardware and software inventories are kept in the SQL database and accessed through the same GUI.

6.2.6.1 Hardware Inventory

Computer hardware is inventoried for the first time when a user logs on to an SMS logon server. The logon script will trigger automatic installation of the SMS client and execution of the inventory scan program. After the first inventory scan, future inventory scans will be executed in the client computer based on the frequency set in the Inventory window under the Site Properties window (Figure 355 on page 221).

Every time that hardware inventory is run, old inventory records in the database are kept, but moved to inventory history for that machine. SMS compares new inventory values to inventory history values and any values that do not match the new settings will show up in red in the administrator GUI.
Use the Sites window to view hardware inventory for each client. Select the site where you want to view inventory, then the domain, and double-click on the machine you want details on.

![Figure 411. SMS Personal Computer Properties Window](image)

The above window graphically shows the inventory data stored in the SMS database. For each icon selected in the left column you will see a series of parameters listed as tables in the right portion of the window. If you have run inventory more than once, you will see the history records buttons available, allowing you to navigate from current inventory data to previous inventory data.

### 6.2.6.2 Software Inventory

The most common software inventory method is based on a software description database. This is where software characteristics are kept. A scanning program compares file entries in the scanned machine to the software database entries.

SMS is no different from other inventory software, but it allows two different approaches to software inventory: package inventory and software audit. Package inventory works similar to hardware inventory. Both scans are performed by the same program at the same time. Software audit, on the other hand, is less tied to SMS processes, having a separate scanning program and software database. We describe both methods in this section.

The inventory function in NetFinity is similar to the one in SMS. Both NetFinity and SMS have software dictionaries to help define software to be discovered, and both may write to SQL databases. However, NetFinity’s inventory may be triggered or scheduled any time the administrator requires it. SMS is not as flexible as that. The NetFinity software inventory window is shown below.
Package Inventory: Package inventory is run together with hardware inventory. Every time the inventory process is run (as set in Figure 355 on page 221), it will also detect software packages. The detection of software packages is based on inventory data entered into each SMS package. As mentioned in 6.2.2, "Packages and Jobs" on page 226, it is possible to add inventory attributes to SMS packages. These attributes are used by the inventory scanning program to find software in scanned machines.

For example, if the administrator knows that Lotus 1-2-3 Version 5 is started in the client machine by an executable file called 123.EXE, that is 324.886 bytes with a creation date of 12/15/95, they may input this information into the Lotus 1-2-3 V5 package so that this software will be discovered by the scanning program during the inventory process.

Inventoried packages are shown when the Packages icon is selected in the left column of the Personal Computer Properties window.
**Software Audit:** Software Audit differs from package inventory in two ways:

- It bases its scan on information stored in a rules file.
- It is run as a Run Command on Workstation job.

Perform the following steps to set up and run software auditing:

1. **Prepare a rules file.**
   
   A rules file contains rules for SMS to find software in scanned machines. The rules in a rules file are the same as inventory information we specify in a package. This means file name, size, date, CRC, or other relevant attributes. You will find a sample rules file in the directory `\SMS\PRIMSITE.SRV\AUDIT`. The sample rules file name is `AUDIT.RUL`. We created our own rules file for testing, listed below.

   ```
   package 0 "1-2-3 5.0 English (International) Win16, Lotus Development"
   file "L14CLS.DLL" size 312368 crc 62473 187422 64595
   file "C1WUIMG.R.DLL" size 179888 crc 35977 107934 33668
   file "LGALLERY.BMP" size 151670 crc 30334 91003 60360
   
   package 1 "1-2-3 4.01 English (International) Win16, Lotus Development"
   file "L14CLS.DLL" size 180736 crc 36147 108442 31769
   file "C1WUIMG.R.DLL" size 180692 crc 36138 108416 59953
   file "LGALLERY.BMP" size 151670 crc 30334 91003 60360
   
   package 2 "WinZip 6.2 English Win32, Nico Mak Computing, Inc"
   file "WINZIP32.EXE"
   
   package 3 "Paint Shop Pro V4.12 Shareware, JASC Inc"
   file "Psp.exe"
   file "Psp.hlp"
   
   package 4 "Netscape Navigator V3.0, Netscape Comm Corp"
   file "netscape.exe" size 2986544
   
   package 5 "Netscape Communicator Preview R3, Netscape Comm Corp"
   file "netscape.exe" size 3553792
   ```

   The basic rules file has syntax such that each defined package has on its first line the keyword `package`, package number and a description (in quotes). The lines following that identify the software. Each line with a file description must have the keyword `file`, and additional parameters such as size, CRC and date. Please refer to the SMS online documentation for additional rules on file syntax.

   The only application we had installed that was in the default rules file in our testing was SQL Server and it was properly detected. We found that the less restrictive your rules are, the easier it is to detect packages.

2. **Compile your rules file using RUL2CFG.BAT.**
   
   The text rules file must be compiled into a .CFG file that will be used by the auditing program. Simply run the RUL2CFG program passing as a parameter the rules file you want to compile:

   ```
   rul2cfg myrules.rul
   ```

   The RUL2CFG script will compile the rules and copy them to the appropriate directories referenced by the auditing program. You will see that when the auditing package is defined these directories are shared with the machine being audited.

3. **Create a package for auditing.**

   In order to run a command on a workstation, you must set up a package, then a job to execute it. SMS provides a PDF to aid with package creation for auditing. The file `AUDIT.PDF` is located in the
In the Package Properties window for the new package (Figure 365 on page 226), click on Import and specify the AUDIT.PDF file. Specify the \SMS\PRIMSITE.SRV\AUDIT\PACKAGE directory as the package source directory. The AUDIT.BAT file, contained in this directory, will detect which environment it is running on and then call the proper executable under the respective subdirectories (alpha, mips or x86).

The PDF sets all required parameters for the audit package. Note that there are no sharing or inventory parameters in the package. It is only a workstation package that will be executed using a run command on the workstation job.

4. Prepare and run the auditing job.

Create a run command on workstation job for auditing (see 6.2.2, “Packages and Jobs” on page 226) targeted to the workstations you desire to audit. The job will show up in the package command manager for each selected workstation.

![Figure 414. Software Auditing Job in Package Command Manager in Win NT 3.51](image)

The audit program runs in a command line session.
5. Check auditing results.

Auditing results are shown with the rest of inventory in the Personal Computer Properties window. When a computer has been audited it will have an additional icon in the properties column called Audited Software. Select it to see the audit results.
6.2.6.3 MIF Extensions

SMS stores its inventory data using DMTF’s MIF format. It is possible to extend SMS inventory with MIF forms that may be filled in by the user with additional data required by your implementation. These forms are incorporated into the personal computer inventory and may be viewed in the Personal Computer Properties window. Since this information is also part of the database you may create queries based on the fields you create.

To build MIF forms, SMS provides a utility called the MIF Form Generator, found in the SMS program group in the administrator machine.

The MIF Form Generator allows creation of numeric, character and list fields. After creating and saving your new MIF form, distribute it to the target machines using a Run Command on Workstation job. The job should simply have a copy
command to copy the .XNF file to the C:\MS\SMS\BIN directory (or the drive/directory SMS is installed on at the client machine).

SMS provides a sample MIF form called UINFO.XNF. You may also customize UINFO.XNF instead of creating a new form.

After package distribution, the client may input the additional inventory data using the MIF Entry program (see Figure 346 on page 215).

Check the inventoried information in the administrator interface in the Personal Computer Properties window.

![Figure 419. Customized Inventory Data](image)

### 6.2.7 Performing Software Distribution

Two mechanisms are provided by SMS to make software available at client workstations: software distribution and application sharing. We show software distribution in this section.

Our examples install the Lotus Notes client using both methods.

#### 6.2.7.1 Software Distribution

Software Distribution consists of installing software on client machines in an automated and unattended fashion. This process may become difficult depending on how flexible the software’s installation program is.

If the installation program allows you to provide input using a companion file or other automated method, it will not be very difficult. If not, there are many details pertinent to each software application that you will need to know to perform the automated installation.

We use for our example the Lotus Notes client, which has a flexible installation program and comes with pre-defined PDFs to be used by SMS for software distribution.

Two steps are required to perform the Lotus Notes Client distribution:

1. Create a package for the software.

   A package for distribution may be created manually (as shown in 6.2.2, "Packages and Jobs" on page 226) or automatically using a package definition file (PDF). Lotus provides PDFs for the Notes clients on Windows 95 and Windows NT (32NOT45.PDF, listed in Appendix A, “SMS Files” on page 271). The PDFs are available on the Internet at www.lotus.com.
The PDF defines parameters for software installation and inventory. The only parameter you must input manually is the package source directory, that is, the share name where the installation files reside (see Figure 366 on page 227). Remember that the SMS service account must have access to that directory.

### [PDF]

**Version=1.0**

**[Manual Setup]**
- **CommandName=** Manual Lotus Notes client installation.
- **CommandLine=** INSTALL.EXE
- **UserInputRequired=** TRUE
- **SupportedPlatforms=** Windows95, Windows NT 3.1 (x86)

**[Automated Setup]**
- **CommandName=** Automated Lotus Notes client installation.
- **CommandLine=** CLIENT32.BAT
- **UserInputRequired=** FALSE
- **SupportedPlatforms=** Windows95, Windows NT 3.1 (x86)

**[Package Definition]**
- **Product=** Notes (Win 95, NT)
- **Version=** 4.5 Client
- **Comment=** Lotus Notes 4.5 for Windows NT and Windows 95.
- **SetupVariations=** Manual, Automated

; [Setup Package for Inventory]
; InventoryThisPackage=TRUE
; Detection Rule Part 1=File 1
; Detection Rule Part 2=AND
; Detection Rule Part 3=File 2

; [File 1]
; FILE=NOTES.EXE
; COLLECT=FALSE
; Checksum=
; DATE=
; SIZE=
; TIME=

*Figure 420. Package Definition File for Lotus Notes Client*

Each section in the PDF corresponds to the windows for manual creation of the package. The inventory parameters in the PDF are commented out. (A semicolon in the first position of the line indicates a comment.) Remove the semicolons for the inventory parameters you want to be valid.

Installation parameters in the PDF file contain two install methods: manual and automatic. Manual installation will simply run the install.exe file in the client machine from the share you specify in the package source directory field. Automatic installation will run the batch file CLIENT32.BAT.

```
echo off
ccls
START /wait INSTALL.EXE /A %0\.\..\CLIENT32.RSP
exit
```

*Figure 421. Unattended Installation Script CLIENT32.BAT*

CLIENT32.BAT starts the installation program redirecting its input from the CLIENT32.RSP file (also listed in Appendix A, “SMS Files” on page 271). Note that CLIENT32.BAT and CLIENT32.RSP must both be in the package source directory.
Observe that automated installation is only possible because the
INSTALL.EXE program from Notes allows a /A parameter to get installation
parameters from CLIENT32.RSP.

```
[User Registration]
UserName =
CompanyName =

[General Information]
InstallType = 1
ProgramGroup = Lotus Applications
StartmenuFolder = Lotus Applications

[NOT]
; The [NOT] section provides information about
; Notes directories.
; Do not modify the BASEDIR symbol.
; Use the "NOTDIR" field to select the drive
; and directory where you want to install
; Notes program files.
; Use the "NOTWORKDIR" field to select the drive
; and directory you where you want to store Notes data files
BASEDIR = C:\lotus
NOTDIR = C:\Notes\NOTWORKDIR = C:\Notes\Data\SizeOfInstall = 2

[CustomizeNOT]
NOTESPROGRAM = 1
NOTESDATA = 1
NOTESTEMPLATE = 1
NOTESDOCUMENT = 1
NOTESHELP = 1
NOTESHELPLITE = 1
NOTESVIEWER = 1
```

Figure 422. Unattended Installation Response File CLIENT32.RSP

The response file for the Lotus Notes client contains parameters such as
user name, what modules to install and which target directories to use.

2. Install the package with a job.

You may manually create a job or simply drag and drop the newly created
Notes package onto the client machine in the sites window. Both ways will
take you to the Job Details window (Figure 375 on page 233) to input
additional data for the job and then submit it.

After the job is submitted, it will go through SMS regular job processing until
it reaches the client machines. Our job took over 10 minutes to go through
the send and distribute phases. SMS compacts the entire source directory
during these phases. All source directory contents are loaded to the
database and then made available to all sites. The run phase in the client
was executed by the Package Command Manager without errors.

6.2.8 Performing Remote Troubleshooting

Remote Troubleshooting, Remote Control, and Help Desk are all terms used to
describe the same function: remote take over and control of an SMS client
workstation. Taking over control in this case means being able to see from your
administrator machine exactly what is displayed on the clients desktop, as well
as remotely controlling the client machine’s keyboard and mouse. SMS actually
shares keyboard and mouse control, that is, when performing the remote
troubleshooting function, both the administrator and the client have control of the keyboard and mouse.

This function is available for DOS and Windows machines, and is started from the Personal Computer Properties window by selecting the Help Desk icon. The client portion of the help desk function is disabled by default after installation for security purposes. It must be enabled manually.

Make sure your user ID has permission to use Remote Troubleshooting functions on the client machines (see Figure 357 on page 222).

USERTSR, USERIPX, WUSER.EXE and WUSER32.EXE are the help desk client modules, and must be running for remote troubleshooting to work. USERTSR and USERIPX are TSR (terminate and stay resident) modules used in DOS-based computers (running DOS and Windows 3.x). WUSER.EXE is the 16-bit executable that runs on Windows 95 and Windows 3.x computers. WUSER32.EXE runs as a service on Windows NT machines. The following table illustrates platforms and required modules for remote troubleshooting to work.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Required Client Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOS</td>
<td>USERTSR (for NetBIOS and TCP/IP) or USERIPX (for IPX)</td>
</tr>
<tr>
<td>Windows 3.x</td>
<td>USERTSR (for NetBIOS and TCP/IP) or USERIPX (for IPX), and WUSER</td>
</tr>
<tr>
<td>Windows 95</td>
<td>WUSER</td>
</tr>
<tr>
<td>Windows NT</td>
<td>WUSER32 (SMS Remote Control Agent service)</td>
</tr>
</tbody>
</table>

Although the non-Windows NT platforms do support TCP/IP, remote troubleshooting is implemented in these architectures with NetBIOS over TCP/IP. Therefore, the LANA number for NetBIOS must be set to the same value both in the server and client machines for remote troubleshooting to work. Check the LANA number in the network properties window as shown in the following figure:
On Windows 95, select the **Set this protocol to be the default protocol** check box to set the protocol to LANA 0. In our lab, we set NetBEUI to LANA 0 in the server and client machines. Not setting this parameter correctly will make SMS fail to locate the client machine.

Select the **Help Desk Options** icon in the SMS client program group in each client machine to set remote troubleshooting options.
It is possible to restrict the actions executed by the remote troubleshooting service with the above panel. Specify which function will be available, whether or not permission from the client is required, and whether or not there will be a visible signal for the client when remote troubleshooting is being performed. This means that the user will be made aware when someone else is accessing their desktop.

If your setup is correct, when you click on the **Help Desk** icon in the Personal Computer Properties window you will see the functions in the right portion of the window enabled.

**Available Help Desk functions are:**

- Remote Control
Takes over (shares) screen, keyboard and mouse control. The following window is displayed.

![Quick Windows Viewer](image)

Figure 426. SMS Help Desk Window (Quick Windows Viewer)

Note the five extra buttons on the top right corner of the window. They allow the administrator to send Control key combinations that do not normally go through remote control sessions (such as Ctrl+Esc, Alt+Tab and Ctrl+Alt+Del).

![Icons](image)

Each icon respectively:

1. Sends a Ctrl+Esc signal.
2. Sends an Alt+Tab signal.
3. Sends a Ctrl+Alt+Del signal. (It is recommended to use the remote reboot function instead to reboot machines.)
4. Allows Alt combination keys to be directed to the client machine (for example, Alt+F1).
5. Brings up the AREA box to help navigate on displays with same or higher resolution than the current resolution used by the administrator’s display.

To quit remote troubleshooting, simply close the Quick Viewer window by double-clicking on the upper left window button. The connection may also be terminated by the user through the Being Accessed window.
6.2.9 Performing Network Monitoring

As with other administration and diagnostic functions, SMS integrates the Windows Network Monitor Agent and Tools into its administrator interface. The Network Monitor is a Windows tool that is used to capture network packets and analyze them based on protocols, packet source and destination.

The Network Monitoring functions are invoked from the Personal Computer Properties window. Select a computer within a site in the Site window and double-click on the selected computer to get to the Personal Computer Properties window. Then, select the Network Monitoring icon in the left column and the following window will be displayed:
The Find Remote Agents button requests SMS to look for agents in remote networks. SMS allows you to use the remote agents to capture network data in their local networks and have it sent to your administrator GUI. Remote agents found by SMS will be reported in the list below the Start Network Monitor button.

Click on **Start Network Monitor** to start the monitoring process. The network monitoring window will appear.
Refer to 4.2, "Network Monitor" on page 154 for details on Network Monitor functions.
Appendix A. SMS Files

This appendix contains the listings for files used by Microsoft’s Systems Management Server (SMS) referenced in Chapter 6, “SMS” on page 193.

A.1 RUNSMS.BAT

@echo OFF
REM Copyright (C) 1994-1995 Microsoft Corporation
REM This batch file is the Systems Management Server (SMS) script
REM for workstations attaching to a Windows NT or LAN Manager server.
REM It installs the SMS client components and collects hardware and
REM software inventory data.
REM This batch file is run directly from a Windows NT, LAN
REM Manager, or NetWare SMS logon server for DOS, Windows, and Windows
REM NT workstations. To run directly from an SMS logon server, the user
REM must make a network connection (drive mapping) using an available
REM drive letter and then change the current drive to this network
REM drive. This connection must be to SMS_SHR for a Windows NT or LAN
REM Manager server, or to the SMS-volume:SMS-directory\LOGON.SRV
REM directory for a NetWare server. This batch file can also be run
REM from the Windows95 Explorer, or with a UNC such as
REM \SMS-server\SMS_SHR\RUNSMS.

echo.
echo Microsoft Systems Management Server (SMS)
echo.
REM If the SMSLS environment variable is set on the workstation (e.g.,
REM set SMSLS=1), verbose output will be enabled for SETLS16, CLI_DOS,
REM and INVDOs or SETLS32, CLI_NT and INVWIN32.
if "%SMSLS%" == "" goto START
set SMS_VERBOSE=/v
echo Executing SMS_SHR script.
goto START

REM Determine the binary files directory on the SMS logon server by
REM checking environment variables for operating system and processor
REM architecture. Set environment variables for this directory and
REM for the OS type. The directory this file exists in and the platform
REM specific directory beneath it are added to the path so that the proper
REM version of SETLS and NLSMSG can be called.
::START

REM Check to see if we can save path and reserve the necessary environment
REM space before continuing.
set SMS_P=%PATH%
set SMS_TEMP=123456789012345678901234567890123456789012345
if "%SMS_TEMP%"=="12345678901234567890123456789012345" goto FIND_OS
goto LOW_ENV

::FIND_OS
set SMS_TEMP=
if "%OS%" == "Windows_NT" goto NT_BIN
REM Determine the DOS version and exit if OS/2 1.3 or greater.
if not exist %0\..\dosver.com goto NOARGO
%0\..\dosver
if errorlevel 13 goto OS2
goto DOS_BIN

::NOARGO
REM this should only occur on Netware machines running pure netx
REM dosver
if errorlevel 13 goto OS2

dosver
set SMS_OS=16

::OS2

::NT_BIN

::Dos BIN

::NOARGO

::NT_BIN

::OS2
set SMS_BIN=x86.bin
goto RUN_FROM
:NT_BIN
if ″%PROCESSOR_ARCHITECTURE%″
if ″%PROCESSOR_ARCHITECTURE%″
if ″%PROCESSOR_ARCHITECTURE%″
if ″%PROCESSOR_ARCHITECTURE%″

==
==
==
==

″ALPHA″
″MIPS″
″x86″
″PPC″

goto
goto
goto
goto

NT_ALPHA
NT_MIPS
NT_X86
NT_PPC

echo.
echo Unable to determine operating system or processor architecture.
echo.
echo Consult your network administrator.
echo.
pause
goto END

:NT_ALPHA
set SMS_BIN=alpha.bin
set SMS_OS=32
goto RUN_FROM
:NT_MIPS
set SMS_BIN=mips.bin
set SMS_OS=32
goto RUN_FROM
:NT_X86
set SMS_BIN=x86.bin
set SMS_OS=32
goto RUN_FROM
:NT_PPC
REM The PowerPC is not supported in this release.
goto END

:RUN_FROM
if ″%OS%″ == ″Windows_NT″
set PATH=%PATH%;%0\..\%SMS_BIN%
if not ″%OS%″ == ″Windows_NT″ set PATH=%0\..;%0\..\%SMS_BIN%;%PATH%
REM The SETLS program will spawn the executable files for CLI_DOS and
REM INVDOS or CLI_NT and INVWIN32 located on this server.
:RUN_SETLS
if ″%OS%″ == ″Windows_NT″ goto RUN_NT
:RUN_DOS
if not exist %0\..\%SMS_BIN%\setls%SMS_OS%.exe goto NOPATHARG0
setls%SMS_OS% -m:E -i -p:%SMS_BIN%\CLI_DOS.EXE -pa:/p:%%SMS_UNC%%\ -pa:%SMS_VERBOSE% %SMS_VERBOSE%
setls%SMS_OS% -m:E -i -p:%SMS_BIN%\INVDOS.EXE -pa:/l:%%SMS_UNC%%\ -pa:/i -pa:%SMS_VERBOSE% %SMS_VERBOSE%
goto RESTORE
:NOPATHARG0
REM this should only occur on Netware machines running pure netx
%SMS_BIN%\setls%SMS_OS% -m:E -i -p:%SMS_BIN%\CLI_DOS.EXE -pa:/p:%%SMS_UNC%%\
-pa:%SMS_VERBOSE% %SMS_VERBOSE%
%SMS_BIN%\setls%SMS_OS% -m:E -i -p:%SMS_BIN%\INVDOS.EXE -pa:/l:%%SMS_UNC%%\
-pa:/i -pa:%SMS_VERBOSE% %SMS_VERBOSE%
goto RESTORE
:RUN_NT
setls%SMS_OS% -m:E -i -p:%SMS_BIN%\CLI_NT.EXE
-pa:/p:%%SMS_UNC%%\
-pa:%SMS_VERBOSE% %SMS_VERBOSE%
setls%SMS_OS% -m:E -i -p:%SMS_BIN%\INVWIN32.EXE -pa:/l:%%SMS_UNC%%\
-pa:/e -pa:/t0 -pa:/i -pa:%SMS_VERBOSE% %SMS_VERBOSE%
goto RESTORE
:OS2
echo.
NLSMSG%SMS_OS% 10 /M ″ Please run RUNSMS.CMD from an OS/2 window″
echo.
pause
goto END

272

Windows NT Systems Management


REM RUNSMS was unable to reserve the necessary amount of environment space
REM and was unable to complete successfully. Increase the available environment
REM space and retry this batch file.

:LOW_ENV
set SMS_TEMP=

REM Try to start a new command shell to procure more env space
REM but only once to avoid extra recursion. The second call to the
REM batch file will have a command line parameter.
if "%1" == "" goto newshell

echo.
%0\..\x86.bin\NLSMSG16 7 /M "Not enough environment space"
%0\..\x86.bin\NLSMSG16 8 /M "Use the /E parameter on the shell= command in config.sys"
%0\..\x86.bin\NLSMSG16 9 /M "to increase the amount of environment space available."
pause
goto END

:newshell
command /e:2048 /c %0 %1 retry
go to END

:RESTORE
REM Restore the previous path setting.
PATH=%SMS_P%
go to END

REM Clean up the environment variables.
:END
set SMS_P=
set SMS_OS=
set SMS_BIN=
set SMS_VERBOSE=

Appendix B. Windows NT Diagnostic Summary

The output of the `winmsd \barryn /s /f` follows:

Microsoft Diagnostics Report For \barryn

OS Version Report
Microsoft (R) Windows NT (TM) Server
Version 4.0 (Build 1381: Service Pack 2) x86 Uniprocessor Free
Registered Owner: Barry D. Nusbaum, IBM-ITSO
Product Number: xxxxx-xxx-xxxxxxx-xxxxx

System Report
System: AT/AT COMPATIBLE
Hardware Abstraction Layer: PC Compatible Eisa/Isa HAL
BIOS Date: 12/20/95
BIOS Version: BIOS Version 0.02.04.CCOM

Processor list:
0: x86 Family 5 Model 2 Stepping 11 GenuineIntel 132 Mhz

Video Display Report
BIOS Date: 10/26/95
BIOS Version: Phoenix S3 TRI064 Enhanced VGA BIOS. Version 1.3-08-21-57Mhz

Adapter:
Setting: 640 x 480 x 256
60 Hz
Type: s3 compatible display adapter
String: Phoenix
Memory: 1 MB
Chip Type: S3 764
DAC Type: S3

Driver:
Vendor: Microsoft Corporation
File(s): s3.sys, s3.dll
Version: 4.00, 4.0.0

Drives Report
C:\ (Local - NTFS) Total: 0KB, Free: 0KB
D:\ (Local - NTFS) Total: 0KB, Free: 0KB
F:\ (Local - NTFS) Total: 0KB, Free: 0KB

Memory Report
Handles: 2,649
Threads: 200
Processes: 32

Physical Memory (K)
Total: 130,484
Available: 71,656
File Cache: 19,456

Services Report
Alerter Running (Automatic)
Computer Browser Running (Automatic)
EventLog (Event log) Running (Automatic)
Server Running (Automatic)
Workstation (NetworkProvider) Running (Automatic)
License Logging Service Running (Automatic)
TCP/IP NetBIOS Helper Running (Automatic)
Messenger Running (Automatic)
FTP Publishing Service Running (Automatic)
Net Logon (RemoteValidation) Running (Automatic)
NT LM Security Support Provider Running (Manual)
Tivoli Object Dispatcher Running (Automatic)
Plug and Play (PlugPlay) Running (Automatic)
Remote Session Manager Running (Automatic)
Remote Procedure Call (RPC) Locator Running (Automatic)
Remote Procedure Call (RPC) Service Running (Automatic)
Simple TCP/IP Services Running (Automatic)
SNMP Running (Automatic)
Drivers Report
AFD Networking Support Environment (TDI) Running (Automatic)
atapi (SCSI miniport) Running (Boot)
Beep (Base) Running (System)
Cdifs (File system) Running (Disabled)
Cdrom (SCSI CDROM Class) Running (System)
Disk (SCSI Class) Running (Boot)
Diskperf (Filter) Running (Boot)
DLC Protocol Running (System)
Floppy (Primary disk) Running (System)
i8042 Keyboard and PS/2 Mouse Port Driver (Keyboard Port) Running (System)
IAvBoot4 (Extended base) Running (Boot)
IAvFsps4 (Extended base) Running (System)
IBM Auto 16/4 Token-Ring ISA Adapter Driver (NDIS) Running (Automatic)
Keyboard Class Driver (Keyboard Class) Running (System)
KSecDD (Base) Running (System)
Mouse Class Driver (Pointer Class) Running (System)
Msfs (File system) Running (System)
Mup (Network) Running (Manual)
NetBEUI Protocol (PNP_TDI) Running (Automatic)
Microsoft NDIS System Driver (NDIS) Running (System)
NetBIOS Interface (NetBIOSGroup) Running (Manual)
WINS Client(TCP/IP) (PNP_TDI) Running (Automatic)
Npfs (File system) Running (System)
Ntfs (File system) Running (Disabled)
Null (Base) Running (System)
Parallel (Extended base) Running (Automatic)
Parport (Parallel arbitrator) Running (Automatic)
ParVdm (Extended base) Running (Automatic)
Rdr (Network) Running (Manual)
s3 (Video) Running (System)
Serial (Extended base) Running (Automatic)
Srv (Network) Running (Manual)
TCP/IP Service (PNP_TDI) Running (Automatic)
VgaSave (Video Save) Running (System)

IRQ and Port Report

<table>
<thead>
<tr>
<th>Devices</th>
<th>Vector Level</th>
<th>Affinity</th>
</tr>
</thead>
<tbody>
<tr>
<td>i8042p1</td>
<td>1</td>
<td>1 0xffffffff</td>
</tr>
<tr>
<td>i8042p2</td>
<td>12</td>
<td>12 0xffffffff</td>
</tr>
<tr>
<td>Serial</td>
<td>4</td>
<td>4 0x00000000</td>
</tr>
<tr>
<td>Serial</td>
<td>3</td>
<td>3 0x00000000</td>
</tr>
<tr>
<td>Floppy</td>
<td>6</td>
<td>6 0x00000000</td>
</tr>
<tr>
<td>1bmTok4</td>
<td>2</td>
<td>2 0x00000000</td>
</tr>
<tr>
<td>atapi</td>
<td>0</td>
<td>14 0x00000000</td>
</tr>
<tr>
<td>atapi</td>
<td>0</td>
<td>15 0x00000000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Devices</th>
<th>Physical Address Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>i8042p1</td>
<td>0x000000060 0x0000000001</td>
</tr>
<tr>
<td>i8042p2</td>
<td>0x00000064 0x0000000001</td>
</tr>
<tr>
<td>Parport</td>
<td>0x0000003bc 0x0000000003</td>
</tr>
<tr>
<td>Serial</td>
<td>0x0000003fb 0x0000000007</td>
</tr>
<tr>
<td>Serial</td>
<td>0x0000002fb 0x0000000007</td>
</tr>
<tr>
<td>Floppy</td>
<td>0x0000003f0 0x0000000006</td>
</tr>
<tr>
<td>Floppy</td>
<td>0x0000003f7 0x0000000001</td>
</tr>
<tr>
<td>1bmTok4</td>
<td>0x00000a20 0x0000000004</td>
</tr>
<tr>
<td>atapi</td>
<td>0x0000010f0 0x0000000008</td>
</tr>
<tr>
<td>atapi</td>
<td>0x000003f6 0x0000000001</td>
</tr>
<tr>
<td>atapi</td>
<td>0x00000170 0x0000000008</td>
</tr>
<tr>
<td>atapi</td>
<td>0x00000376 0x0000000001</td>
</tr>
<tr>
<td>s3</td>
<td>0x000003c0 0x0000000010</td>
</tr>
<tr>
<td>s3</td>
<td>0x000003d4 0x0000000008</td>
</tr>
<tr>
<td>s3</td>
<td>0x0000042e8 0x0000000002</td>
</tr>
<tr>
<td>s3</td>
<td>0x000004ae8 0x0000000002</td>
</tr>
<tr>
<td>s3</td>
<td>0x000008e8 0x0000000004</td>
</tr>
<tr>
<td>s3</td>
<td>0x000008ee8 0x0000000004</td>
</tr>
<tr>
<td>s3</td>
<td>0x0000092e8 0x0000000004</td>
</tr>
<tr>
<td>s3</td>
<td>0x0000096e8 0x0000000004</td>
</tr>
</tbody>
</table>
Appendix B. Windows NT Diagnostic Summary
Network Report
Your Access Level: Admin & Local
Workgroup or Domain: ITSODOM
Network Version: 4.0
LanRoot: ITSODOM
Logged On Users: 1
Current User (1): Administrator
   Logon Domain: ITSODOM
   Logon Server: BARRYN

Transport: NetBT_IbmTok41, 40-00-98-94-11-89, VC’s: 0, Wan: Wan
Transport: Nbf_IbmTok41, 40-00-98-94-11-89, VC’s: 2, Wan: Wan

Character Wait: 3,600
Collection Time: 250
Maximum Collection Count: 16
Keep Connection: 600
Maximum Commands: 5
Session Time Out: 45
Character Buffer Size: 512
Maximum Threads: 50
Lock Quota: 6,144
Lock Increment: 10
Maximum Locks: 500
Pipe Increment: 10
Maximum Pipes: 500
Cache Time Out: 40
Dormant File Limit: 45
Read Ahead Throughput: 4,294,967,295
Mailslot Buffers: 3
Server Announce Buffers: 20
Illegal Datagrams: 5
Datagram Reset Frequency: 60
Bytes Received: 246,713
SMB’s Received: 1,259
Appendix C. Special Notices

This publication is intended to help technical support personnel implement systems management on the NT platform. The information in this publication is not intended as the specification of any programming interfaces that are provided by the products mentioned. See the PUBLICATIONS section of the IBM Programming Announcements for more information about what publications are considered to be product documentation.

References in this publication to IBM products, programs or services do not imply that IBM intends to make these available in all countries in which IBM operates. Any reference to an IBM product, program, or service is not intended to state or imply that only IBM’s product, program, or service may be used. Any functionally equivalent program that does not infringe any of IBM’s intellectual property rights may be used instead of the IBM product, program or service.

Information in this book was developed in conjunction with use of the equipment specified, and is limited in application to those specific hardware and software products and levels.

IBM may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood, NY 10594 USA.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact IBM Corporation, Dept. 600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The information contained in this document has not been submitted to any formal IBM test and is distributed AS IS. The information about non-IBM (“vendor”) products in this manual has been supplied by the vendor and IBM assumes no responsibility for its accuracy or completeness. The use of this information or the implementation of any of these techniques is a customer responsibility and depends on the customer’s ability to evaluate and integrate them into the customer’s operational environment. While each item may have been reviewed by IBM for accuracy in a specific situation, there is no guarantee that the same or similar results will be obtained elsewhere. Customers attempting to adapt these techniques to their own environments do so at their own risk.

Reference to PTF numbers that have not been released through the normal distribution process does not imply general availability. The purpose of including these reference numbers is to alert IBM customers to specific information relative to the implementation of the PTF when it becomes available to each customer according to the normal IBM PTF distribution process.

The following terms are trademarks of the International Business Machines Corporation in the United States and/or other countries:
The following terms are trademarks of other companies:

C-bus is a trademark of Corollary, Inc.

PC Direct is a trademark of Ziff Communications Company and is used by IBM Corporation under license.

Pentium, MMX, ProShare, LANDesk and ActionMedia are trademarks or registered trademarks of Intel Corporation in the U.S. and other countries.


UNIX is a registered trademark in the United States and other countries licensed exclusively through X/Open Company Limited.

Microsoft, Windows, Windows NT and the Windows 95 logo are trademarks or registered trademarks of Microsoft Corporation.

Java and HotJava are trademarks of Sun Microsystems, Inc.

Other company, product, and service names may be trademarks or service marks of others.
Appendix D. Related Publications

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this redbook.

D.1 International Technical Support Organization Publications

For information on ordering these ITSO publications see “How to Get ITSO Redbooks” on page 283.

- Systems Management from an NT Server Point of View, SG24-4723
- LAN Management Process (Alerts/Monitoring) Using NetFinity, SG24-4517
- Setting Up a TME 3.0 NT Environment, SG24-4819
- NetFinity V5.0 Database Support, SG24-4808
- NetFinity V5.0 Command Line and LMU Support, SG24-4925

D.2 Redbooks on CD-ROMs

Redbooks are also available on CD-ROMs. Order a subscription and receive updates 2-4 times a year at significant savings.

<table>
<thead>
<tr>
<th>CD-ROM Title</th>
<th>Subscription Number</th>
<th>Collection Kit Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>System 390 Redbooks Collection</td>
<td>SBOF-7201</td>
<td>SK2T-2177</td>
</tr>
<tr>
<td>Networking and Systems Management Redbooks Collection</td>
<td>SBOF-7370</td>
<td>SK2T-6022</td>
</tr>
<tr>
<td>Transaction Processing and Data Management Redbook</td>
<td>SBOF-7240</td>
<td>SK2T-8038</td>
</tr>
<tr>
<td>AS/400 Redbooks Collection</td>
<td>SBOF-7270</td>
<td>SK2T-8049</td>
</tr>
<tr>
<td>RS/6000 Redbooks Collection (HTML, BkMgr)</td>
<td>SBOF-7230</td>
<td>SK2T-8040</td>
</tr>
<tr>
<td>RS/6000 Redbooks Collection (PostScript)</td>
<td>SBOF-7205</td>
<td>SK2T-8041</td>
</tr>
<tr>
<td>Application Development Redbooks Collection</td>
<td>SBOF-7280</td>
<td>SK2T-8037</td>
</tr>
<tr>
<td>Personal Systems Redbooks Collection</td>
<td>SBOF-7250</td>
<td>SK2T-8042</td>
</tr>
</tbody>
</table>

D.3 Other Publications

These publications are also relevant as further information sources:

- Windows NT Server Professional Reference, SR23-7365
How to Get ITSO Redbooks

This section explains how both customers and IBM employees can find out about ITSO redbooks, CD-ROMs, workshops, and residencies. A form for ordering books and CD-ROMs is also provided.

This information was current at the time of publication, but is continually subject to change. The latest information may be found at URL http://www.redbooks.ibm.com.

How IBM Employees Can Get ITSO Redbooks

Employees may request ITSO deliverables (redbooks, BookManager BOOKs, and CD-ROMs) and information about redbooks, workshops, and residencies in the following ways:

- **PUBORDER** — to order hardcopies in United States
- **GOPHER link to the Internet** - type GOPHER.WTSCPOK.ITSO.IBM.COM
- **Tools disks**

  To get LIST3820s of redbooks, type one of the following commands:
  
  TOOLS SENDTO EHONE4 TOOLS2 REDPRINT GET SG24xxxx PACKAGE
  TOOLS SENDTO CANVM2 TOOLS REDPRINT GET SG24xxxx PACKAGE (Canadian users only)

  To get BookManager BOOKs of redbooks, type the following command:
  
  TOOLCAT REDBOOKS

  To get lists of redbooks, type one of the following commands:
  
  TOOLS SENDTO USDIST MKTTOOLS MKTTOOLS GET ITSOCAT TXT
  TOOLS SENDTO USDIST MKTTOOLS MKTTOOLS GET LISTSERV PACKAGE

  To register for information on workshops, residencies, and redbooks, type the following command:
  
  TOOLS SENDTO WTSCPOK TOOLS ZDISK GET ITSOREGI 1996

  For a list of product area specialists in the ITSO, type the following command:
  
  TOOLS SENDTO WTSCPOK TOOLS ZDISK GET ORGCARD PACKAGE

- **Redbooks Home Page on the World Wide Web**
  
  http://w3.itso.ibm.com/redbooks

- **IBM Direct Publications Catalog on the World Wide Web**
  

  IBM employees may obtain LIST3820s of redbooks from this page.

- **REDBOOKS category on INEWS**

- **Online** — send orders to: USIB6FPL at IBMMAIL or DKIBMBSH at IBMMAIL

- **Internet Listserv**

  With an Internet e-mail address, anyone can subscribe to an IBM Announcement Listserv. To initiate the service, send an e-mail note to announce@webster.ibmlink.ibm.com with the keyword subscribe in the body of the note (leave the subject line blank). A category form and detailed instructions will be sent to you.

Redpieces

For information so current it is still in the process of being written, look at “Redpieces” on the Redbooks Home Page (http://www.redbooks.ibm.com/redpieces.htm). Redpieces are redbooks in progress; not all redbooks become redpieces, and sometimes just a few chapters will be published this way. The intent is to get the information out much quicker than the formal publishing process allows.

© Copyright IBM Corp. 1997
How Customers Can Get ITSO Redbooks

Customers may request ITSO deliverables (redbooks, BookManager BOOKs, and CD-ROMs) and information about redbooks, workshops, and residencies in the following ways:

- **Online Orders** — send orders to:
  - In United States: usib6fpl at ibmmail
  - In Canada: caibmbkz at ibmmail
  - Outside North America: dkibmbsh at ibmmail

- **Telephone orders**
  - United States (toll free): 1-800-879-2755
  - Canada (toll free): 1-800-IBM-4YOU
  - Outside North America: (+45) 4810-1320 - Danish
  - (+45) 4810-1420 - Dutch
  - (+45) 4810-1540 - English
  - (+45) 4810-1670 - Finnish
  - (+45) 4810-1220 - French
  - (+45) 4810-1020 - German
  - (+45) 4810-1620 - Italian
  - (+45) 4810-1270 - Norwegian
  - (+45) 4810-1120 - Spanish
  - (+45) 4810-1170 - Swedish

- **Mail Orders** — send orders to:
  - IBM Publications
    - Publications Customer Support: 144-4th Avenue, S.W.
    - P.O. Box 29570
    - Raleigh, NC 27626-0570
    - USA
    - IBM Direct Services
    - Sortemosevej 21
    - Calgary, Alberta T2P 3N5
    - DK-3450 Allerød

- **Fax** — send orders to:
  - United States (toll free): 1-800-445-9269
  -Canada: 1-403-267-4455
  -Outside North America: (+45) 48 14 2207 (long distance charge)

- **1-800-IBM-4FAX (United States)** or (+1)001-408-256-5422 (Outside USA) — ask for:
  - Index # 4421 Abstracts of new redbooks
  - Index # 4422 IBM redbooks
  - Index # 4420 Redbooks for last six months

- **Direct Services** - send note to softwareshop@vnet.ibm.com

- **On the World Wide Web**
  - Redbooks Home Page: http://www.redbooks.ibm.com

- **Internet Listserver**
  - With an Internet e-mail address, anyone can subscribe to an IBM Announcement Listserver. To initiate the service, send an e-mail note to announce@webster.ibmlink.ibm.com with the keyword subscribe in the body of the note (leave the subject line blank).

---

**Redpieces**

For information so current it is still in the process of being written, look at “Redpieces” on the Redbooks Home Page (http://www.redbooks.ibm.com/redpieces.htm). Redpieces are redbooks in progress; not all redbooks become redpieces, and sometimes just a few chapters will be published this way. The intent is to get the information out much quicker than the formal publishing process allows.
IBM Redbook Order Form

Please send me the following:

<table>
<thead>
<tr>
<th>Title</th>
<th>Order Number</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

First name             Last name

Company

Address

City                  Postal code    Country

Telephone number      Telefax number   VAT number

- Invoice to customer number

- Credit card number

Credit card expiration date    Card issued to    Signature

We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not available in all countries. Signature mandatory for credit card payment.
ntserver/webadmin/webadminl.htm  23

O
ODBC interface 21

P
Package Command Manager 215
package definition files (PDFs) 230, 231, 257
package definition files (PDFs) 261
package inventory 255
packages 226, 234, 260
Packages button 242
Packages icon 255
parent site 194
Parent Site window 223
Performance Management 182
Performance Monitor 18, 168, 174, 176, 183, 189, 190, 192
permissions 34
polling interval 20
primary site 194, 201, 204
printer management 24

R
rclient 55
registry key 5
Remote Console 56
Remote Console Server 55
Remote Control 262
Remote Troubleshooting 262
RMTSHARE command 48
RUNSMS.BAT script 210

S
secondary site 194
Sender service 223
senders 195, 225
server management 24
session management 24
share management 24
Share Package job 232
Shared Directories 43
Shutdown.exe command 58
Single Logon service 76
Site Code field 204
Site Groups window 244
Site Properties window 221
sites 218
SMS Resource Kit 197
SMSLS.BAT 214
SNMP 183, 247
   Browser 18
   Control Rights 16
   functions 5
   MON.EXE 20
SNMP (continued)
   Monitor 18
   traps 225, 247, 250
   software inventory 254
   SQL Enterprise Manager 198
   subsites 194

T
Task Manager 178
TELNET 28
Tivoli Event Console 168
Tivoli Management Platform 168
TME 10 NetView 6
TN3270E Server 110, 113, 118
traps 19, 248
Type of Access 48

U
user synchronization 74, 75, 80

W
Windows NT Diagnostics Program 70
Windows NT Resource Kit 21, 37
Windows NT Resources Kit 165
WUSER.EXE 217, 263
WUSER32.EXE 217, 263

288  Windows NT Systems Management
ITSO Redbook Evaluation

Windows NT Systems Management
SG24-2107-00

Your feedback is very important to help us maintain the quality of ITSO redbooks. **Please complete this questionnaire and return it using one of the following methods:**

- Use the online evaluation form found at http://www.redbooks.com
- Fax this form to: USA International Access Code + 1 914 432 8264
- Send your comments in an Internet note to redbook@vnet.ibm.com

**Please rate your overall satisfaction** with this book using the scale:  
(1 = very good, 2 = good, 3 = average, 4 = poor, 5 = very poor)

Overall Satisfaction ____________

**Please answer the following questions:**

Was this redbook published in time for your needs?  Yes____ No____
If no, please explain:
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

What other redbooks would you like to see published?
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

**Comments/Suggestions:**  (THANK YOU FOR YOUR FEEDBACK!)
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

© Copyright IBM Corp. 1997